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Glossary
A

Administrator
A user with permissions to manage Check Point security products and the network
environment.

API
In computer programming, an application programming interface (API) is a set of
subroutine definitions, protocols, and tools for building application software. In general
terms, it is a set of clearly defined methods of communication between various software
components.

Appliance
A physical computer manufactured and distributed by Check Point.

Audit Log
A record of an action that is done by an Administrator.

B

Bond
A virtual interface that contains (enslaves) two or more physical interfaces for
redundancy and load sharing. The physical interfaces share one IP address and one
MAC address. See "Link Aggregation".

Bonding
See "Link Aggregation".

Bridge Mode
A Security Gateway or Virtual System that works as a Layer 2 bridge device for easy
deployment in an existing topology.
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C

CA
Certificate Authority. Issues certificates to gateways, users, or computers, to identify
itself to connecting entities with Distinguished Name, public key, and sometimes IP
address. After certificate validation, entities can send encrypted data using the public
keys in the certificates.

Certificate
An electronic document that uses a digital signature to bind a cryptographic public key
to a specific identity. The identity can be an individual, organization, or software entity.
The certificate is used to authenticate one identity to another.

Cluster
Two or more Security Gateways that work together in a redundant configuration - High
Availability, or Load Sharing.

Cluster Member
A Security Gateway that is part of a cluster.

Cooperative Enforcement
Integration of Endpoint Security server compliance to verify internal network
connections.

CoreXL
A performance-enhancing technology for Security Gateways on multi-core processing
platforms. Multiple Check Point Firewall instances are running in parallel on multiple
CPU cores.

CoreXL Firewall Instance
Also CoreXL FW Instance. On a Security Gateway with CoreXL enabled, the Firewall
kernel is copied multiple times. Each replicated copy, or firewall instance, runs on one
processing CPU core. These firewall instances handle traffic at the same time, and
each firewall instance is a complete and independent firewall inspection kernel.
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CoreXL SND
Secure Network Distributer. Part of CoreXL that is responsible for: Processing incoming
traffic from the network interfaces; Securely accelerating authorized packets (if
SecureXL is enabled); Distributing non-accelerated packets between Firewall kernel
instances (SND maintains global dispatching table, which maps connections that were
assigned to CoreXL Firewall instances). Traffic distribution between CoreXL Firewall
instances is statically based on Source IP addresses, Destination IP addresses, and the
IP 'Protocol' type. The CoreXL SND does not really "touch" packets. The decision to
stick to a particular FWK daemon is done at the first packet of connection on a very high
level, before anything else. Depending on the SecureXL settings, and in most of the
cases, the SecureXL can be offloading decryption calculations. However, in some other
cases, such as with Route-Based VPN, it is done by FWK daemon.

Correlation Unit
A SmartEvent software component that analyzes logs and detects events.

CPUSE
Check Point Upgrade Service Engine for Gaia Operating System. With CPUSE, you
can automatically update Check Point products for the Gaia OS, and the Gaia OS itself.
For details, see sk92449.

Custom Report
A user defined report for a Check Point product, typically based on a predefined report.

D

DAIP Gateway
A Dynamically Assigned IP (DAIP) Security Gateway is a Security Gateway where the
IP address of the external interface is assigned dynamically by the ISP.

Data Type
A classification of data. The Firewall classifies incoming and outgoing traffic according
to Data Types, and enforces the Policy accordingly.

Database
The Check Point database includes all objects, including network objects, users,
services, servers, and protection profiles.
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Distributed Deployment
The Check Point Security Gateway and Security Management Server products are
deployed on different computers.

Domain
A network or a collection of networks related to an entity, such as a company, business
unit or geographical location.

Domain Log Server
A Log Server for a specified Domain. It stores and processes logs from Security
Gateways that are managed by the corresponding Domain Management Server.
Acronym: DLS.

Domain Management Server
A virtual Security Management Server that manages Security Gateways for one
Domain, as part of a Multi-Domain Security Management environment. Acronym: DMS.

E

Event
A record of a security or network incident that is based on one or more logs, and on a
customizable set of rules that are defined in the Event Policy.

Event Correlation
A procedure that extracts, aggregates, correlates and analyzes events from the logs.

Event Policy
A set of rules that define the behavior of SmartEvent.

Expert Mode
The name of the full command line shell that gives full system root permissions in the
Check Point Gaia operating system.

External Network
Computers and networks that are outside of the protected network.
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External Users
Users defined on external servers. External users are not defined in the Security
Management Server database or on an LDAP server. External user profiles tell the
system how to identify and authenticate externally defined users.

F

Firewall
The software and hardware that protects a computer network by analyzing the incoming
and outgoing network traffic (packets).

G

Gaia
Check Point security operating system that combines the strengths of both
SecurePlatform and IPSO operating systems.

Gaia Clish
The name of the default command line shell in Check Point Gaia operating system. This
is a restrictive shell (role-based administration controls the number of commands
available in the shell).

Gaia Portal
Web interface for Check Point Gaia operating system.

H

Hotfix
A piece of software installed on top of the current software in order to fix some wrong or
undesired behavior.

I

ICA
Internal Certificate Authority. A component on Check Point Management Server that
issues certificates for authentication.
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Internal Network
Computers and resources protected by the Firewall and accessed by authenticated
users.

IPv4
Internet Protocol Version 4 (see RFC 791). A 32-bit number - 4 sets of numbers, each
set can be from 0 - 255. For example, 192.168.2.1.

IPv6
Internet Protocol Version 6 (see RFC 2460 and RFC 3513). 128-bit number - 8 sets of
hexadecimal numbers, each set can be from 0 - ffff. For example,
FEDC:BA98:7654:3210:FEDC:BA98:7654:3210.

J

Jumbo Hotfix Accumulator
Collection of hotfixes combined into a single package. Acronyms: JHA, JHF.

L

Link Aggregation
Various methods of combining (aggregating) multiple network connections in parallel to
increase throughput beyond what a single connection could sustain, and to provide
redundancy in case one of the links should fail.

Log
A record of an action that is done by a Software Blade.

Log Server
A dedicated Check Point computer that runs Check Point software to store and process
logs in Security Management Server or Multi-Domain Security Management
environment.
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M

Management High Availability
Deployment and configuration mode of two Check Point Management Servers, in which
they automatically synchronize the management databases with each other. In this
mode, one Management Server is Active, and the other is Standby. Acronyms:
Management HA, MGMT HA.

Management Interface
Interface on Gaia computer, through which users connect to Portal or CLI. Interface on a
Gaia Security Gateway or Cluster member, through which Management Server
connects to the Security Gateway or Cluster member.

Management Server
A Check Point Security Management Server or a Multi-Domain Server.

Multi-Domain Log Server
A computer that runs Check Point software to store and process logs in Multi-Domain
Security Management environment. The Multi-Domain Log Server consists of Domain
Log Servers that store and process logs from Security Gateways that are managed by
the corresponding Domain Management Servers. Acronym: MDLS.

Multi-Domain Security Management
A centralized management solution for large-scale, distributed environments with many
different Domain networks.

Multi-Domain Server
A computer that runs Check Point software to host virtual Security Management Servers
called Domain Management Servers. Acronym: MDS.

N

Network Object
Logical representation of every part of corporate topology (physical machine, software
component, IP Address range, service, and so on).
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O

Open Server
A physical computer manufactured and distributed by a company, other than Check
Point.

P

Predefined Report
A default report included in a Check Point product that you can run right out of the box.

Primary Multi-Domain Server
The Multi-Domain Server in Management High Availability that you install as Primary.

R

Report
A summary of network activity and Security Policy enforcement that is generated by
Check Point products such as SmartEvent.

Rule
A set of traffic parameters and other conditions in a Rule Base that cause specified
actions to be taken for a communication session.

Rule Base
Also Rulebase. All rules configured in a given Security Policy.

S

Secondary Multi-Domain Server
The Multi-Domain Server in Management High Availability that you install as
Secondary.

SecureXL
Check Point product that accelerates IPv4 and IPv6 traffic. Installed on Security
Gateways for significant performance improvements.
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Security Gateway
A computer that runs Check Point software to inspect traffic and enforces Security
Policies for connected network resources.

Security Management Server
A computer that runs Check Point software to manage the objects and policies in Check
Point environment.

Security Policy
A collection of rules that control network traffic and enforce organization guidelines for
data protection and access to resources with packet inspection.

SIC
Secure Internal Communication. The Check Point proprietary mechanism with which
Check Point computers that run Check Point software authenticate each other over
SSL, for secure communication. This authentication is based on the certificates issued
by the ICA on a Check Point Management Server.

Single Sign-On
A property of access control of multiple related, yet independent, software systems. With
this property, a user logs in with a single ID and password to gain access to a
connected system or systems without using different usernames or passwords, or in
some configurations seamlessly sign on at each system. This is typically accomplished
using the Lightweight Directory Access Protocol (LDAP) and stored LDAP databases
on (directory) servers. Acronym: SSO.

SmartConsole
A Check Point GUI application used to manage Security Policies, monitor products and
events, install updates, provision new devices and appliances, and manage a multi-
domain environment and each domain.

SmartDashboard
A legacy Check Point GUI client used to create and manage the security settings in
R77.30 and lower versions.

SmartEvent Server
Server with enabled SmartEvent Software Blade that hosts the events database.
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Software Blade
A software blade is a security solution based on specific business needs. Each blade is
independent, modular and centrally managed. To extend security, additional blades can
be quickly added.

SSO
See "Single Sign-On".

Standalone
A Check Point computer, on which both the Security Gateway and Security
Management Server products are installed and configured.

System Counter
SmartView Monitor data or report on status, activity, and resource usage of Check Point
products.

T

Traffic
Flow of data between network devices.

U

Users
Personnel authorized to use network resources and applications.

V

VLAN
Virtual Local Area Network. Open servers or appliances connected to a virtual network,
which are not physically connected to the same network.

VLAN Trunk
A connection between two switches that contains multiple VLANs.
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VSX
Virtual System Extension. Check Point virtual networking solution, hosted on a
computer or cluster with virtual abstractions of Check Point Security Gateways and
other network devices. These Virtual Devices provide the same functionality as their
physical counterparts.

VSX Gateway
Physical server that hosts VSX virtual networks, including all Virtual Devices that
provide the functionality of physical network devices. It holds at least one Virtual
System, which is called VS0.
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Introduction
With R80, logging, event management, reporting, and monitoring are more tightly integrated than ever
before. Security data and trends easy to understand at a glance, with Widgets and chart templates that
optimize visual display. Logs are now tightly integrated with the policy rules. To access logs associated with
a specific rule, click that rule. Free-text search lets you enter specific search terms to retrieve results from
millions of logs in seconds.

One-click exploration makes it easy to move from high-level overview to specific event details such as type
of attack, timeline, application type and source. After you investigate an event, it is easy to act on it.
Depends on the severity of the event, you can ignore it, act on it later, block it immediately, or toggle over to
the rules associated with the event to refine your policy. Send reports to your manager or auditors that
show only the content that is related to each stakeholder.

In this release, SmartReporter and SmartEvent functionality is integrated into SmartConsole.

With rich and customizable views and reports, R80 introduced a new experience for log and event
monitoring.

The new views are available from two locations:

n SmartConsole > Logs & Monitor

n SmartView Web Application. Browse to: https://<Server IP>/smartview/where Server IP is IP
address of the Security Management Server or SmartEvent server.
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Getting Started
This section introduces the logging and monitoring clients, and explains how to install and configure
logging and monitoring products.

Logging and Monitoring Clients
Monitor logs and events using customizable views and reports. Use these GUI clients:

SmartConsole
>
Logs &
Monitor

Analyze events that occur in your environment with customizable views and reports.

The Logs view replaces the SmartView Tracker and SmartLog GUI clients.

SmartView
Web
Application

It has the same real-time event monitoring and analysis views as SmartConsole, with
the convenience of not having to install a client.

Browse to: https://<Server IP>/smartview/, where <Server IP> is IP
address of the Security Management Server or SmartEvent Server.

These GUI clients are still supported:

SmartEvent n For initial settings - configure the SmartEvent Correlation Unit, Log Server,
Domains and Internal Network.

n For the correlation policy (event definitions)

n For Automatic Reactions

SmartView
Monitor

n To monitor tunnels

n To monitor users

n For suspicious activity rules

n To monitor alerts - Thresholds configuration

For more about monitoring, see "Monitoring Traffic and Connections" on page 108.

SmartView GUI Clients

Administrator access permissions can be limited by the GUI Clients list based on IP address, IP range, a
network or a host name.This list is based on the GUI clients' access configuration as defined on the
relevant Security Management Server or a Multi-Domain Server.

See the R80.40 SecurityManagement Administration Guide > ChapterManaging Administrator Accounts
> Section Defining Trusted Clients.

To open the SmartEvent GUI:

1. Open SmartConsole > Logs & Monitor.

2. Click (+) for a Catalog (new tab).

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_SecurityManagement_AdminGuide/Default.htm
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3. In the External Apps section, click SmartEvent Settings & Policy.

To open the SmartViewMonitor GUI:

1. Open SmartConsole > Logs & Monitor.

2. Click (+) for a Catalog (new tab).

3. In the External Apps section, click Tunnel & User Monitoring.

Understanding Logging
Security Gateways generate logs, and the Security Management Servers generates audit logs, which are
a record of actions taken by administrators. The Security Policy that is installed on each Security Gateway
determines which rules generate logs.

Logs can be stored on a:

n Security Management Server that collects logs from the Security Gateways. This is the default.

n Log Server on a dedicated machine. This is recommended for organizations that generate a lot of
logs.

n Security Gateway. This is called local logging.

Note - Logs can be automatically forwarded to the Security Management Server or Log Server, according
to a schedule, or manually imported with the Remote File Management operation via CLI (fw fetchlogs).
The management servers and log servers can also forward logs to other servers.

To find out howmuch storage is necessary for logging, see the new appliance datasheet.

A Log Server handles log management activities:

n Automatically starts a new log file when the existing log file gets to the defined maximum size.

n Stores log files for export and import.

n Makes an index of the logs to enable faster responses to log queries.

Log Storage
SmartEvent and Log Server use an optimization algorithm to manage disk space and other system
resources. When the Logs and Events database becomes too large, the oldest logs and events are
automatically deleted according to the configured thresholds.

In SmartConsole, open the Security Gateway or Check Point host for editing, and openLogs >Storage.

Configure these fields:

n Measure free disk space in - ChooseMBytes or Percentage.

n When disk space is below <number> Mbytes, issue alert - Get an alert when the available disk
space for logs and log index files is below this threshold. This value must be at least 5 MB greater
than the value of ...stop logging in the Additional logging options page.

n When disk space is below <number> Mbytes, start deleting old files - Delete the oldest logs and
log index files when the available disk space is below this threshold. This value must be at least 5 MB
greater than the ...issue alert value.

n Run the following script before deleting old files - Enter a path to the script.

https://www.checkpoint.com/downloads/product-related/datasheets/ds-smart-1-appliances.pdf
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This option is for Gateways only

n Reserve ... for packet capturing - Some types of logs can also capture the packets that created the
log event. Set the amount, in MBytes or Percent, that you want to use for captured packets.

These options and examples are for a Security Management Server, SmartEvent Server, or Log Server:

n When disk space is below <number> Mbytes, start deleting old files -The available space in the
logs partition is checked every 1 minute. Once the threshold is reached, the log disk maintenance
occurs: deleting the oldest day of log and index data and repeating until reaching above configured
threshold.

Daily logs retention

n Keep indexed logs for no longer than <number> days - Occurs daily at midnight. Deleting oldest
index files by days, keeping today + the configured number of index days (14 = 14 days + today).

n Keep log files for an extra <number> days - Occurs daily at midnight. Deleting oldest log files by
days, keeping today + the configured number of index days + extra log days (3664 = 14 [from index
settings] + 3650 days + today). As 3664 is more than 10 years, effectively keeping all log files.

Note - The max summary value of both indexed logs and log files is 3664.

For these examples, the administrator enables these thresholds:

n When disk space is below [5000] Mbytes, start deleting old files

n Daily logs retention

n Keep indexed logs for 14 days

n Keep log files for an extra 6 days (6 + 14 = 20 days of log files)

Example 1:

The server has 3000 MBytes of free disk space, and 5 days of logs and index files.

The server deletes logs and index files, one day at a time, until there is 5000 Mbytes of free disk space.

Example 2:

The server has 10 GBytes of free disk space and 30 days of logs and index files.

The server deletes all log files older than 20 days ago (6 + 14), each day at midnight.

The server deletes all index files older than 14 days ago, each day at midnight.

Example 3:

A server produces 1GB of logs and 1GB of index files each day. The server now has 35 days of logs and 30
days of index files and only 2.5GB of free disk space left. The configured disk space threshold is 5GB,
which means the server is now 2.5GB below the threshold.

The index files threshold is 14 days.

The log file threshold is 20 days.

When the disk space threshold (5GB) is reached, disk space maintenance deletes logs and index data until
there is again more than 5GB of free space. In this example:
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1. Logs from day one are deleted first, as they are older. Three days of the oldest logs are deleted to
clear 3GB of logs and leave 6GB of free space on the drive, 1GB above the threshold, leaving the
server with 32 log days and 30 index days.

2. The server still has more than 14 days of index files - an extra 16 days (30 days of index files now)

And more than 20 days of logs – an extra 12 days (32 days of log files now).

At midnight, the extra log & index files are deleted until only the current day’s log files plus the last 20
days remain.

Index days are deleted until only the current day’s index plus the last 14 days remain.

The deletion of three days of logs left 5.5GB of free space.

The deletion of 12 log file days + 16 index file days frees up a total of 28GB (12 + 16) of space.

33.5GB of space is now free.

The daily logs retention occurs every day at midnight keeping the chosen number of days of log +
index data.

Most likely, this means it will never reach the log disk space threshold. But if the log disk space
threshold is again reached, the log disk maintenance process repeats to make sure space never
runs out.

In a Multi-Domain environment

In a Multi-Domain Security Management environment, the Security Gateways send logs to the Domain
Management Server. The Multi-Domain Server generates logs, and they can be stored on the Multi-
Domain Server. To learn how to deploy logging in a Multi-Domain Security Management environment, see
the R80.40Multi-Domain SecurityManagement Administration Guide.

To learn how to monitor the Log Receive Rate on the Security Management Server / Log Server in R80
and higher, see sk120341.

To decrease the load on the Security Management Server, you can install a dedicated Log Server and
configure the gateways to send their logs to this Log Server. To see the logs from all Log Servers, connect
to the Security Management Server with SmartConsole, and go to the Logs & Monitor view > Logs tab.

Daily Logs Retention
Daily logs retention refers to how long logs are stored before they are deleted. Configure this value to help
you manage free disk space.

Audit logs are not deleted, even in a case of emergency disk space maintenance, regardless of the
configured log retention value. You cannot configure the daily retention of audit logs.

Audit indexes are deleted only in a disk space emergency. Audit indexes are not deleted as part of daily
maintenance regardless of the value configured in SmartConsole, unless they are configured otherwise
via log_maintenance_domain_conf.csv files (Global SmartEvent only). For more details, see
sk164054.

In R80.40 and higher, you can configure log retention on these servers:

n Management/Log Servers: Configure via SmartConsole.

n Multi-Domain Server/Multi-Domain Log Server: Configure log and index retention via
SmartConsole per server and per domain and allow the use of default values for all domains on the
Multi-Domain Server level (Super User only).

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Multi-DomainSecurityManagement_AdminGuide/Default.htm
http://supportcontent.checkpoint.com/solutions?id=sk120341
http://supportcontent.checkpoint.com/selections?id=sk164054
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Note - Multi-Domain Server daily index deletion is enforced according to the highest value defined
between the domain and theMulti-Domain Server level.

n Global SmartEvent: Configured only via manual configuration files for Daily index retention. For
more details, see sk164054.

Note – When you configure log retention:

Keep log files for an extra Y days: When this value is 0, both logs and indexed logs will be saved
for the same number of days. A value higher than 0 results in saving additional days of logs.

Example 1:

Indexed logs: 14 days & log-files extra: 0 days

Result: 14 index days & 4 days of log-files.

Example 2:

Indexed logs: 14 days & log-files extra: 6 days

Result: 14 index days & 20 days of log-files.

To configure Daily logs retention (Management/SmartEvent/Log Servers):

1. In SmartConsole, go to Logs >Storage.

2. For Daily logs retention , select to apply this log retention policy:

n Keep indexed logs for no longer than <X> days.

n Keep log files for an extra <Y> days.

3. ClickOK to save settings.

To configure Daily logs retention (Multi-Domain Server):

1. In SmartConsole, go to Multi-Domain Server > Log Settings >General.

2. For Daily logs retention , select to apply this log retention policy:

n Keep indexed logs for no longer than <X> days.

n Keep log files for an extra <Y> days.

3. ClickOK to save settings.

Note – This configuration applies to all domains that are not manually configured.

To configure Daily logs retention (Domain Management Server):

1. In the Domain Management Server, go to Logs >Storage.

2. Select to configure log retention according to Multi-Domain settings or to override.

Note – Only Super Users have permissions to override Multi-Domain settings.

3. If you select to override, select to keep indexed logs and log files for X + Y days.

4. ClickOK to save settings.

http://supportcontent.checkpoint.com/solutions?id=sk164054
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To configure Daily logs retention (Global SmartEvent):

Unlike the other cases, there is no GUI in which to configure policy settings. Any change to current GUI
settings is not enforced and default values apply.

However, you can configure the general settings using log_policy_extended.C or you can configure
each domain individually for daily index retention, via log_maintenance_domain_conf.csv file (see
sk164054).

To configure each domain separately:

1. Copy this file from the Multi-Domain Server: $RTDIR/conf/log_maintenance_domain_
conf.csv (recommended)

or

Download the template from sk164054 and place the file $RTDIR/conf/log_maintenance_
domain_conf.csv

2. Edit the file manually or via Excel.

If you edit the file in a non – linux environment, you must convert the file to Linux format by using dos2unix.
Otherwise, the file may fail to load.

You do not need to configure each domain individually, as we can use default values for each domain.To
do so, add a domain called default and specify what values you want as the default.

Best Practice - Add default values even if all of the domains are individually configured. This helps if you
added a new domain and forgot to edit this file, or if there is a mistake in a domain name.

If default values are not configured, all domains that are not configured in the file take the largest value
written in the file configured for that specific index type.

Domain_name audit files firewallandvpn other other-smartlog resources smartevent

Domain1 3650 20 15 14 14 14 14

Domain2 3650 20 30 14 14 14 14

default 3650 30 14 14 14 14 14

In the example, Domain3 uses the default values.

If the default is not configured, it uses the highest values: (3650, 20, 30, 14, 14, 14, 14, 14)

Deploying Logging
You can enable logging on the Security Management Server (enabled by default), or deploy a dedicated
Log Server. After you deploy the Log Server, you must configure the Security Gateways for logging.

You must execute the Install Database function on the remote Log Server when you:

n Enable or disable a logging related blade or function, including Log Indexing in a server object.

n Add a new Log Server to the system.

n Change a gateway's Log Server.

http://supportcontent.checkpoint.com/solutions?id=sk164054
http://supportcontent.checkpoint.com/solutions?id=sk164054
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n Change a Log Server's log settings or make any other Log Server object change.

n Change anything in the Global Properties that might affect the Log Server.

Enabling Logging on the Security Management Server
1. Open SmartConsole.

2. Edit the network object of the Security Management Server.

3. In theGeneral Properties page, on the theManagement tab, enable Logging & Status.

4. ClickOK

5. Publish the SmartConsole session.

Deploying a Dedicated Log Server
To deploy a dedicated Log Server, you must install it, and then connect it to the Security Management
Server.

For details, see the R80.40 Installation and UpgradeGuide.

Configuring the Security Gateways for Logging

To configure a Security Gateway for logging:

1. Open SmartConsole.

2. In theGateways & Servers view, double-click the gateway object.

3. From the navigation tree, click Logs.

4. Configure where to send logs:

n To save logs to the Security Management Server - Select Send gateway logs to server.

n To save logs to a dedicated Log Server - Select the Log Server from the list.

n To save logs locally -
Select Save logs locally, on this server.

5. ClickOK.

6. Publish the SmartConsole session.

7. Install a policy on the Security Gateway.

Enabling Log Indexing
Log indexing on the Security Management Server or Log Server reduces the time it takes to run a query on
the logs. Log indexing is enabled by default.

In a standalone deployment, log indexing is disabled by default. Enable log indexing only if the standalone
server CPU has 4 or more cores.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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To manually enable Log Indexing:

1. Open SmartConsole.

2. From theGateways & Servers view, double-click the Security Management Server or Log Server
object.

TheGeneral Properties window opens.

3. In theManagement tab, select Logging & Status.

4. From the navigation tree, click Logs.

5. Select Enable Log Indexing.

6. ClickOK.

7. Publish the SmartConsole session.

8. FromMenu, select Install Database.

Disabling Log Indexing
To save disk storage space, a Log Server can be configured to work in non-index mode. If you disable log
indexing, queries will take longer.

When log indexing is disabled, you must connect with SmartConsole to each Log Server separately to
query its logs. When you connect to the management server you do not get a unified view of all logs, as in
index mode. On each Log Server, the search is done on one log file at a time.

To disable Log Indexing:

1. Open SmartConsole.

2. From theGateways & Servers view, double-click the Security Management Server or Log Server
object.

3. From the navigation tree, click Logs.

4. Clear the Enable Log Indexing option.

5. ClickOK.

6. Publish the SmartConsole session.

7. FromMenu, select Install Database.

To select a log file to search:

1. Open Logs & Monitor > Logs view.

2. Click theOptions menu button to the right of the search bar.

3. Select File > Open Log File.
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Deploying SmartEvent
SmartEvent Server is integrated with the Security Management Server architecture. It communicates with
Log Servers to read and analyze logs. You can enable SmartEvent on the Security Management Server or
deploy it as a dedicated server.

You can deploy R80.40 SmartEvent on a dedicated server and connect it to Security Management Servers
or Multi-Domain Servers of version R77.X and higher. This lets you extend an R77.X environment with the
new capabilities of R80.40 SmartEvent.

Only a Security Management Server can also work as a SmartEvent Server. In a Multi-domain
environment, you must install SmartEvent on a dedicated server.

You must execute theInstall Database function on the remote SmartEvent Server when you:

n Enable or disable a SmartEvent Server blade, including Log Indexing in a server object.

n Add a new SmartEvent Server to the system.

n Change a SmartEvent Server log settings or make any other SmartEvent Server object change.

n Change anything in the Global Properties that might affect the SmartEvent Server.

SmartEvent Licensing
You can deploy SmartEvent in these ways:

n As part of the SmartEvent - A renewable one year license is included with the SmartEvent package.

n As a dedicated server - You can purchase a perpetual license for a SmartEvent Server.

Enabling SmartEvent on the Security Management Server
1. Open SmartConsole.

2. Open the Security Management Server object.

3. On theManagement tab, enable these Software Blades:

n Logging & Status

n SmartEvent Server

n SmartEvent Correlation Unit

4. ClickOK.

5. Publish the SmartConsole session.

Note - For Security Gateways R77.30 and lower, you must activate the Firewall session for the network
activity report. See "Exporting Views and Reports" on page 45.

System Requirements
To use SmartEvent, see the requirements in the R80.40 Release Notes.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_RN/Default.htm
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Installing a Dedicated SmartEvent Server
1. Download the installation ISO file.

2. Install the ISO on the open server or appliance.

Allocate partition size:

n Root partition: at least 20 GB

n Logs partition: more than allocated for Root and backup (set maximum possible) to let the
server keep a long history.

3. When prompted, reboot.

Configuring the SmartEvent Components in the First Time
Configuration Wizard
Configure the components of the dedicated server for SmartEvent on a Smart-1 appliance, or on an open
server.

For information on how to install a SmartEvent Server, see the R80.40 Installation and UpgradeGuide.

To configure the SmartEvent components:

1. Connect to the SmartEvent Server Portal:

https://<Server_IP>

2. Run the First Time Configuration Wizard.

3. On the Installation Type page, select Security Management.

4. On the Products page:

n On a Smart-1 Appliance, selectDedicated Server and SmartEvent.

n On an Open Server, select Log Server / SmartEvent only

5. Install the R80.40 SmartConsole GUI client.

R80.40 SmartConsole has the Logs &Monitor catalog of views, which includes the views in the
SmartEvent GUI.

Connecting R80.40 SmartEvent to R80.40 Security
Management Server
This procedure explains how to configure a dedicated server for these components:

n SmartEvent Server and SmartEvent Correlation Unit

Note - For information on how to install a dedicated SmartEvent Server, see the R80.40 Installation and
UpgradeGuide.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Installation_and_Upgrade_Guide/Default.htm
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To connect R80.40 SmartEvent Server and SmartEvent Correlation Unit to R80.40 Security Management
Server:

1. In SmartConsole, create a newCheck Point Host object for the dedicated SmartEvent Server.

2. In the Version field, selectR80.40.

3. Create a SIC trust with the dedicated SmartEvent Server.

4. On theManagement tab, enable these Software Blades:

n Logging & Status

n SmartEvent Server

n SmartEvent Correlation Unit

5. On a dedicated SmartEvent Server that is not a Log Server (recommended):

In the Logs page, make sure that Enable Log Indexing is not selected.

This ensures that Firewall connections (which are not relevant for views and reports) are not
indexed.

6. ClickOK.

7. Publish the SmartConsole session.

8. Click Install Database > select all objects > click Install.

Note - For Security Gateways R77.30 and lower: activate the firewall session for the network activity
report. See"Exporting Views and Reports" on page 45.

Advanced Configuration for a dedicated SmartEvent Server that is also a Correlation Unit

1. Open the SmartEvent GUI:

a. In SmartConsole > Logs & Monitor, click + to open a catalog (new tab).

b. Click SmartEvent Settings & Policy.

2. In Policy tab >Correlation Units, define a Correlation Unit object.

3. Select the production Log Servers and local Log Server on the SmartEvent Server to read logs from.

4. In Policy tab > Internal Network, define the internal Network.

5. Click Save.

6. Install the Event Policy on the Correlation Unit:

SmartEventmenu >Actions > Install Event Policy.

Connecting R80.40 SmartEvent to R77.X Security
Management Server
This procedure explains how to configure a dedicated server for these components:

n SmartEvent Server and SmartEvent Correlation Unit
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To connect R80.40 SmartEvent Server and SmartEvent Correlation Unit to an R77.X Security
Management Server:

1. Open an SSH connection to the SmartEvent Server.

2. Run this script:
$RTDIR/scripts/SmartEvent_R80_change_dbsync_mode.sh

3. Wait until the script has finished running. This is when cpstarthas finished and you have a
prompt.

4. Run: cpconfig

5. Select (2) Administratorto configure the SmartEvent Server administrators.

Note - Administrators that are configured in R77.X SmartConsole cannot manage the R80.40
SmartEvent Server.

6. Open the R77.X SmartDashboard.

7. In SmartDashboard, create a Check Point Host object for the SmartEvent Server R80.40.

8. Create an SIC trust between the Security Management Server and the new server for SmartEvent
R80.40.

9. Define it with the highest version available and ignore theWarningmessage.

10. For a dedicated SmartEvent Correlation Unit that is not a SmartEvent Server: In the Logs page, click
Enable SmartLog.

11. In the Check Point Host >Management tab, enable these Software Blades:

n Logging & Status

n SmartEvent Server

n SmartEvent Correlation Unit

12. ClickOK.

13. ClickMenu >Policy > Install Database.

14. Wait until the server synchronizes and loads SmartEvent.

See also Advanced Configuration for a dedicated SmartEvent Server that is also a Correlation Unit in
"Connecting R80.40 SmartEvent to R80.40 SecurityManagement Server" on page 33.

Note - For R77.30 Gateways and lower: activate the firewall session for the network activity report in
"Exporting Views and Reports" on page 45.

Connecting R80.40 SmartEvent to R80.40 Multi-Domain
Server
You can configure a dedicated R80.40 server for SmartEvent components, and connect them to one or
more Domains in an R80.40 Multi-Domain Security Management environment.

This procedure explains how to configure a dedicated server for these SmartEvent components:

n SmartEvent Server and SmartEvent Correlation Unit
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Notes:

n In R80 Multi-Domain Security Management environment, you can only define the SmartEvent
Server and SmartEvent Correlation Unit at the global level and not the domain level.

n Configure SmartEvent to read logs from one domain or a number of domains.

To connect R80.40 SmartEvent Server and SmartEvent Correlation Unit to an R80.40 Multi-Domain
Server:

1. Open SmartConsole.

2. Log in to the Global Domain:

n In the SmartConsole login window, enter the Multi-Domain Server IP address or host name.

n Select the Global Domain from the list (\Global).

3. Create a Check Point Host object for SmartEvent R80.

4. In the Check Point Host >Management, select these Management Blades:

n Logging & Status

n SmartEvent Server

n SmartEvent Correlation Unit

5. Initialize SIC with the new SmartEvent R80.40 Server.

6. ClickOK.

7. Publish the SmartConsole session.

8. Reassign the Global Policy for the Domains that use SmartEvent. For new Domains, create a new
global assignment.

9. In each Domain Management Server, open SmartConsole.

10. ClickMenu > Install Database , on each Domain Management Server and Domain Log Server.

11. Wait until the server synchronizes and loads SmartEvent process.

See also Advanced Configuration for a dedicated SmartEvent Server that is also a Correlation Unit in
"Connecting R80.40 SmartEvent to R80.40 SecurityManagement Server" on page 33.

Note - For R77.30 Gateways and lower: activate the firewall session for the network activity report in
"Exporting Views and Reports" on page 45.

Connecting R80.40 SmartEvent to R77.X Multi-Domain
Server
You can connect R80.40 SmartEvent components to one or more Domains in an R77.XMulti-Domain
Security Management environment.

This procedure explains how to configure a dedicated server for these components:

n SmartEvent Server and SmartEvent Correlation Unit

Configure SmartEvent to read logs from one domain or a number of domains.
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To connect R80.40 SmartEvent Server and SmartEvent Correlation Unit to an R77.X Multi-Domain
Server:

1. Open an SSH connection to the Correlation Unit server.

2. Run this script: $RTDIR/scripts/SmartEvent_R80_change_dbsync_mode.sh

3. Wait until the script has finished running. This is when cpstarthas finished and you have a
prompt.

4. Open R77.X SmartDomain Manager.

5. Log in to the Global Domain:

6. Create a Check Point Host object for the dedicated server for SmartEvent Server R80.40. Define it
with the highest version possible, and ignore theWarningmessage.

7. In the Check Point Host >Management, select these Management Blades:

n Logging & Status

n SmartEvent Server

n SmartEvent Correlation Unit

8. Initialize SIC between the Multi-Domain Server and the new server for SmartEvent R80.40.

9. In the Logs page, click Enable Log Indexing.

10. ClickOK.

11. Publish the SmartConsole session.

12. Reassign the global Policy for the Domains that use SmartEvent. For new Domains, create a new
global assignment.

13. In each Domain Management Server, open SmartDashboard.

14. ClickMenu >Policy > Install Database, on each Domain Management Server and Domain Log
Server.

15. Wait until the server synchronizes and loads SmartEvent.

16. Click Save.

17. Install the Event Policy on the Correlation Unit: SmartEventmenu >Actions > Install Event Policy.

See also Advanced Configuration for a dedicated SmartEvent Server that is also a Correlation Unit
in"Connecting R80.40 SmartEvent to R80.40 SecurityManagement Server" on page 33.

Note - For R77.30 Gateways and lower: activate the firewall session for the network activity report. See
"Exporting Views and Reports" on page 45.

Configuring SmartEvent to use a Non-Standard LEA Port
You can get logs from and send logs to a third-party Log Server. The Check Point Log Server and the third
party Log Server use the LEA (Log Export API) protocol to read logs. By default, the Check Point Log
Server uses port 18184 for this connection. If you configure the Log Server to use a different LEA port, you
must manually configure the new port on the SmartEvent Server and on the SmartEvent Correlation Unit.

Note - This procedure is not relevant if you use "Log Exporter" on page 159
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To change the default LEA port:

1. Open $INDEXERDIR/log_indexer_custom_settings.conf in a text editor.

2. Add this line to the file:

:lea_port (<new_port_number>)

3. In the SmartEvent client, configure the new port on the Correlation Unit.

4. In Policy tab >Correlation Units, configure the Correlation Unit to read logs from the local Log
Server (on the SmartEvent Server).

5. Configure the new port on the SmartEvent Server

a. In Policy tab >Network Objects, double-click the SmartEvent Server object.

b. Change the LEA port No parameter to <new_port_number>.

6. Install the Event Policy on the Correlation Unit: Actions > Install Event Policy

7. On the SmartEvent Server

a. Run: cpstop

b. Open $FWDIR/conf/fwopsec.conf in a text editor.

c. Change these parameters:

lea_server auth_port <new_port_number>
lea_server port 0

d. Run: cpstart

Configuring SmartEvent to read External Logs
To configure SmartEvent to read logs from an externally-managed Log Server or an external Security
Management Server, see sk35288.

An externallymanaged Log Server is managed by a different Security Management Server than the one
that manages the SmartEvent Server. An external SecurityManagement Server is not the one that
manages the SmartEvent Server.

Administrator Permission Profiles
You can give an administrator permissions for:

n Monitoring and Logging

n Events and Reports

To define an administrator with these permissions:

1. Define an administrator or an administrator group.

2. Define a Permission Profile with the required permissions in SmartConsole (Manage & Settings >
Permission Profiles).

3. Assign that profile to the administrator or to the administrator group.

http://supportcontent.checkpoint.com/solutions?id=sk35288
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Configuring Permissions for Monitoring, Logging, Events, and Reports

In the Profile object, select the features and the Read or Write administrator permissions for them.

Monitoring and Logging Features

These are someof the available features:

n Monitoring

n Management Logs

n Track Logs

n Application and URL Filtering Logs

Events and Reports Features

These are the permissions for SmartEvent:

n SmartEvent

l Events - views in SmartConsole > Logs & Monitor

l Policy -SmartEvent Policy and Settings on SmartEvent GUI.

l Reports - in SmartConsole > Logs & Monitor

n SmartEvent Application & URL Filtering reports only

Multi-Domain Security Management

In a Multi-Domain Security Management, each Event and Report is related to a Domain. Administrators
can see events for Domains according to their permissions.

AMulti-Domain Security Management Policy administrator can be:

n Locally defined administrator on the SmartEvent Server.

n Multi-Domain Server Super User defined on the Multi-Domain Server.

n An administrator with permissions on all Domains. Select the Domains in SmartEvent, in Policy >
General Settings >Objects >Domains. This type of administrator can install a Policy, and can see
events from multiple Domains.

SmartEvent Reports-Only Permission Profile

You can define a special permission profile for administrators that only see and generate SmartEvent
reports. With this permission profile, Administrators can open SmartConsole, but in the Logs & Monitor
view can see onlyReports. They cannot access other security information in SmartEvent. You can
configure this permissions profile to apply to the Application &URL Filtering blade only, or apply to all
blades.

To create a SmartEvent report-only permissions profile:

1. In SmartConsole, clickManage & Settings >Permissions Profiles.

2. In the Permission Profiles page, select a permission profile, or click the New button and create a
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permission profile.

3. SelectCustomized.

4. On the Events and Reports page, select SmartEvent Reports.

5. Clear all other options.

6. On the Access Control, Threat Prevention, andOthers pages, clear all options.

7. On theMonitoring and Logging page, select all features, withWrite permissions.

8. ClickOK.

The profile shows in the Permission Profiles page.

9. Assign the SmartEvent Reports Only permissions profile to administrators.

10. Publish the SmartConsole session.

11. Install the policy.

Importing Offline Log Files
The administrator can examine logs from a previously generated log file. This makes it possible to review
security threats and pattern anomalies that occurred in the past, before SmartEvent was installed. You can
investigate threats such as unauthorized scans targeting vulnerable hosts, unauthorized legions, denial of
service attacks, network anomalies, and other host-based activity.

The administrator can review logs from a specific timeframe in the past and focus on deploying resources
on threats that have been active but may have been missed (for example, new events which may have
been dynamically updated can now be processed over the previous period).

Importing Log Files from SmartEvent Servers

By default, you can import offline logs from the last 1 day. To import more days of logs, change the log
indexing settings.

To change log indexing settings:

Note - Do this to make it possible to import logs that are older than 1 day before the SmartEvent Server
was installed.

1. Run: # evstop

2. Run: $INDEXERDIR/log_indexer -days_to_index<days>

<days> is the last number of days of logs to be indexed by the SmartEvent Server. For example, to
import and index logs from the last 30 days of logs, give a value of 30.

Note - To decrease the performance effect while you index the offline logs, import only the
necessary number of days of logs.

3. In the Logs >Storage page of the SmartEvent Server, Make sure thatDelete Index files older than
is not selected, or is selected with an equal or larger number of days than configured in days_to_
index.

4. Run: # evstart
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To allow the SmartEvent Server to index offline log files:

1. Copy the log files and related pointer files <log file name>.log* to $FWDIR/log. Copy the
files to the Log Server that sends logs to the SmartEvent Server.

2. Optional: Do an Offline Work for Correlated Events procedure for each log file. This procedure is
done to run the log files through the Correlation Unit for correlation analysis according to the Event
Policy (defined in SmartEvent GUI client).

To run SmartEvent offline jobs for multiple log files, see: sk98894.

Offline Work For Correlated Events

To detect suspicious logging activity (suspicious according to the Event Policy on the SmartEvent GUI >
Policy tab), run the offline log file through the Correlation Unit.

The settings to generate of Offline logs are in: SmartEvent GUI client >Policy tab >General Settings >
Initial Settings >Offline Jobs, connected to the Security Management Servers or Multi-Domain Server.

The settings are:

n Add - Configure an Offline Log File procedure.

l Name - Lets you recognize the specified Offline Line log file for future processing.

l Comment - A description of the Offline Job.

l Offline Job Parameters:

SmartEvent Correlation Unit: The machine that reads and processes the Offline Logs.

Log Server: The machine that contains the Offline Log files. SmartEvent makes a query to
this Log Server to find out which log files are available.

Log File - A list of available log files found on the selected Log Server. These log files are
processed by the SmartEvent Correlation Unit. In this window, select the log file from which to
retrieve historical information.

n Edit - Change the parameters of an Offline Log File procedure.

n Remove - Delete an Offline Log File procedure. After you start an Offline Log File procedure you
cannot remove it.

n Start - Run the Offline Log File procedure.

n Stop - Stop the Offline Log Files procedure. It does not delete the full procedure, but stops the
procedure at the specified point.

http://supportcontent.checkpoint.com/solutions?id=sk98894
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Views and Reports
You can create rich and customizable views and reports for log and event monitoring. The views present
queries in a graphical way which can be used for analytical and presentation purposes.

Use these GUIs:

n SmartConsole > Logs & Monitor

n SmartView Web Application - for generating and editing views in a browser:
https://<Server IP>/smartview/

<Server IP> is IP address of the Security Management Server or SmartEvent Server.

Enabling Views and Reports
To enable SmartEvent views and reports, you must install and configure a SmartEvent Server.See
"Deploying SmartEvent" on page 32.

Catalog of Views and Reports
In the Logs & Monitor view, click the (+) tab to open a catalog of all views and reports, predefined and
customized. Click a view or report to open it. You can create a new view or report, or export them to PDF.
To see other actions, open the Actions menu.
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Item Description

1 Open Log View - See and search through the logs from all Log Servers. In SmartConsole only,
you can also search the logs from a specific Log Server.

Open Audit Logs View - See and search records of actions done by SmartConsole
administrators.

These views come from the Log Servers. All other Views/Reports (except the Compliance View)
come from the SmartEvent Server.

2 Views -The list of predefined and customized views. A view is an interactive dashboard made
up of widgets. The view tells administrators and other stakeholders about security and network
events. Each widget is the output of a query. Widgets can show the information as a chart, table,
or some other format. To find out more about the events, double-click a widget to drill down to a
more specific view or raw log files.

Compliance View -Optimize your security settings and ensure compliance with regulatory
requirements.

3 Reports -The list of predefined and customized reports. A report consists of multiple views.
There are several predefined reports, and you can create new reports. A report gives more
details because it consists of multiple views. Reports can be customized, filtered, generated and
scheduled. You cannot drill down into a report.

4 Favorites - Use this view to collect the views and reports you use the most.

Recent - Shows the most recently opened report or view.

5 Switch to Table View or Thumbnails View -The Table view is the default for Views and
Reports. The Thumbnails view is the default for the Favorites ,Recent, and Logs.

6 Scheduled Tasks - See and edit scheduled tasks.

7 Archive - Download the exported views and reports.

8 Catalog (New Tab) - Open a Catalog (new tab) and select Log View, Audit View, Views, or
Reports. In the Logs &Monitor view, click the (+) tab to open a catalog of all views and reports,
predefined and customized. To open a view, double-click the view or select the applicable view
and clickOpen from the action bar.

Views
Views shows an interactive dashboard made up of widgets. Each widget is the output of a query. AWidget
pane can show information in different formats, for example, a chart or a table.

SmartView and SmartEvent come with several predefined views. You can create new views that match
your needs, or you can customize an existing view.
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Item Description

1 Widget - The output of a query. AWidget can show information in different formats, for example,
a chart or a table. To find out more about the events, you can double-click most widgets to drill
down to a more specific view or raw log files.

2 Options - Customize the view, restore defaults, Hide Identities, export.

3 Query search bar - Define custom queries using the GUI tools, or manually entering query
criteria. Shows the query definition for the most recent query. ClickQuery Syntax to open the
online Help for more information.

4 Time Period - Specify the time periods for the view.

Reports
A report consists of multiple views and a cover page. There are several predefined reports, and you can
create new reports. A report gives more details than a view. Reports can be customized, filtered,
generated and scheduled. You cannot drill down into a report.

Note - For R77.30 Gateway and lower, the ability to generate reports on firewall and VPN activity is
integrated into SmartConsole. To enable this functionality, activate the firewall session event on the
SmartEvent Policy tab. Select and enable Consolidated Sessions > Firewall Session. For more
information, see "Connecting R80.40 SmartEvent to R80.40 SecurityManagement Server" on page 33.

Automatic View and Report Updates
SmartEvent automatically downloads new predefined views and reports, and downloads updates to
existing predefined ones. To allow this, make sure the management server has internet connectivity to the
Check Point Support Center.

https://supportcenter.checkpoint.com/
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Opening a View or Report
Use the predefined graphical views and reports for the most frequently seen security issues. You can also
customize the views and reports.

To open a view or report:

1. In SmartConsole, open the Logs & Monitor view.

2. Click the + icon to open a new catalog.

3. Click Views or Reports.

4. Select a view or a report, and clickOpen. You can also double click to open it.

5. Define the required timeframe, and filter in the search bar.

6. Click Enter.

Exporting Views and Reports
The Export to PDF and Export to Excel options save the current view or report as a PDF or Excel file,
based on the defined filters and time frame. Note - When you export to Excel, only tables are exported.

To export a view or report to PDF or Excel:

1. In SmartConsole, open the Logs & Monitor view.

2. Click the + tab to open a new tab.

3. Click Views or Reports.

4. Select a view or report.

5. Click Export to PDF.Optionally:

n Configure the Period and filter.

n To automatically send by email to specified recipients each time the view or report runs,
configure the Send by email settings.See "Configuring Email Settings for Views and
Reports" on page 51.

Alternatively, clickOpen and from inside the view or report clickOptions >Export to PDF or Export
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to Excel.

To see your exported views and reports:

1. Add a new tab. Click +.

2. Go to Tasks >Archive.

Generating a Network Activity Report
The Network Activity report shows important firewall connections. For example, top sources,
destinations, and services. To create this report, SmartEvent must first index the firewall logs. Indexing is
on by default in R80 and higher, in all environments except for Stand Alone.

To enable the Network Activity Report for R80.10 and higher Gateways:

In SmartConsole, in the Access Control Policy rule, add per Session to the Track settings. See"Tracking
Options" on page 67.

To enable the Network Activity Report for Pre-R80.10 Gateways:

1. In SmartConsole, open the Logs & Monitor view.

2. Click the (+) to open a Catalog (new tab).

3. In the External Apps section, click SmartEvent Settings & Policy link.

4. In the SmartEvent GUI client >Policy tab, select and expand Consolidated Sessions.

5. Select Firewall Session.

Note - this configuration increases the number of events per day by about five times. To avoid a
performance impact, make sure the hardware can handle the load.
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Sharing Reports
You can share a report you created with your team, without export or import. If a regular admin shares a
view or report, it is shared with all the admins on the domain. A super admin for the Multi-Domain Server
can share with all users under all domains.

To share a report:

1. In SmartConsole, open Logs & Monitor and click + to open a Catalog (new tab).

2. ClickReports and select a report.

3. Click Actions and select Share.

4. Click Yes to approve sharing the report.

The report is nowmarked as shared.

The report owner can undo the action and unshare the report.

To unshare the report:

Click Actions and selectUnshare.
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Note - A Super User can take ownership of reports or views created by other administrators via the take
ownership feature.

Permissions when an owner shares a view/report:

Visible on Catalog Can Edit Can clone Can Delete

Owner + + + +

Super User + - + -

Exporting and Importing Templates
You can export the view or report layout and widget definitions to a file. This is called a template. You can
import the template from another server or from another administrator.

To export the view or report layout and widget definitions to a file, use the Export Template option

To download exported templates, click the link in the notification message. To view historical reports,
views, and templates, go to Tasks >Archive.

To import the file from another server or from another administrator, use the Import Template option in the
Catalog (new tab).
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Scheduling a View or Report
To schedule a view or report, you need to define and edit it in SmartConsole.

To schedule a report:

1. In SmartConsole, open the Logs & Monitor view.

2. Click the + tab to open a new tab.

3. Click Views or Reports.

4. Select a view or a report.

5. Select Actions >Schedule PDF or Schedule Excel.

The Schedule page of the Export settings window opens.

6. Define the recurrence pattern.

7. Define the Period and Filter.

8. Optional: Configure email settings to get the scheduled view or report automatically. ClickSend by
email.

To edit your scheduled views and reports:

1. In SmartConsole, open the Logs & Monitor view.

2. Click the + tab to open a new tab.

3. Select Tasks >Scheduled.

Customizing a View or Report

To customize a view or report:

1. Select a view or a report and clickOpen.

2. ClickOptions >Edit.
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3. In a report, you can edit the report or the current view in the report.

n To add or remove, click the relevant icon in the edit toolbar (becomes available when in edit
mode):

n To add a widget or arrange the "Widgets" on page 52 in the view, use Drag &Drop or
expand..

n Define filters. (see "Widgets" on page 52).

Note - If you change the timeframe, the data changes according to the start and stop times. The timeframe
and search bar are not saved with the view or report definition. Define them as needed when generating
the view or report. See "Opening a View or Report" on page 45.

View Settings
Views can be configured according to these options:

1. Enter a title.

2. To showmore results, this option allows a table to spread across multiple pages when saved to
PDF.

The No page limit option shows all the results for the selected table query, spread across as many
pages as required.

3. Select what you want to display when this control has no data:

n Remove the page

n Show a default or custom message.

4. Select to use the view as a template and add filter and sort criteria.

Use the view as a basis for generating duplicate views with more granularity.

Use Case:

The Active Users predefined view shows all active users. You want to see a more granular view per user:
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1. Open the Active Users view and clickOptions >View settings.

The View Settings window opens.

2. SelectUse View as template.

3. For Filter each view by, selectUser.

4. SelectNumber of values. For example, 5.

5. ClickOK.

6. Go toOptions >Export >Export to PDF.

7. The view is exported. Wait until a message shows the view was successfully exported.

8. ClickDownload.

The report shows all widgets in the view filtered according to each user.

Report Settings
Reports can be configured according to these options:

Configuring Email Settings for Views and Reports
You can automatically send views and reports by email to specified recipients each time the view or report
runs.

Configuring Email Server Settings

Mail server settings in SmartConsole and SmartView are shared for all email interactions. For each
SmartConsole administrator, configure them one time.

To configure email server settings:

1. Select a view or a report in the catalog.

2. Click Export to PDF, or Actions >Schedule PDF or Actions > Schedule Excel.

3. Click Send by email.
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4. In the Email Server section, click Edit.

Note - In SmartView, you can edit the mail server on the user preferences menu.

5. Configure the email server options:

n Sender email address. This shows on all report emails.

n Outgoing mail server (SMTP)

n Port - The default port is 25.

n Use authentication (Optional) - if required by the email server, configure a Username and
Password.

n Connection encryption (Optional) - if required by the email server, choose SSL or TLS.

6. ClickOK.

Configuring Email Recipients

Define the email recipients every time you run the view or report, or one time for scheduled reports.

To configure email recipients:

1. Select a view or a report from the catalog.

2. Click Export to PDF, or Actions >Schedule PDF or Actions > Schedule Excel.

3. Click Send by email.

4. In the Email recipients section, click + to enter an email address. You can add multiple addresses.

5. ClickOK.

Adding a Logo to Reports
You can configure reports to show your company logo on report cover pages. The Check Point logo shows
on report cover pages.

To add a logo to your reports:

1. Save your logo image as a PNG file with the name cover-company-logo.png.

2. Copy the image to the $RTDIR/smartview/conf directory on the SmartEvent server.

Note - The best image dimensions are 152 pixels wide by 94 pixels high.

Widgets
You can customize the widgets to optimize the visual display. To customize widgets, switch to edit mode.
ClickOptions >Edit.

n To save changes, clickDone.

n To cancel changes, click on Discard.
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n To restore the predefined view to the default values, clickOptions >Restore Defaults.

Note - Restore Defaults option is only available after you modify a predefined view.

Adding and Customizing Widgets

To add a Widget:

1. Double-click a view or report to open it.

2. ClickOptions >Edit.

3. Click Add Widget and select the widget type.

a. Enter a title.

b. Select a chart type: vertical bar, horizontal bar, pie, area or line.

c. Select a data category for the X axis.

d. Define how the Top Values are calculated (by number of logs, or by traffic).

e. Set a limit for howmany top values to show.
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f. Optional: click Series - split the results into colored groups with different values for the series.

g. Optional: clickCustomize and define axis titles and legend position.
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a. Enter a title.

b. Select a timeline graphical presentation: vertical bar, doughnut, area or line.

c. Select the data to count.

d. Advanced - split the results into colored groups, with different values for the Series.

e. Define the time-granularity. Enter the number of bars or doughnuts to show.

a. Enter a title.

b. Manage columns: add, edit, remove, and change the order.

c. Select a column on the left and define its settings:

n Enter the number of top values to show.

n Select how values are sorted.

d. Select this option to group results with the same value in one row.
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a. Enter a title.

b. Enter the number of Top Countries to mark.

c. Select to mark Top Source Countries, Top Destination Countries, or both.

d. Define how to find the Top Countries (for example, by number of logs or by traffic).

The infographic widget shows large meaningful values. For example:

Configure an infographic using these settings:
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a. Enter a title

b. Select a field to count. Selecting Nonemeans all the logs that match the filter criteria are
counted.

c. Define filter criteria.

This critieria is in addition to the inherited filters for the report and view layers.

For more, see Filters in "Widgets" on page 52.
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d. Optional: Enter an icon name in the field.

Select a name from the list below. Pay attention to upper and lower case letters and the use of
hyphens.

Icon Used for

apps

attacks

hosts

Gateway

traffic

usercheck

users

new Audit Logs

add Audit Logs

remove Audit logs

modify Audit logs

install-policy

publish

ips

anti-bot

anti-virus

threat-emulation

e. Enter primary text that describes the value counted.

f. Optional: For secondary text, enter a more detailed description.

Use a container to unify multiple widgets into one frame. Add a container, then add, edit, or remove
the widgets inside it.

Note - The container widget cannot be added to a container.
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a. Enter a title.

b. Optional: filter at the container level. The filter applies to all internal widgets.

c. Select the widget order inside the container: Horizontal, Vertical, Grid or Tabs.

After the container is added to the view, you can configure it further.

a. Remove the widget from the container.

b. Add a new widget.

c. Edit the settings for the container, or edit one of the widgets in the list.
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Use this window to add textual explanations to the View text box.

4. ClickOK.

5. Select filters for the widget in addition to the inherited filters from the report and view layers. See
Filters in "Widgets" on page 52.

6. Configure settings for the widget.

To customize a widget:

1. ClickOptions >Edit.

2. Select the widget to customize.

3. Select the graphic presentation that best fits the information you want to see: chart, table, timeline...

4. Select filters for the widget in addition to the inherited filters from the report and view layers.

5. Configure settings for the widget.

6. Delete a widget.
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Filters

The search bar is used to apply on-demand filters, but you can also save filters with the view / report
definition.

There are different layers of filters:

1. Filters to apply to the full report.

2. Filters to apply to a view (specified page in a report) and all widgets that this page includes.

3. Filters to apply to the selected widget.

To edit the view filter:

1. Click the + (plus) button to add a filter.
To delete a filter, click the X button.

2. Select a field.
To enable free text search, select Custom Filter.

3. Select a comparison method.

4. Select or enter the value.
You can define multiple values.

Filtering for Active Directory User Groups

You can filter logs, reports, and views for one or more Active Directory groups.
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1. In your Access Control Policy, create an Access Role that includes all the Active Directory groups
you want to have in the query.

2. Install the Access Control Policy on the Security Gateways.

3. Look at the Identity Awareness login logs, and copy the names of the relevant groups. They usually
have the prefix "ad_".

4. Add a filter for the field User Group and type or paste the name of the group that you want to include
in the filter. For multiple groups, use a comma-separated list.
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Logging
This section deals with logging.

Log Analysis
SmartConsole lets you transform log data into security intelligence. Search results are fast and
immediately show the log records you need. The Security Gateways send logs to the Log Servers on the
Security Management Server or on a dedicated server. Logs show on the SmartConsole Logs & Monitor
Logs tab. You can:

n Quickly search through logs with simple Google-like searches.

n Select from many predefined search queries to find the applicable logs.

n Create your own queries using a powerful query language.

n Monitor logs from administrator activity and connections in real-time.

Sample Log Analysis
This is a sample procedure that shows how to do an analysis of a log of a dropped connection.

To show a log of a dropped connection:

1. Log into SmartConsole.

2. Connect to the IP address of the Security Management Server, not to a Log Server.

3. In the Security Policies >Access Control >Policy view, select a rule with the Drop action.

4. In the bottom pane, click Logs.

This shows the logs for connections that were dropped by the specific rule.

5. Double-click a log.

The Log Details window opens.

Using the Logs View

In SmartConsole:

1. Go to Logs and Monitoring >View.

2. ClickNew, and selectNew View.

3. In the New View window, enter:
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n Name

n Category - For example, select Access Control

n Description (optional)

4. In the new window that opens, create a query. ClickOptions >View Filter and select blade and app
control.

5. Click Add Widget to customize how you see the data that comes back from the query.

Start with a Timeline of all events.

In Table, you can create a table that contains multiple fields such as user, application name, and the
amount of traffic. There are more widgets you can use: map, infographic, rich text, chart, and
container (for multiple widgets).

After you save the dashboard (done), you can schedule and get an automatic email at multiple
intervals.

This is an example of the Logs view.

Item Description

1 Queries - Predefined and favorite search queries.

2 Time Period - Search with predefined custom time periods.

3 Query search bar - Define custom queries in this field. You can use the GUI tools or manually
enter query criteria. Shows the query definition for the most recent query.

4 Log statistics pane - Shows top results of the most recent query.
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Item Description

5 Results pane - Shows log entries for the most recent query.

SmartView Log Viewer
Use Case - You are the system administrator at a small company and are concerned that some
employees spend too much time looking at Facebook. You want a way to monitor the employee application
use.

The SmartViewWeb Application is one of the SmartEvent clients that you can use to analyze events that
occur in your environment. Use the SmartViewWeb Application to see an overview of the security
information for your environment. It has the same real-time event monitoring and analysis views as
SmartConsole. The convenience is that you do not have to install a client.

To log in to SmartEvent using SmartViewWeb Application:

Browse to
https://<SecurityManagement Server IP Address>/smartview/
or
https://<SecurityManagement Server host name>/smartview/

Note - The URL is case sensitive.

SmartView advantages:

n Available for non-admin users

n Export up to 1M logs

n Integrated top statistics and docked card

n Support for High Contrast theme

In SmartView (web browser):

In SmartView, you first filter for the application and then by user.

1. Click the + icon to open a new tab and select Views >Access Control.

2. Right-click the User column and drill down to see the user activity or create a filter for this user in
your current view.

You can schedule for all activities for a user, but cannot set the system to trigger an alert at a certain
threshold.

To access SmartView:

From the browser:

Go to: https://<management IP address>/SmartView/

SmartView opens by default in theGeneral Overview tab. This shows the statistics, Software Blades,
timelines, and more. Any open tabs from the previous session are retained. Note - SmartView Log Viewer
is available even without SmartEvent, but the default page is different.

To open a new tab, click +.
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The Audit Logs tab shows audit logs which are changes done in the management. The Logs > Logs View
tab shows blade activities.

To select which columns are shown:

1. Right-click on a column heading and select Profile editor.

The Profile editor window opens.

2. Select fields to add to or remove from the selected profile.

3. ClickOK.

To set user display preferences:

1. Click the arrow next to your user name and selectUser Preferences.

2. For Locale, select the display language.

3. For First day of the week, select the day of the week for the weekly logs to start.

4. For Theme, selectDefault or High Contrast. In High Contrast, the view display is white text on a
black background.

5. For Email server settings, select Edit to enter the email server details.

6. ClickOK.

Exporting Logs

Apply a filter to select the logs you want to export. Currently, you can only export logs to Excel.

To export logs:

1. In the Logs tab, clickOptions and select Export >Export to Excel.

The Excel Exportwindow opens.

2. Select the Logs Amount.

3. Select the Exported Columns - All columns or Visible columns.

4. ClickOK.

5. A popup shows when the export process starts. When you see a message that the exported
completed successfully, clickDownload. All exported logs also appear in the archive tab.

Working with Logs
This section explains how to work with logs.

Choosing Rules to Track
Logs are useful if they show the traffic patterns you are interested in. Make sure your Security Policy tracks
all necessary rules. When you track multiple rules, the log file is large and requires more disk space and
management operations.
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To balance these requirements, track rules that can help you improve your cyber security, help you
understand of user behavior, and are useful in reports.

Configuring Tracking in a Policy Rule

To configure tracking in a rule:

1. Right-click in the Track column.

2. Select a tracking option.

3. Install the policy.

Tracking Options
Select these options in the Track column of a rule:

n None - Do not generate a log.

n Log -This is the default Track option. It shows all the information that the Security Gateway used to
match the connection. At a minimum, this is the Source, Destination, Source Port, and Destination
Port. If there is a match on a rule that specifies an application, a session log shows the application
name (for example, Dropbox). If there is a match on a rule that specifies a Data Type, the session
log shows information about the files, and the contents of the files.

n Accounting - Select this to update the log at 10 minutes intervals, to show howmuch data has
passed in the connection: Upload bytes, Download bytes, and browse time.

Note - When upgrading from R77.X or from R80 versions to R80.40, there are changes to the behavior of
the options in the Track column. To learn more see sk116580.

Advanced Track options

Detailed Log and Extended Log are only available if one or more of these Blades are enabled on the
Layer: Application & URL Filtering,Content Awareness, orMobile Access.

n Detailed Log -Equivalent to the Logoption, but also shows the application that matched the
connections, even if the rule does not specify an application. Best Practice -Use for a cleanup rule
(Any/internet/Accept) of an Applications and URL Filtering Policy Layer that was upgraded from an
R77 Application Control Rule Base.

n Extended Log -Equivalent to the Detailedoption, but also shows a full list of URLs and files in the
connection or the session. The URLs and files show in the lower pane of the Logs view.

Log Generation

n per Connection - Select this to show a different log for each connection in the session. This is the
default for rules in a Layer with only Firewall enabled. These are basic firewall logs.

n per Session - Select this to generate one log for all the connections in the same session (see "Log
Sessions" on the next page). This is the default for rules in a Layer with Application & URL Filtering
or Content Awareness enabled. These are basic Application Control logs.

Alert:

For each alert option, you can define a script inMenu >Global Properties > Log and Alert >Alerts.

http://supportcontent.checkpoint.com/solutions?id=sk116580
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n None - Do not generate an alert.

n Alert - Generate a log of type Alert and run a command, such as: Show a popup window, send an
email alert or an SNMP trap alert, or run a user-defined script as defined in theGlobal Properties.

n SNMP - Generate a log of type Alert and send an SNMP alert to the SNMPGUI, as defined in the
Global Properties.

n Mail - Generate a log of type Alert and send an email to the administrator, as defined in theGlobal
Properties.

n User Defined Alert - Generate a log of type Alert and send one of three possible customized alerts.
The alerts are defined by the scripts specified in theGlobal Properties.

Log Sessions
A session is a user's activity at a specified site or with a specified application. The session starts when a
user connects to an applicationor to a site. The Security Gateway includes all the activity that the user does
in the session in one session log (in contrast to the firewall log which shows top sources, destinations, and
services).

To search for log sessions:

In the Logs tab of the Logs & Monitor view, search for type:Session

To see details of the log session:

In the Logs tab of the Logs & Monitor view, select a session log.

In the bottom pane of the Logs tab, click the tabs to see details of the session log:

n Connections - Shows all the connections in the session. These show if Per connection is selected
in the Track option of the rule.

n URLs - Shows all the URLs in the session. These show if Extended Log is selected in the Track
option of the rule.

n Files - Shows all the files uploaded or downloaded in the session. These show if Extended Log is
selected in the Track option of the rule, or if a Data Type was matched on the connection.

To see the session log for a connection that is part of a session:

1. In the Logs tab of the Logs & Monitor view, double-click on the log record of a connection that is
part of a session.

2. In the Log Details, click the session icon (in the top-right corner) to search for the session log in a
new tab.

To configure the session timeout:

By default, after a session continues for three hours, the Security Gateway starts a new session log. You
can change this in SmartConsole from theManage & Settings view, in Blades >Application & URL
Filtering >Advanced Settings >General >Connection unification.
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Viewing Rule Logs
You can search for the logs that are generated by a specific rule, from the Security Policy or from the Logs
& Monitor > Logs tab.

To see logs generated by a rule (from the Security Policy):

1. In SmartConsole, go to the Security Policies view.

2. In the Access Control Policy or Threat Prevention Policy, select a rule.

3. In the bottom pane, click one of these tabs to see:

n Logs - By default, shows the logs for the Current Rule. You can filter them by Source,
Destination, Blade, Action, Service, Port, Source Port,Rule (Current rule is the default),
Origin,User, orOther Fields.

n History (Access Control Policy only) - List of rule operations (Audit logs) related to the rule in
chronological order, with the information about the rule type and the administrator that made
the change.

To see logs generated by a rule (by Searching the Logs):

1. In SmartConsole, go to the Security Policies view.

2. In the Access Control Policy or Threat Prevention Policy, select a rule.

3. Right-click the rule number and selectCopy Rule UID.

4. In the Logs & Monitor > Logs tab, search for the logs in one of these ways:

n Paste the Rule UID into the query search bar and click Enter.

n For faster results, use this syntax in the query search bar:

layer_uuid_rule_uuid:*_<UID>

For example, paste this into the query search bar and click Enter:

layer_uuid_rule_uuid:*_46f0ee3b-026d-45b0-b7f0-5d71f6d8eb10

Packet Capture
You can capture network traffic. The content of the packet capture provides a greater insight into the traffic
which generated the log. With this feature activated, the Security Gateway sends a packet capture file with
the log to the Log Server. You can open the file, or save it to a file location to retrieve the information a later
time.

For some blades, the packet capture option is activated by default in Threat Policy.

To deactivate packet capture (in Threat Policy only):

1. In SmartConsole, in the Security Policies view

2. In the Track column of the rule, right-click and clear Packet Capture.
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To see a packet capture:

1. In SmartConsole, go to the Logs & Monitor view.

2. Open the log.

3. Click the link in the Packet Capture field.

The Packet Capture opens in a program associated with the file type.

4. Optional:Click Save to save the packet capture data on your computer.

Searching the Logs
SmartConsole lets you quickly and easily search the logs with many predefined log queries.

To see the predefined queries:

1. Open SmartConsole > Logs & Monitor view.

2. ClickQueries.

To create your own queries, see "Creating CustomQueries" on page 72.

Running Queries

To create and run a query:

1. In the query search bar, click Enter SearchQuery (Ctrl+F).

2. Enter or select query criteria.

To manually refresh your query:

ClickRefresh (F5).

To continuously refresh your query (Auto-Refresh):

Click Auto -Refresh (F6). The icon is highlighted when Auto-Refresh is enabled.

The query continues to update every five seconds while Auto-Refresh is enabled. If the number of logs
exceeds 100 in a five-second period, the logs are aggregated, and the summary view shows.

Showing Query Results

Query results can include tens of thousands of log records. To prevent performance degradation,
SmartConsole only shows the first set of results in the Results pane. Typically, this is a set of 50 results.

Scroll down to showmore results. As you scroll down, SmartConsole extracts more records from the log
index on the Security Management Server or Log Server, and adds them to the results set. See the
number of results above the Results pane.

For example, on the first run of a query, you can see the first 50 results out of over 150,000 results. When
you scroll down, you can see the first 100 results out of over 150,000.
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Customizing the Results Pane

By default, SmartConsole shows a predefined set of columns and information based on the selected blade
in your query. This is known as the Column Profile. For example:

n The DLP column profile includes columns for: Blade, Type, DLP Incident UID, and severity.

n The Threat Prevention column profile includes columns for: Origin, Action, Severity, and Source
User.

A column profile is assigned based on the blade that occurs most frequently in the query results. This is
called Automatic Profile Selection, and is enabled by default.

The Column Profile defines which columns show in the Results Pane and in which sequence. You can
change the Column Profile as necessary for your environment.

To use the default Column Profile assignments:

n Right-click a column heading and selectColumns Profile >Automatic Profile Selection.

To manually assign Column Profile assignments by default:

n Right-click a column heading and selectColumns Profile >Manual Profile Selection.

To manually assign a different Column Profile:

1. Right-click a column heading and selectColumns Profile.

2. Select a Column Profile from the options menu.

To change a Column Profile:

1. Right-click a column heading and selectColumns Profile >Edit Profile.

2. In the Show Fields window, select a Column Profile to change.

3. Select fields to add from the Available Fields column.

4. Click Add.

5. Select fields to remove from the Selected Fields column.

6. ClickRemove.

7. Select a field in the Selected Fields.

8. ClickMove Up orMove Down to change its position in the Results Pane.

9. Double-click the Width column to change the default column width for the selected field.

To change the column width:

1. Drag the right column border in the Results Pane.

2. Right-click and select Save Profile.

Changes made to the column are saved for future sessions.
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Creating Custom Queries

Queries can include one or more criteria. You can modify an existing predefined query or create a new one
in the query box.

To modify a predefined query:

Click inside the query box to add search filters.

To save the new query in the Favorites list:

1. ClickQueries >Add to Favorites.

The Add to Favorites window opens.

2. Enter a name for the query.

3. Select or create a new folder to store the query

4. Click Add.

Selecting Query Fields

You can enter query criteria directly from the Query search bar.

To select field criteria:

1. If you start a new query, clickClear to remove query definitions.

2. Put the cursor in the Query search bar.

3. Select a criterion from the drop-down list or enter the criteria in the Query search bar.

Selecting Criteria from Grid Columns

You can use the column headings in theGrid view to select query criteria. This option is not available in the
Table view.

To select query criteria from grid columns:

1. In the Results pane, right-click on a column heading.

2. Select Add Filter.

3. Select or enter the filter criteria.
The criteria show in theQuery search bar and the query runs automatically.

To enter more criteria, use this procedure or other procedures.

Manually Entering Query Criteria

You can enter query criteria directly in theQuery search bar. You can manually create a new query or
make changes to an existing query that shows in theQuery search bar.

As you enter text, the Search shows recently used query criteria or full queries. To use these search
suggestions, select them from the drop-down list.
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Query Language Overview
A powerful query language lets you show only selected records from the log files, according to your criteria.
To create complex queries, use Boolean operators, wildcards, fields, and ranges. The log search tool
suggests, or automatically enters, an appropriate Boolean operator. This can be an implied AND operator,
which does not explicitly show.

This section refers in detail to the query language.

When you use SmartConsole to create a query, the applicable criteria show in theQuery search bar.

The basic query syntax is [<Field>:]<Filter Criterion>.

To put together many criteria in one query, use Boolean operators:

[<Field>:]<Filter Criterion> AND|OR|NOT [<Field>:]<Filter Criterion> ...

Most query keywords and filter criteria are not case sensitive, but there are some exceptions. For example,
source:<X> is case sensitive (Source:<X> does not match). If your query results do not show the
expected results, change the case of your query criteria, or try upper and lower case.

When you use queries with more than one criteria value, an AND is implied automatically, so there is no
need to add it. Enter OR or other boolean operators if needed.

Criteria Values

Criteria values are written as one or more text strings. You can enter one text string, such as a word, IP
address, or URL, without delimiters. Phrases or text strings that contain more than one word must be
surrounded by quotation marks.

One word string examples:

n John

n inbound

n 192.168.2.1

n mahler.ts.example.com

n dns_udp

Phrase examples

n "John Doe"

n "Log Out"

n "VPN-1 Embedded Connector"

IP Addresses

IPv4 and IPv6 addresses used in log queries are counted as one word. Enter IPv4 address with dotted
decimal notation and IPv6 addresses with colons. You can also use the '*' wildcard character with IP
addresses.

Example:
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n 192.0.2.1

n 2001:db8::f00:d

Wildcards

You can use the standard wildcard characters (* and ?) in queries to match variable characters or strings in
log records. You can use more than the wildcard character.

Wildcard syntax

n The ? (question mark) matches one character.

n The * (asterisk) matches a character string.

Examples:

n Jo? shows Joe and Jon, but not Joseph.

n Jo* shows Jon, Joseph, and John Paul.

If your criteria value contains more than one word, you can use the wildcard in each word. For example,
'Jo* N*' shows Joe North, John Natt, Joshua Named, and so on.

Log Queries

You can run a log query in these ways:

n Standard suffix - Search for subnets using the standard suffix.

l Examples: 192.168.0.0/16 (shows all records for 192.168.0.0 to 192.168.255.255 inclusive)

or 192.168.1.0/24 (shows all records for 192.168.1.0 to 192.168.1.255 inclusive)

n Wildcard

l Examples 192.168.2.* shows all records for 192.168.2.0 to 192.168.2.255 inclusiv

192.168.* shows all records for 192.168.0.0 to 192.168.255.255 inclusive

l Search for a field with non-empty values only using field:*.

Examples: src:*, severity:*, appi_name:*, protection_type:*

Field Keywords

You can use predefined field names as keywords in filter criteria. The query result only shows log records
that match the criteria in the specified field. If you do not use field names, the query result shows records
that match the criteria in all fields.

This table shows the predefined field keywords. Some fields also support keyword aliases that you can
type as alternatives to the primary keyword.

Keyword Keyword
Alias Description

severity Severity of the event

app_risk Potential risk from the application, of the event
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Keyword Keyword
Alias Description

protection Name of the protection

protection_
type

Type of protection

confidence_
level

Level of confidence that an event is malicious

action Action taken by a security rule

blade product Software Blade

destination dst Traffic destination IP address, DNS name or Check Point network
object name

origin orig Name of originating Security Gateway

service Service that generated the log entry

source src Traffic source IP address, DNS name or Check Point network
object name

user User name

Syntax for a field name query:

<field name>:<values>

n <field name> - One of the predefined field names

n <values> - One or more filters

To search for rule number, use the Rule field name. For example:

rule:7.1

If you use the rule number as a filter, rules in all the Layers with that number are matched.

To search for a rule name, you must not use the Rule field. Use free text. For example:

"Block Credit Cards"

Best practice:Do a free text search for the rule name. Make sure rule names are unique and not reused in
different Layers.

Examples:

n source:192.168.2.1

n action:(Reject OR Block)

You can use the OR Boolean operator in parentheses to include multiple criteria values.

Important - When you use fields with multiple values, you must:
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n Write the Boolean operator, for exampleOR.

n Use parentheses.

Boolean Operators

You can use the Boolean operators AND,OR, and NOTto create filters with many different criteria. You
can put multiple Boolean expressions in parentheses.

If you enter more than one criteria without a Boolean operator, the ANDoperator is implied. When you use
multiple criteria without parentheses, theORoperator is applied before the ANDoperator.

Examples:

n blade:"application control" AND action:block

Shows log records from the Application &URL Filtering Software Blade where traffic was blocked.

n 192.168.2.133 10.19.136.101

Shows log entries that match the two IP addresses. The ANDoperator is presumed.

n 192.168.2.133 OR 10.19.136.101

Shows log entries that match one of the IP addresses.

n (blade:Firewall OR blade:IPS OR blade:VPN) AND NOT action:drop

Shows all log entries from the Firewall, IPS or VPN blades that are not dropped. The criteria in the
parentheses are applied before the AND NOT criterion.

n source:(192.168.2.1 OR 192.168.2.2) AND destination:17.168.8.2

Shows log entries from the two source IP addresses if the destination IP address is 17.168.8.2.
This example also shows how you can use Boolean operators with field criteria.

Log Server High Availability
In SmartConsole, you can configure a Security Gateway, that when it fails to send its logs to one Log
Server, it will send its logs to a secondary Log Server. To support this configuration, you can add Log
Servers to a single SmartEvent Correlation Unit. In this way, the SmartEvent Correlation Unit gets an
uninterrupted stream of logs from both servers and continues to correlate all logs.

Working with Syslog Servers
Syslog (System Logging Protocol) is a standard protocol used to send system log or event messages to a
specific server, the syslog server. The syslog protocol is enabled on most network devices such as routers
and switches.

Use Case

Syslog is used by many log analysis tools included in the cloud. If you want to use these tools, make sure
Check Point logs are sent to from the gateway to the syslog server in syslog format.

By default, gateway logs are sent to the Security Management Server. But you can configure gateways to
send logs directly to syslog servers.
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1. Define syslog servers.

2. Update the logging properties of the gateways.

These syslog protocols are supported: RFC 3164 (old) and RFC 5424 (new)

These features are not supported: IPv6 logs and Software Blade logs.

To create a syslog server:

1. OpenObject Explorer >New >Server >More >Syslog.

2. Configure these fields:

n Name - Enter a name for this server, to be a unique network object.

n Host - Select an existing host or clickNew to define a new computer or appliance.

n Port - Enter the port number for syslog traffic. (Default = 514)

n Version - Select BSD Protocol or Syslog Protocol.

3. ClickOK.

Note - Syslog is not an encrypted protocol. Make sure the Security Gateway and the Log Proxy are
located close to each other and that they communicate over a secure network.

You can configure a gateway to send logs to multiple syslog servers. The syslog servers must be the
same type: BSD Protocol or Syslog Protocol.

To send the logs of a gateway to syslog servers:

1. In SmartConsole on the gateway Properties >General Properties page >Management tab make
sure Logging & Status is selected.

2. On the Logs page, in the Send logs and alerts to these log servers table, click the green (+)
button to add syslog servers.

Note - You cannot configure a Syslog server as a backup server.

3. ClickOK.

4. Install policy.

The fwsyslog_enable kernel parameter enables or disables the Syslog in Kernel feature:

n 0 = Disabled (default)

n 1 = Enabled

You can enable or disable Syslog in Kernel temporarily (until the system reboots) or permanently (until
manually disabled).

To temporarily enable Syslog in Kernel on a Security Gateway:

1. Run in the Expert mode:

# fw ctl set int fwsyslog_enable 1

2. Install Policy in SmartConsole.
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To permanently enable Syslog in Kernel on a Security Gateway:

1. Run in the Expert mode:

echo fwsyslog_enable=1 >> $FWDIR/boot/modules/fwkern.conf

2. Reboot the Security Gateway.

To disable Syslog in Kernel temporarily:

Run: # fw ctl set int fwsyslog_enable 0

To disable Syslog in Kernel permanently:

1. Open $FWDIR/boot/modules/fwkern.conf in a text editor and do one of these actions:

n Set

fwsyslog_enable=0

or

n Delete the entire fwsyslog_enable line.

2. Reboot the Security Gateway.

To see the Syslog in Kernel status:

# fw ctl get int fwsyslog_enable

You can see the count of logs sent to syslog from the kernel. Log counters start when you install the policy.

To see log count for an instance:

# fw -i <CoreXL Firewall Instance Number> ctl get size fwsyslog_nlogs_
counter

Sample output:

fwsyslog_nlogs_counter = 21

To see log count for all instances:

1. Open two command line connections to the Security Gateway.

2. On the first CLI connection, run: # fw ctl zdebug

3. On the second CLI connection, run: # fw ctl set size fwsyslog_print_counter 1

4. On the first shell, see the counter for each instance and the sum of all instances.

Sample output:

;[cpu_2];[fw4_0];Number of logs sent from instance 0 is 43;

;[cpu_2];[fw4_0];Number of logs sent from instance 1 is 39;

;[cpu_2];[fw4_0];Number of logs sent from instance 2 is 50;

;[cpu_2];[fw4_0];Total fwsyslog_nlogs_counter = 132;
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To see the Syslog in Kernel status:

# fw ctl get int fwsyslog_enable

You can see the count of logs sent to syslog from the kernel. Log counters start when you install the policy.

To see log count for an instance:

# fw -i <CoreXL Firewall Instance Number> ctl get size fwsyslog_nlogs_
counter

Sample output:

fwsyslog_nlogs_counter = 21

To see log count for all instances:

1. Open two command line connections to the Security Gateway.

2. On the first CLI connection, run: # fw ctl zdebug

3. On the second CLI connection, run: # fw ctl set size fwsyslog_print_counter 1

4. On the first shell, see the counter for each instance and the sum of all instances.

Sample output:

;[cpu_2];[fw4_0];Number of logs sent from instance 0 is 43;

;[cpu_2];[fw4_0];Number of logs sent from instance 1 is 39;

;[cpu_2];[fw4_0];Number of logs sent from instance 2 is 50;

;[cpu_2];[fw4_0];Total fwsyslog_nlogs_counter = 132;

For more on syslog, see: "Appendix: Manual Syslog Parsing" on page 177
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Event Analysis
This section deals with analyzing events.

Event Analysis with SmartEvent
The SmartEvent Software Blade is a unified security event management and analysis solution that delivers
real-time, graphical threat management information. SmartConsole, SmartViewWeb Application, and the
SmartEvent GUI client consolidate billions of logs and show them as prioritized security events so you can
immediately respond to security incidents, and do the necessary actions to prevent more attacks. You can
customize the views to monitor the events that are most important to you. You can move from a high level
view to detailed forensic analysis in a few clicks. With the free-text search and suggestions, you can quickly
run data analysis and identify critical security events.

What is an Event?
An event is a record of a security incident. It is based on one or more logs, and on rules that are defined in
the Event Policy.

An example of an event that is based on one log: A High Severity Anti-Bot event. One Anti-Bot log with a
Severity of High causes the event to be recorded.

An example of an event that is based on more than one log: A Certificate Sharing event. Two login logs with
the same certificate and a different user cause the event to be recorded.

How Are Logs Converted to Events?

SmartEvent automatically defines logs that are not Firewall, VPN, or HTTPS Inspection logs, as events.

Events that are based on a suspicious pattern of one or more logs, are created by the SmartEvent
Correlation Unit. These correlated events are defined in the SmartEvent client GUI, in the Policy tab.

Most logs are Firewall, VPN and HTTPS inspection logs. Therefore, SmartEvent does not define them as
events by default to avoid a performance impact on the SmartEvent Server. For logs from R77.XGateways
and lower: To create events for Firewall, in the SmartEvent Policy tab, enable Consolidated Sessions >
Firewall Session.

The SmartEvent Architecture
SmartEvent has some components that work together to help track down security threats and make your
network more secure.

This is how they work together. The numbers refer to the diagram:

n SmartEvent Correlation Unit (3) analyzes log entries on Log Servers (2) and stores the event in the
same way the log server stores logs.

n SmartEvent Server (4) contains the Events Database (5).

n The SmartEvent and SmartConsole clients (6) manage the SmartEvent Server.
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Item Description Purpose

Log data flow

Event data flow

1 Check
Point
Security
Gateway

Sends logs to the Log Server.

2 Log Server Stores logs.

3 SmartEvent
Correlation
Unit

Identifies events: Analyzes each log entry from a Log Server, and looks for
patterns according to the installed Event Policy. The logs contain data from
Check Point products and certain third-party devices. When a threat pattern is
identified, the SmartEvent Correlation Unit forwards the eventto the SmartEvent
Server.

4 SmartEvent
Server

The SmartEvent Server:

n Indexes logs for SmartView

n Defines the event policy

n Manages correlation units

5 Events
database

Stores events. Located on the SmartEvent Server.

6 SmartEvent
client

Shows the received events. Uses the clients to manage events (for example: to
filter and close events), fine-tunes, and installs the Event Policy. The clients are:

n SmartConsole

n SmartViewWeb Application

The SmartEvent components can be installed on one computer (that is, a standalone deployment) or
multiple computers and sites (a distributed deployment). To handle higher volumes of logging activity, we
recommend a distributed deployment. Each SmartEvent Correlation Unit can analyze logs from more than
one Log Server or Domain Log Server.



Event Analysis

Logging andMonitoring R80.40 Administration Guide      |      82

SmartEvent Correlation Unit
The SmartEvent Correlation Unit analyzes the log entries and identifies events from them. During analysis,
the SmartEvent Correlation Unit:

n Marks log entries that are not stand-alone events, but can be part of a larger pattern to be identified
later.

n Takes a log entry that meets one of the criteria set in the Events Policy, and generates an event.

n Takes a new log entry that is part of a group of items. Together, all these items make up a security
event. The SmartEvent Correlation Unit adds it to an ongoing event.

n Discards log entries that do not meet event criteria.

SmartEvent Correlation Unit High Availability
Multiple correlation units can read logs from the same Log Servers. That way, the units provide
redundancy if one of them fails. The events that the Correlation Units detect are duplicated in the
SmartEvent database. But these events can be disambiguated if you filter them with the Detected By field
in the Event Query definition. The Detected By field specifies which SmartEvent Correlation Unit detected
the event.

The SmartView Web Application
The SmartViewWeb Application is one of the SmartEvent clients that you can use to analyze events that
occur in your environment. Use the SmartViewWeb Application to see an overview of the security
information for your environment. It has the same event monitoring and analysis views as SmartConsole.
The convenience is that you do not have to install a client.

To log in to SmartEvent using SmartViewWeb Application:

Browse to
https://<SecurityManagement Server IP Address>/smartview/
or
https://<SecurityManagement Server host name>/smartview/

Configuring SmartEvent Policy and Settings
This section discusses how to configure SmartEvent policy and settings.

Opening the SmartEvent GUI Client
Use the Policy tab of the SmartEvent GUI client to configure and customize the events that define the
SmartEvent Policy.
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To open the SmartEvent GUI client:

1. Open SmartConsole > Logs & Monitor.

2. Click (+) to open a Catalog ( new tab).

3. Click SmartEvent Settings & Policy.

Policy Tab
Define the Event Policy in the Event Policy tab. Most configuration steps occur in the Policy tab. You
define system components, such as SmartEvent Correlation Unit, lists of blocked IP addresses and other
general settings.

The types of events that SmartEvent can detect are listed here, and sorted into a number of categories. To
change each event, change the default thresholds and set Automated Responses. You can also disable
events.

The Policy tab has these sections:

n Selector Tree - The navigation pane.

n Detail pane - The settings of each item in the Selector Tree.

n Description pane - A description of the selected item.

You can edit the event policy in one of these ways:

n Fine-tune the Event Policy.

n Change the existing Event Definition to see the events that interest you in "Modifying Event
Definitions" on the next page.

n Create new Event Definitions to see the events that are not included in the existing definitions.

Save Event Policy

Modifications to the Event Policy do not take effect until saved on the SmartEvent Server and installed to
the SmartEvent Correlation Unit.

To enable changes made to the Event Policy:

1. Click File >Save.

2. Click Actions > Install Event Policy.

Revert Changes

You can undo changes to the Event Policy, if they were not saved.

To undo changes: click File >Revert Changes.
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Event Definitions and General Settings
The Selector tree is divided into two branches: Event Policy andGeneral Settings. The events
detectable by SmartEvent are organized by category in the Event Policy branch. Select an event
definition to show its configurable properties in the Detail pane, and a description of the event in the
Description pane. Clear the property to remove this event type from the Event Policy the next time the
Event Policy is installed.

TheGeneral Settings branch contains Initial Settings. For example: To define SmartEvent Correlation
Unit, which is typically used for the initial configuration. Click aGeneral Settings item to show its
configurable properties in the Detail pane.

For details on specified attacks or events, refer to the Event Definition Detail pane.

Event Definition Parameters
When an event definition is selected, its configurable elements appear in the Detail pane, and a
description of the event is displayed in the Description pane. These are the usual types of configurable
elements:

n Thresholds, such asDetect the event when more than x connections were detected over y
seconds

n Severity, such asCritical,Medium, Informational, etc.

n "Automatic Reactions" on the next page such as Block Source or run External Script

n "Exceptions" on page 89

n Time Object, such as to issue an event if the following occurs outside the followingWorking Hours

Not all of these elements appear for every Event Definition. After you install and run SmartEvent for a short
time, you will discover which of these elements need to be fine-tuned per Event Definition.

For configuration information regarding most objects inGeneral Settings, see "SystemAdministration" on
page 106.

Modifying Event Definitions
SmartEvent constantly takes data from your Log Servers, and searches for patterns in all the network
chatter that enters your system.

Depending on the levels set in each Event Definition, the number of events detected can be high. But only
a portion of those events can be meaningful. You can change the thresholds and other criteria of an event,
to reduce the number of false alarms.

Event Threshold
The Event Threshold allows you to modify the limits that, when exceeded, indicate that an event occurred.
Limits include the number of logs, and the timeframe in which they occurred:

Detect the event when more thanx logs were detected over a period ofy seconds.

To decrease the number of false alarms based on a particular event, increase the number of logs and/or
the timeframe for them to occur.



Event Analysis

Logging andMonitoring R80.40 Administration Guide      |      85

Severity
To modify the severity of an event, select a severity level from the drop-down list.

If the event is based on Threat Prevention logs, the event gets the severity from the protection type, not
from the severity configured here.

To overwrite the severity:

1. Go to SmartEvent >Policy.

2. Select an event and right-click >Select Properties.

The Edit Event Definitionwindow opens.

3. In the Event Format tab, selectDetermine event's display name and severity from event logs.

Automatic Reactions
When detected, an event can activate an Automatic Reaction. The SmartEvent administrator can create
and configure one Automatic Reaction, or many, according to the needs of the system.

For example: AMail Reaction can be defined to tell the administrator of events to which it is applied.
Multiple Automatic Mail Reactions can be created to tell a different responsible party for each type of event.

To create an automatic reaction:

1. Create an automatic reaction object in the Event definition, or fromGeneral Settings >Objects >
Automatic Reactions.

2. Assign the Automatic Reaction to an event (or to an exception to the event).

3. To save the Event Policy, click File >Save

4. To install the Event Policy on the SmartEvent Correlation Unit, click Actions > Install Event Policy.

These are the types of Automatic Reactions:

n Mail - Tell an administrator by email that the event occurred. See "Creating aMail Reaction" on the
next page.

n Block Source - Instruct the Security Gateway to block the source IP address from which this event
was detected for a configurable timeframe . Select a timeframe from one minute to more than three
weeks. See "Creating a Block Source Reaction" on page 87.

n Block Event activity - Instruct the Security Gateway to block a distributed attack that emanates
from multiple sources, or attacks multiple destinations for a configurable timeframe. Select a
timeframe from one minute to more than three weeks). See "Creating a Block Event Activity
Reaction" on page 87.

n External Script - Run a script that you provide. See "Creating an External Script Automatic
Reaction" on page 87 to write a script that can exploit SmartEvent data.

n SNMP Trap - Generate an SNMPTrap. See "Creating an SNMP Trap Reaction" on page 87.

You can send event fields in the SNMPTrap message. The format for such an event field is [seam_
event_table_field]. This list represents the possible seam_event table fields:

AdditionalInfo varchar(1024)
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AutoReactionStatus varchar(1024)

Category varchar(1024)

DetectedBy integer

DetectionTime integer

Direction integer

DueDate integer

EndTime integer

EventNumber integer

FollowUp integer

IsLast integer

LastUpdateTime integer

MaxNumOfConnections integer

Name varchar(1024), NumOfAcceptedConnections integer

NumOfRejectedConnections integer

NumOfUpdates integer

ProductCategory varchar(1024)

ProductName varchar(1024)

Remarks varchar(1024)

RuleID varchar(48)

Severity integer

StartTime integer

State integer

TimeInterval integer

TotalNumOfConnections varchar(20)

User varchar(1024)

Uuid varchar(48)

aba_customer varchar(1024)

jobID varchar(48)

policyRuleID varchar(48)

Creating a Mail Reaction

1. Select Add >Mail.

2. Give the automatic reaction a significant name.

3. Fill out theMail Parameters of From, To and cc.
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4. To add multiple recipients, separate each email address with a semi-colon.

Note - the Subject field has the default variables of [EventNumber] - [Severity] - [Name]. These
variables automatically adds to the mail subject the event number, severity and name of the event
that triggered this reaction. These variables can be removed at your discretion.

5. Optional: Include your own standard text for each mail reaction.

6. Enter the domain name of the SMTP server.

7. Select Save.

Creating an SNMP Trap Reaction

1. Select Add >SNMP Trap.

2. Give the automatic reaction a significant name.

3. Fill out the SNMP Trap parameters ofHost,Message,OID and Community name.

The command send_snmp uses values that are found in the file chkpnnt.mib, in the directory
$CPDIR/lib/snmp/. AnOID value used in the SNMP Trap parameters windowmust be defined
in chkpnnt.mib, or in a file that refers it. If theOID field is left blank, the value is determined from
iso.org.dod.internet.private.enterprises.checkpoint.products.fw.fwEvent =
1.3.6.1.4.1.2620.1.1.11.

When the automatic reaction occurs, the SNMPTrap is sent as a 256 byte DisplayString text.
But, if the OID type is not text, the message is not sent.

4. Select Save.

Creating a Block Source Reaction

1. Select Add >Block Source.

2. Give the automatic reaction a significant name.

3. From the drop-down list, select the number of minutes to block this source.

4. Select Save.

Creating a Block Event Activity Reaction

1. Select Add >Block Event Activity.

2. Give the automatic reaction a significant name.

3. From the drop-down list, select the number of minutes to block this source.

4. Select Save.

Creating an External Script Automatic Reaction

To add an External Script:

1. Create the script.

2. Put the script on the SmartEvent Server
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a. In $RTDIR/bin, create the folder ext_commands. Run:
mkdir $RTDIR/bin/ext_commands

b. Put the script in $RTDIR/bin/ext_commands/ or in a folder under that location. The
path and script name must not contain any spaces.

c. Give the script executable permissions. Run:
chmod +x <script_filename>

3. In the SmartEvent GUI client Policy tab, in Automatic Reactions, Select Add >External Script.

4. In the Add Automatic Reaction window

a. Give the automatic reaction object a significant Name.

b. In Command line, enter the name of the script to run. Specify the name of the script that is
in $RTDIR/bin/ext_commands/ directory. Use the relative path if needed. Do not
specify the full path of $RTDIR/bin/ext_commands/.

c. Select Save.

Guidelines for creating the script

n Run the script manually and make sure it works as expected

n Make sure the script runs for no longer than 10 minutes, otherwise it will be terminated by the
SmartEvent Server.

n Use the event fields in the script:

To refer to the event in the script, define this environment variable:

EVENT=$(cat)

and use $EVENT

Use line editor commands like awk or sed to parse the event and refer to specific fields. You can
print the $EVENT one time to see its format.

The format of the event content is a name-value set - a structured set of fields that have the form:

(name: value ;* );

where name is a string and value is either free text until a semicolon, or a nested name-value set.

This is a sample event:

(Name: Check Point administrator credential guessing; RuleID:
{F182D6BC-A0AA-444a-9F31-C0C22ACA2114}; Uuid:
<42135c9c,00000000,2e1510ac,131c07b6>; NumOfUpdates: 0; IsLast: 0;
StartTime: 16Feb2015 16:45:45; EndTime: Not Completed; DetectionTime:
16Feb2015 16:45:48; LastUpdateTime: 0; TimeInterval: 600;
MaxNumOfConnections: 3; TotalNumOfConnections: 3; DetectedBy:
2886735150;
Origin: (IP: 192.0.2.4; repetitions: 3; countryname: United States;
hostname: theHost) ; ProductName: SmartDashboard; User: XYZ; Source:
(hostname: theHost; repetitions: 3; IP: 192.0.2.4; countryname: United
States) ; Severity: Critical; EventNumber: EN00000184; State: 0;
NumOfRejectedConnections: 0; NumOfAcceptedConnections: 0) ;
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If you need to add more fields to the event:

1. In the SmartEvent GUI client, in the Policy tab, right-click the event, and select Properties >Event
Format tab

2. In the Display column, select the Event fields to have in the Event.

3. Install the Event Policy on the SmartEvent Correlation Unit.

Assigning an Automatic Reaction to an Event

You can add an Automatic Reaction for SmartEvent to run when this type of event is detected.

1. Select the icon [...].

2. Select an Automatic Reaction that you created from the list, or select Add new?. For details on how
to create each type of Automatic Reaction, see above section.

3. Configure the Automatic Reaction.

4. Select Save.

5. ClickOK.

Working Hours
Working Hours are used to detect unauthorized attempts to access protected systems and other forbidden
operations after-hours. To set the Regular Working Hours for an event, select a Time Object that you
have configured from the drop-down list.

To create a Time Object:

1. From the Policy tab, selectGeneral Settings Objects > Time Objects.

2. Click Add.

3. Enter a Name and Description.

4. Select the days and times that are consideredRegular Working Hours.

5. ClickOK.

To assign a Time Object to an event:

1. From the Policy tab, select an event that requires aTime Object (for example,User Login at
irregular hours in the Unauthorized Entry event category).

2. Select the Time Object you created from the drop-down list.

3. Select File >Save.

Exceptions
Exceptions allow an event to be independently configured for the sources, destination, service and other
parameters depending on the event type. For example, if the event Port Scan from Internal Network is
set to detect an event when 30 port scans occur within 60 seconds, you can also define that two port scans
detected from host A within 10 seconds of each other is also an event.
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To add an exception:

1. Under Apply the following exceptions, click Add.

2. Select the Source and/or Destination of the object to apply different criteria for this event.

Note - If you do not see the host object listed, you may need to create it in SmartEvent.(see "System
Administration" on page 106).

High Level Overview of Event Identification
Events are detected by the SmartEvent Correlation Unit. The SmartEvent Correlation Unit scans logs for
criteria that match an Event Definition.

SmartEvent uses these procedures to identify these events:

n "Matching a Log Against Global Exclusions" below

n "Matching a Log Against Each Event Definition" below

n "Creating an Event Candidate" on the next page

n "Matching a Log Against Event Exclusion" on page 94

n "Event Generation" on page 94

Matching a Log Against Global Exclusions

When the SmartEvent Correlation Unit reads a log, it first checks if the log matches all definedGlobal
Exclusions. Global Exclusions (defined on the Policy tab >Event Policy >Global Exclusions) direct
SmartEvent to ignore logs that are not expected to contribute to an event.

If the log matches a Global Exclusion, it is discarded by the system. If not, the SmartEvent Correlation Unit
starts to match it against each Event Definition.

Matching a Log Against Each Event Definition

Each Event Definition contains a filter which is comprised of a number of criteria that must be found in all
matching logs. The criteria are divided by product: The Event Definition can include a number of different
products, but each product has its own criterion.

To match the Event Definition "A", a log from Endpoint Security must match the Action, Event Type, Port,
and Protocol values listed in the Endpoint Security column. A log from a Security Gateway must match the
values listed in its column.

SmartEvent divides this procedure into two steps. The SmartEvent Correlation Unit first checks if the
Product value in the log matches one of the permitted Product values of an Event Definition.
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If Log 1 did not contain a permitted Product value, the SmartEvent Correlation Unit compares the log
against Event Definition "B", and so on. If the log fails to match against an Event Definition, it is
discarded.

The SmartEvent Correlation Unit checks if the log contains the Product-specific criteria to match the Event
Definition. For example: The product Endpoint Security generates logs that involve the Firewall, Spyware,
Malicious Code Protection, and others. The log contains this information in the field Event Type. If an
event is defined to match on Endpoint Security logs with the event type Firewall, an Endpoint Security log
with Event Type "Spyware" fails against the Event Definition filter. Other criteria can be specified to the
Product.

In our example, Log 1 matched Event Definition "A"with a permitted product value. The SmartEvent
Correlation Unit examines if the log contains the necessary criteria for an Endpoint Security log to match.

If the criteria do not match, the SmartEvent Correlation Unit continues to compare the log criteria to other
event definitions.

Creating an Event Candidate

When a log matches the criteria, it is added to an Event Candidate. Event candidates let SmartEvent track
logs until an event threshold is crossed, at which point an event is generated.
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The logs can come from different log servers and be correlated in the same event.

The Event Candidate tracks logs until the criteria is matched (the criteria is the number of logs in a declared
number of seconds).

Each Event Definition can have multiple event candidates, each of which keeps track of logs grouped by
equivalent properties. In the figure above the logs that create the event candidate have a common source
value. They are dropped, blocked or rejected by a Firewall. They are grouped together because the Event
Definition is designed to detect this type of activity that originates from one source. Depending on the event
declaration, if there is a grouping declaration on the source field, it will create a new event candidate.

When a log matches the event definition, but has properties different than those of the existing event
candidates, a new event candidate is created. This event candidate is added to what can be thought of as
the Event Candidate Pool.
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By default, SmartEvent creates a new event candidate for a log with a different source.

To customize the default behavior:

1. Go to SmartEvent >Policy.

2. Select an event and right-click >Select Properties.

The Edit Event Definitionwindow opens.

3. In the Count logs tab, click the options under Select the fields by which distinct Event
Candidates will be created.

4. In the Event Definition Wizard window, select the log fields and clickOK.

To illustrate more, an event defined detects a high rate of blocked connections. SmartEvent tracks the
number of blocked connections for each Firewall, and the logs of the blocked traffic at each Firewall forms
an event candidate. When the threshold of blocked connection logs from a Firewall is surpassed, that
Firewall event candidate becomes an event. While this Event Definition creates one event candidate for
each Firewall monitored, other Event Definitions can create many more.
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The Event Candidate Pool is a dynamic environment, with new logs added and older logs discarded when
they have exceeded an Event Definition time threshold.

Matching a Log Against Event Exclusion

Before SmartEvent generates logs for a specific event, it checks to see if this event candidate attributes are
listed in the exclusions table or not. Event Exclusions are defined on the Policy tab >Event Policy >Event
Exclusions according to the attributes selected.

If an attribute matches an Event Exclusion, it is discarded by the system (an event is not generated). If not,
the SmartEvent Correlation Unit starts to match it against each Event Definition.

Event Generation

When a candidate becomes an event, the SmartEvent Correlation Unit forwards the event to the Event
Database. But to discover an event does not mean that SmartEvent stops to track logs related to it. The
SmartEvent Correlation Unit adds matching logs to the event as long as they continue to arrive during the
event threshold. To keep the event open condenses what can appear as many instances of the same
event to one, and provides accurate, up-to-date information as to the start and end time of the event.
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Creating a User-Defined Event
To create New Event Definitions, right-click an existing Event Definition, or use the Actions menu:

Right
Click

Actions
Menu Description

New New
Custom
Event

Launches the Event Definition Wizard, which allows you to select how to base the
event: on an existing Event Definition, or from scratch.

Save
As

Save
Event
As

Creates an Event Definition based on the properties of the highlighted Event
Definition. When you select Save As, the system prompts you to save the selected
Event Definition with a new name for later editing. Save As can also be accessed
from the Properties window.

All User Defined Events are saved at Policy tab >Event Policy >User Defined Events. When an Event
Definition exists it can be modified through the Properties window, available by right-click and from the
Actions menu.

Creating a New Event Definition

You can edit all events, not only user-defined events. If you change a predefined event,the result is saved
as a new user defined event.

To create a new event definition:

1. From the Actions menu, selectNew Custom Event.

The Event Definition Wizard opens.

2. For Create an event

a. Select that is based on an existing event.

b. Select an event that has equivalent properties to the event you want to create.

c. ClickNext.

3. Name the Event Definition.

4. Enter a Description.

5. Select a Severity level.

6. ClickNext.

7. Set which of these options generates the event:

n A single log - Frequently depicts an event, such as a log from a virus scanner that reports
that a virus has been found.

n Multiple logs - Required if the event can only be identified as a result of a combination of
multiple logs, such as a High Connection Rate.

ClickNext.
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8. Examine the products that can cause this event.

9. SelectNext.

10. Optional: Edit the product filters:

n If you added a product you can edit the filters for each product (Edit all product filters), or
those of new products you added (Edit only newly selected product filters).

n If you did not add other products, edit the filters of existing products (Yes) or skip this step
(No, Leave the original files).

ClickNext.

11. Edit or add product filters for each log necessary in the Event Definition filter

a. Select the Log field from the available Log Field list.

b. Click Add to edit the filter.

c. Make sure that the filter matches on All Conditions or Any Conditions.

d. Double-click the Log field and select the values to use in the filter.

ClickNext.

12. When you defined the filters for each product, select values for these options to define how to
process logs

n Detect the event when at least__ logs occurred over a period of__ seconds contains
the event thresholds that define the event. You can modify the event thresholds by altering
the number of logs and/or the period of time that define the event.

n Each event definition may have multiple Event Candidates existing simultaneously
allows you to set whether SmartEvent creates distinct Event Candidates based on a field
(or set of fields) that you select below.

Select the field(s) by which distinct Event Candidates will be created allows you to set
the field (or set of fields) that are used to differentiate between Event Candidates.

n Use unique values of the__field when counting logs directs SmartEvent to count unique
values of the specified field when determining whether the Event Threshold has been
surpassed. When this property is not selected, SmartEvent counts the total number of logs
received.

13. Click Finish.

Customizing a User-Defined Event

Customizing a user-defined event:

1. From the Policy tab >Event Policy >User Defined Events, right-click a User-Defined Event and
select Properties.

2. In the tabs provided, make the necessary changes

n Name - Name the Event Definition, enter a Description and select a Severity level. The
text you enter in theDescription field shows in the Event Description area (below the event
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configurable properties).

n Filter - To edit a product filter

a. Select the product.

b. Select the Log field from the available Log Fields list.

c. If the necessary field does not show select Show more fields... to add a field to
the Log Fields list.

d. Click Add to edit the filter.

e. Select if the filter matches on All Conditions orAny Conditions.

n Count logs

This screen defines how SmartEvent counts logs related to this event.

l A Single log - Frequently depicts an event, such as a log from a virus scanner
that reports that a virus is found.

l With this option you can set the fields that are used to group events into Event
Candidates. Logs with matching values for these fields are added to the same
event. For example: Multiple logs that report a virus detected on the same source
with the same virus name are combined into the same event.

l Multiple logs - Required for events that identify an activity level, such as a High
Connection Rate.

l When the event is triggered by multiple logs, set the behavior of Event
Candidates:

l Detect the event when at least... - Set the Event Threshold that, when
exceeded, indicates that an event has occurred.

l Select the field(s) by which distinct event candidates will be created - An
event is generated by logs with the same values in the fields specified here. To
define how logs are grouped into Event Candidates, select the related fields here.

l Use unique values of the ... - Only logs with unique values for the fields specified
here are counted in the event candidate. For example: A port scan event counts
logs that include unique ports scanned. Also, the logs do not increment the log
count for logs that contain ports already encountered in the event candidate.

l Advanced - Define the keep=alive time for the event, and how often the
SmartEvent Correlation Unit updates the SmartEvent server with new logs for the
created event.

n Event Format

When an event is generated, information about the event is presented in the Event Detail
pane.

This screen lets you specify if the information will be added to the detailed pane and from
which Log Field the information is taken.

You can clear it in the Display column. The Event Field will not be populated.
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n GUI representation

All events can be configured. This screen lets you select the configuration
parameters that show.

l The Threshold section shows the number of logs that must matched to create
the event. This is usually not shown for one log events and shown for multiple log
events.

l The Exclude section lets you specify the log fields that show when you add an
event exclusion.

l The Exception section lets you specify the log fields that show when you add an
event exception.

3. ClickOK to save your changes.

Eliminating False Positives
This section shows you how to reduce false positives.

Services that Generate Events

Some types of services are characterized by a high quantity of traffic that can be misidentified as events.
These are examples of services and protocols that can potentially generate events:

n Software that does a routine scan of the network to make sure that everything runs correctly.
Configuration of SmartEvent to exclude this source from a scan event eliminates a source of false
positive events.

n High connection rate on a web server. Set SmartEvent to allow a higher connection rate for each
minute on a busy web server, or to exclude this source from a scan event.

Common Events by Service

The information in this table provides a list of server types where high activity is frequently used. To change
the Event Policy, adjust event thresholds and add Exclusions for servers and services . You can decrease
more the quantity of false positives detected.

Common events by service

Server
Type Category Event

Name Source Dest Service Reason

SNMP Scans IP sweep
from
internal
network

Any Any SNMP-read Hosts that
query other
hosts

DNS
Servers

Scans IP sweep
from
internal
network

DNS
servers

- DNS Inter-DNS
servers
updates
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Server
Type Category Event

Name Source Dest Service Reason

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any DNS
servers

DNS DNS
requests
and inter-
DNS servers
updates

Anomalies High
connection
rate from
internal
network

Any Any DNS DNS
requests
and inter-
DNS servers
updates

Anomalies High
connection
rate from
internal
network on
service

Any Any DNS DNS
requests
and inter-
DNS servers
updates

Anomalies Abnormal
activity on
service

Any Any DNS DNS
requests
and inter-
DNS servers
updates

NIS
Servers

Scans Port scan
from
internal
network

NIS
servers

Any - Multiple NIS
queries

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any NIS
servers

NIS NIS queries

Anomalies High
connection
rate from
internal
network

Any Any NIS NIS queries

Anomalies High
connection
rate from
internal
network on
service

Any Any NIS NIS queries



Event Analysis

Logging andMonitoring R80.40 Administration Guide      |      100

Server
Type Category Event

Name Source Dest Service Reason

Anomalies Abnormal
activity on
service

Any Any NIS NIS queries

LDAP
Servers

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any LDAP
servers

LDAP LDAP
requests

Anomalies High
connection
rate from
internal
network

Any LDAP
servers

LDAP LDAP
requests

Anomalies High
connection
rate from
internal
network on
service

Any LDAP
servers

LDAP LDAP
requests

Anomalies Abnormal
activity on
service

Any LDAP
servers

LDAP LDAP
requests

HTTP
Proxy
Servers -
Hosts To
Proxy
Server

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any Proxy
servers

HTTP:8080 Hosts
connections
to Proxy
servers

Anomalies High
connection
rate from
internal
network

Any Proxy
servers

HTTP:8080 Hosts
connections
to Proxy
servers

Anomalies High
connection
rate from
internal
hosts on
service

Any Proxy
servers

HTTP:8080 Hosts
connections
to Proxy
servers
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Server
Type Category Event

Name Source Dest Service Reason

Anomalies Abnormal
activity on
service

Any Proxy
servers

HTTP:8080 Hosts
connections
to Proxy
servers

HTTP
Proxy
Servers -
Out to the
Web

Scans IP sweep
from
internal
network

Proxy
servers

Any HTTP/ HTTPS Proxy
servers
connections
out to
various sites

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Proxy
servers

Any HTTP/ HTTPS Proxy
servers
connections
out to
various sites

Anomalies High
connection
rate from
internal
network

Proxy
servers

Any HTTP/ HTTPS Proxy
servers
connections
out to
various sites

High
connection
rate from
internal
hosts on
service

Proxy
servers

Any HTTP/ HTTPS Proxy
servers
connections
out to
various sites

Anomalies Abnormal
activity on
service

Proxy
servers

Any HTTP/ HTTPS Proxy
servers
connections
out to
various sites

UFP
Servers

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any UFP
servers

Any/UFP by vendor Firewall
connections
to UFP
servers

Anomalies High
connection
rate from
internal
network

Any UFP
servers

Any/UFP by vendor Firewall
connections
to UFP
servers
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Server
Type Category Event

Name Source Dest Service Reason

Anomalies High
connection
rate from
internal
hosts on
service

Any UFP
servers

Any/UFP by vendor Firewall
connections
to UFP
servers

Anomalies Abnormal
activity on
service

Any UFP
servers

Any/UFP by vendor Firewall
connections
to UFP
servers

CVP
Servers
Request

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any CVP
servers

Any/CVP by vendor Firewall
connections
to CVP
servers

Anomalies High
connection
rate from
internal
network

Any CVP
servers

Any/CVP by vendor Firewall
connections
to CVP
servers

Anomalies High
connection
rate from
internal
hosts on
service

Any CVP
servers

Any/CVP by vendor Firewall
connections
to CVP
servers

Anomalies Abnormal
activity on
service

Any CVP
servers

Any/CVP by vendor Firewall
connections
to CVP
servers

CVP
Servers
Replies

Scans Port scans
from
internal
network

CVP
servers

Any - Multiple CVP
replies to
same GW

Scans IP sweep
from
internal
network

CVP
servers

- CVP CVP replies
to multiple
GWs
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Server
Type Category Event

Name Source Dest Service Reason

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

CVP
servers

Any Any/CVP by vendor CVP replies

Anomalies High
connection
rate from
internal
network

CVP
servers

Any Any/CVP by vendor CVP replies

Anomalies High
connection
rate from
internal
hosts on
service

CVP
servers

Any Any/CVP by vendor CVP replies

Anomalies Abnormal
activity on
service

CVP
servers

Any Any/CVP by vendor CVP replies

UA
Server
Request

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

Any UA
servers

uas-port (TCP:19191
TCP:19194)

Connections
to UA
servers

Anomalies High
connection
rate from
internal
network

Any UA
servers

(TCP:19191
TCP:19194)

Connections
to UA
servers

Anomalies High
connection
rate from
internal
hosts on
service

Any UA
servers

uas-port (TCP:19191
TCP:19194)

Connections
to UA
servers

Anomalies Abnormal
activity on
service

Any UA
servers

uas-port (TCP:19191
TCP:19194)

Connections
to UA
servers
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Server
Type Category Event

Name Source Dest Service Reason

UA
Servers
Replies

Scans Port scans
from
internal
network

UA
servers

Any - Multiple UA
replies to the
same
computer

Scans IP sweep
from
internal
network

UA
servers

Any uas-port (TCP:19191
TCP:19194)

Multiple UA
replies to
multiple
computers

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

UA
servers

Any uas-port (TCP:19191
TCP:19194)

UA replies

Anomalies High
connection
rate from
internal
network

UA
servers

Any uas-port (TCP:19191
TCP:19194)

UA replies

Anomalies High
connection
rate from
internal
hosts on
service

UA
servers

Any uas-port (TCP:19191
TCP:19194)

UA replies

Anomalies Abnormal
activity on
service

UA
servers

Any uas-port
(TCP:19191TCP:19194)

UA replies

SMTP
Servers

Scans IP sweep
from
internal
network

SMTP
servers

- SMTP SMTP
servers
connections
out to
various
SMTP
servers

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

SMTP
servers

Any SMTP SMTP
servers
connections
out to
various
SMTP
servers
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Server
Type Category Event

Name Source Dest Service Reason

Anomalies High
connection
rate from
internal
network

SMTP
servers

Any SMTP SMTP
servers
connections
out to
various
SMTP
servers

Anomalies High
connection
rate from
internal
hosts on
service

SMTP
servers

Any SMTP SMTP
servers
connections
out to
various
SMTP
servers

Anomalies Abnormal
activity on
service

SMTP
servers

Any SMTP SMTP
servers
connections
out to
various
SMTP
servers

Anti-Virus
Definition
Servers

Scans IP sweep
from
internal
network

AV_
Defs
servers

- Any/AV by vendor Anti-Virus
definitions
updates
deployment

Denial of
Service
(DoS)

High
connection
rate on
internal
host on
service

AV_
Defs
servers

- Any/AV by vendor Anti-Virus
definitions
updates
deployment

Anomalies High
connection
rate from
internal
network

AV_
Defs
servers

- Any/AV by vendor Anti-Virus
definitions
updates
deployment

Anomalies High
connection
rate from
internal
hosts on
service

AV_
Defs
servers

- Any/AV by vendor Anti-Virus
definitions
updates
deployment
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Server
Type Category Event

Name Source Dest Service Reason

Anomalies Abnormal
activity on
service

AV_
Defs
servers

- Any/AV by vendor Anti-Virus
definitions
updates
deployment

System Administration
To maintain your SmartEvent system, you can do these tasks from theGeneral Settings section of the
Policy tab:

n Adding a SmartEvent Correlation Unit and Log Servers

n Create offline jobs analyze historical log files (see "Importing Offline Log Files" on page 40).

n Adding objects to the Internal Network

n Creating scripts to run as Automatic Reactions for certain events (see "Creating an External Script
Automatic Reaction" on page 87)

n Creating objects for use in filters

Adding Network and Host Objects

Network Objects are the objects that are synchronized from the Management object database as well as
user defined additional objects. These objects from the Management server are added to SmartEvent
during the initial sync and updated at set intervals.

As a best practice, use SmartConsole to add new network or host objects to the Management server.

The customer cannot define the internal network until the initial sync is complete.

To add a host or network object to SmartEvent:

1. From the Policy tab, selectGeneral Settings >Objects >Network Objects >Add >Host or Add
Network.

2. Give the device a significant name.

3. For a host, enter the IP Address or selectGet Address.

4. For a network object, enter the Network Address and Net Mask.

5. SelectOK.

Defining the Internal Network

To help SmartEvent conclude if events originated internally or externally, you must define the Internal
Network. These are the options to calculate the traffic direction:

n Incoming - All the sources are external to the network and all destinations are internal.

n Outgoing - All sources are in the network and all destinations are external.

n Internal - Sources and destinations are all in the network.

n Other - Amixture of internal and external values makes the result indeterminate.
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To define the Internal Network:

1. From the Policy tab, selectGeneral Settings > Initial Settings > Internal Network.

2. Add internal objects.

We recommend you add all internalNetwork objects, and notHost objects.

Some network objects are copied from the Management server to the SmartEvent Server during the the
initial sync and updated afterwards.

Note - The customer cannot define the internal network until the initial sync is complete.
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Monitoring Traffic and Connections
SmartViewMonitor gives you a complete picture of network and security performance. Use it to respond
quickly and efficiently to changes in gateways, tunnels, remote users and traffic flow patterns or security
activities.

SmartViewMonitor is a high-performance network and security analysis system. This system helps you to
establish work habits based on learned system resource patterns. Based on Check Point Security
Management Architecture, SmartViewMonitor provides a single, central interface, to monitor network
activity and performance of Check Point Software Blades.

How SmartView Monitor Works
Data for the status of all gateways in the system is collected by the Security Management Server and
viewed in SmartViewMonitor. The data shows status for:

n Check Point Security Gateways

n OPSEC gateways

n Check Point Software Blades

Gateway Status is the SmartViewMonitor view which shows all component status information. AGateway
Status view shows a snapshot of all Software Blades, such as VPN and ClusterXL, and third party products
(for example, OPSEC-partner gateways).

Gateway Status is similar in operation to the SNMP daemon that provides a mechanism to get data about
gateways in the system.

SIC is initialized between Security Gateways (3) (local and remote), and the Security Management Server
(2). The Security Management Server then gets status data from the Software Blades with the AMON
(Application Monitoring)protocol. SmartViewMonitor (1) gets the data from the Security Management
Server.
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AMON Protocol Support
The Security Management Server acts as an AMON client. It collects data about installed Software Blades.
Each Security Gateway, or any other OPSEC gateway which runs an AMON server, acts as the AMON
server itself. The gateway requests status updates from other components, such as the Firewall kernel
and network servers. Requests are fetched at a defined interval.

An alternate source for status collection can be any AMON client, such as an OPSEC partner, which uses
the AMON protocol.

The AMON protocol is SIC- based. It can collect data only after SIC is initialized.

Defining Status Fetch Frequency
The Security Management Server collects status data from the Security Gateways on a defined interval.
The default is 60 seconds.

To set the Status Fetching Interval:

1. Open SmartConsole.

2. OpenGlobal Properties > Log and Alert > Time Settings.

3. Enter the number of seconds in Status fetching interval.

To Start Monitoring

To open the monitoring views in SmartConsole:

1. From theGateways & Servers view, select a Gateway.

2. ClickMonitor.

The Device and License informationwindow opens and shows:

n Device Status

n License Status

n System Counters

n Traffic

To open SmartViewMonitor:

1. Open SmartConsole > Logs & Monitor.

2. Open the catalog (new tab).

3. Click Tunnel & User Monitoring.

SmartView Monitor Features
SmartViewMonitor allows administrators to easily configure and monitor different aspects of network
activities. You can see graphical from an integrated, intuitive interface.
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Defined views include the most frequently used traffic, counter, tunnel, gateway, and remote user
information. For example, Check Point System Counters collect information on the status and activities of
Check Point products (for example, VPN or NAT). With custom or defined views, administrators can drill-
down the status of a specified gateway and/or a segment of traffic. That way, administrators identify top
bandwidth hosts that can influence network performance. If suspicious activity is detected, administrators
can immediately apply a Firewall rule to the applicable Security Gateway to block that activity. These
Firewall rules can be created dynamically through the graphical interface and be set to expire in a specified
time period.

You can generate Real-time and historical graphical reports of monitored events. This provides a
comprehensive view of gateways, tunnels, remote users, network, security, and performance over time.

The monitoring views show real-time and historical graphical views of:

n Gateway status

n Remote users (SmartViewMonitor only)

n System Counters

n VPN tunnel monitoring (SmartViewMonitor only)

n Cooperative Enforcement, for Endpoint Security Servers

n Traffic

In SmartViewMonitor, you can create customized monitoring view.

SmartView Monitor Use Cases
Use SmartViewMonitor to:

n Create a Traffic view and report to identify the reasons for slow internet access. The view can be
based on an inspection of: Specific Services, Firewall rules or Network Objects, that can be known to
impede the flow of internet traffic. If the SmartViewMonitor Traffic view indicates that users
aggressively use such Services or Network Objects (for example, Peer to Peer application or HTTP),
the cause of the slow internet access is determined. If aggressive use is not the cause, the network
administrator have to look at other avenues. For instance, performance degradation can be the
result of memory overload.

n Create a report to determine why employees who work away from the office cannot connect to the
network. The view can be based on CPUUse %, to collect information about the status, activities
hardware and software use of Check Point products in real-time. The SmartViewMonitor Counter
view can indicate that there are more failures than successes. Perhaps the company cannot
accommodate the number of employees that try to log on at the same time?

Immediate Actions
If the status shows an issue, you can act on that network object.

For example:

n Disconnect client - Disconnect one or more of the connected SmartConsole clients.

n Start/Stop cluster member - You can see all Cluster Members of a Gateway Cluster in SmartView
Monitor. You can start or stop a selected Cluster Member.

n Suspicious Action Rules - You can block suspicious network activity while you investigate the real
risk or to quickly block an obvious intruder.
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Monitoring and Handling Alerts
Alerts provide real-time information about possible security threats, and how to avoid, minimize, or recover
from the damage. The administrator can define alerts to be sent for different gateways and for certain
policies or properties.

The gateways send alerts to the Security Management Server. The Security Management Server forwards
these alerts to SmartViewMonitor. By default, an alert is sent as a pop-up message to the administrator
desktop when a new alert arrives to SmartViewMonitor.

You can set global alert parameters for all gateways in the system, or specify an action to send an alert for
a particular gateway.

Alerts are sent when:

n Rules or attributes which are set to be tracked as alerts are matched by a passing connection.

n System events (also called System Alerts) are configured to cause an alert when different
predefined thresholds are surpassed.

System Alerts are sent for predefined system events or for important situation updates. For example, if
free disk space is less than 10%, or if a security policy is changed. System Alerts can also be defined for
each product. For example, you can define other System Alerts for Check Point QoS.

Viewing Alerts
Alert commands are set in SmartConsole >Global Properties > Log and Alert >Alerts page. The Alerts
in this window apply only to Security Gateways.

To see alerts:

1. Open SmartConsole > Logs & Monitor view >External Apps.

2. Click Tunnel & User Monitoring.

SmartViewMonitor opens.

3. Click the Alerts icon in the toolbar.

The Alerts window opens. Use this window to monitor or delete alerts.

System Alert Monitoring Mechanism
The Check Point Security Management Server System Alert monitoring mechanism uses the defined
System Alert thresholds. If a threshold is reached, it activates the defined action.

To activate System Alert monitoring:

Go to Tools >Start System Alert Daemon.

To stop the System Alert monitoring:

Go to Tools >Stop System Alert Daemon.
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Monitoring Suspicious Activity Rules
Suspicious Activity Monitoring (SAM) is a utility integrated in SmartViewMonitor. It blocks activities that you
see in the SmartViewMonitor results and that appear to be suspicious. For example, you can block a user
who tries several times to gain unauthorized access to a network or internet resource.

A Security Gateway with SAM enabled has Firewall rules to block suspicious connections that are not
restricted by the security policy. These rules are applied immediately (Install Policy not required).

The Need for Suspicious Activity Rules
Connections between enterprise and public networks are a security challenge as they leave the network
and its applications open to attack. You must be able to inspect and identify all inbound and outbound
network activity and decide if it is suspicious.

Creating a Suspicious Activity Rule
SAM rules use CPU resources. Therefore, set an expiration time so you can inspect traffic but not
negatively affect performance.

If you confirm that an activity is risky, edit the Security Policy, educate users, or handle the risk.

You can block suspicious activity based on source, destination, or service.

To block an activity:

1. In the SmartViewMonitor, click the Suspicious Activity Rules icon in the toolbar.

The Enforced Suspicious Activity Rules window opens.

2. ClickAdd.

The Block Suspicious Activity window opens.

3. In Source and in Destination, select IP or Network:

n To block all sources or destinations that match the other parameters, enter Any.

n To block one suspicious source or destination, enter an IPAddress and Network Mask.

4. In Service:

n To block all connections that fit the other parameters, enter Any.

n To block one suspicious service or protocol, click the button and select a service from the
window that opens.

5. In Expiration, set a time limit.

6. Click Enforce.

To create an activity rule based on TCP or UDP use:

1. In the Block Suspicious Activity window , click Service.

The Select Servicewindow opens.

2. ClickCustom Service.
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3. Select TCP or UDP.

4. Enter the port number.

5. ClickOK.

To define SmartViewMonitor actions on rule match:

1. In the Block Suspicious Activity window, click Advanced.

The Advancedwindow opens.

2. In Action, select the Firewall action for SmartViewMonitor to do on rule match:

n Notify - Send a message about the activity, but do not block it.

n Drop - Drop packets, but do not send a response. The connection will time out.

n Reject - Send an RST packet to the source and close the connection.

3. In Track, selectNo Log, Log or Alert.

4. If the action isDrop: To close the connection immediately on rule match, selectClose connections.

5. ClickOK.

Creating a Suspicious Activity Rule from Results
If you monitor traffic, and see a suspicious result, you can create an SAM rule immediately from the results.

Note - You can only create a Suspicious Activity rule for Traffic views with data about the Source or
Destination (Top Sources, Top P2PUsers, and so on).

To create an SAM rule:

1. In SmartViewMonitor open a Traffic view.

The Select Gateway / Interfacewindow opens.

2. Select an object.

3. ClickOK.

4. In the Results, right-click the bar in the chart (or the row in the report), that represents the source,
destination, or other traffic property to block.

5. Select Block Source.

The Block Suspicious Activity window opens.

6. Create the rule.

7. Click Enforce.

For example:

Your corporate policy does not allow to share peer2peer file, and you see it in the Traffic > Top P2P Users
results.
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1. Right-click the result bar and select Block Source.

The SAM rule is set up automatically with the user IP address and the P2P_File_Sharing_
Applications service.

2. Click Enforce.

3. For the next hour, while this traffic is dropped and logged, contact the user.

Managing Suspicious Activity Rules
The Enforced Suspicious Activity Rules window shows the currently enforced rules. If you add a rule
that conflicts with another rule, the conflicting rule remains hidden. For example, if you define a rule to drop
http traffic, and a rule exists to reject http traffic, only the drop rule shows.

sam_alert

Description

For SAM v1, this utility executes Suspicious Activity Monitoring (SAM) actions according to the information
received from the standard input.

For SAM v2, this utility executes Suspicious Activity Monitoring (SAM) actions with User Defined Alerts
mechanism.

Notes:

n VSXGateway does not support Suspicious Activity Monitoring (SAM) Rules. See sk79700.

n You must run this command in Expert mode on the Management server.

n See fw sam and fw sam_policy.

Syntax for SAM v1

[Expert@MGMT:0]# sam_alert [-v] [-o] [-s <SAM Server>] [-t <Time>] [-f
<Security Gateway>] [-C] {-n|-i|-I} {-src|-dst|-any|-srv}

Parameters for SAM v1

Parameter Description

-v Enables the verbose mode for the fw sam command.

-o Specifies to print the input of this tool to the standard output (to use with pipes in a CLI
syntax).

-s <SAM
Server>

Specifies the SAM Server to be contacted. Default is localhost.

-t <Time> Specifies the time (in seconds), during which to enforce the action. The default is
forever.

http://supportcontent.checkpoint.com/solutions?id=sk79700
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Parameter Description

-f <Security
Gateway>

Specifies the Security Gateway, on which to run the operation.

Important - If you do not specify the target Security Gateway explicitly, this command
applies to all managed Security Gateways.

-C Cancels the specified operation.

-n Specifies to notify every time a connection, which matches the specified criteria,
passes through the Security Gateway.

-i Inhibits (drops or rejects) connections that match the specified criteria.

-I Inhibits (drops or rejects) connections that match the specified criteria and closes all
existing connections that match the specified criteria.

-src Matches the source address of connections.

-dst Matches the destination address of connections.

-any Matches either the source or destination address of connections.

-srv Matches specific source, destination, protocol and port.

Syntax for SAM v2

[Expert@MGMT:0]# sam_alert -v2 [-v] [-O] [-S <SAM Server>] [-t <Time>]
[-f <Security Gateway>] [-n <Name>] [-c "<Comment">] [-o <Originator>]
[-l {r | a}] -a {d | r| n | b | q | i} [-C] {-ip |-eth} {-src|-dst|-
any|-srv}

Parameters for SAM v2

Parameter Description

-v2 Specifies to use SAM v2.

-v Enables the verbose mode for the fw sam command.

-O Specifies to print the input of this tool to the standard output (to use with pipes
in a CLI syntax).

-S <SAMServer> the SAM server to be contacted. Default is localhost

-t <Time> Specifies the time (in seconds), during which to enforce the action. The default
is forever.

-f <Security
Gateway>

Specifies the Security Gateway, on which to run the operation.

Important - If you do not specify the target Security Gateway explicitly, this
command applies to all managed Security Gateways.
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Parameter Description

-n <Name> Specifies the name for the SAM rule.

Default is empty.

-c "<Comment>" Specifies the comment for the SAM rule.

Default is empty.

You must enclose the text in the double quotes or single quotes.

-o <Originator> Specifies the originator for the SAM rule.

Default is sam_alert.

-l {r | a} Specifies the log type for connections that match the specified criteria:

n r - Regular

n a - Alert

Default is None.

-a {d | r| n |
b | q | i}

Specifies the action to apply on connections that match the specified criteria:

n d - Drop

n r - Reject

n n - Notify

n b - Bypass

n q - Quarantine

n i - Inspect

-C Specifies to close all existing connections that match the criteria.

-ip Specifies to use IP addresses as criteria parameters.

-eth Specifies to use MAC addresses as criteria parameters.

-src Matches the source address of connections.

-dst Matches the destination address of connections.

-any Matches either the source or destination address of connections.

-srv Matches specific source, destination, protocol and port.

Example

See sk110873: How to configure Security Gateway to detect and prevent port scan.

http://supportcontent.checkpoint.com/solutions?id=sk110873
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Configuring Alerts and Thresholds in SmartView
Monitor
This section describes how to configure alerts and thresholds in SmartViewMonitor.

System Alerts and Thresholds
You can set thresholds for selected gateways. When a threshold is passed, a system alert is sent.

To set System Alert thresholds:

1. OpenGateways Status view.

2. Right-click a network object and selectConfigure Thresholds.

The Threshold Settings window opens.

3. Set the thresholds for the selected object:

n Use global settings - All objects get the same thresholds for system alerts.

n None - The selected gateway object does not have thresholds for system alerts.

n Custom - Change the thresholds for the selected object to be different than the global
settings.

To change Global Threshold settings:

1. In the Threshold Settings window, click Edit Global Settings.

TheGlobal Threshold Settings window opens.
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2. Select thresholds.

3. In Action, select:

n none - No alert.

n log - Sends a log entry to the database.

n alert - Opens a pop-up window to your desktop.

n mail - Sends a mail alert to your Inbox.

n snmptrap - Sends an SNMP alert.

n useralert - Runs a script. Make sure a user-defined action is available. Go to SmartConsole
>Global Properties >Log and Alert >Alert Commands.

To change custom threshold settings:

1. In the Threshold Settings window, selectCustom.

The global threshold settings show.

2. Select thresholds to enable for this gateway or cluster member.

3. Set defining values.

Working with SNMP Monitoring Thresholds
You can configure a variety of different SNMP thresholds that generate SNMP traps, or alerts. You can use
these thresholds to monitor many system components automatically without requesting information from
each object or device. The categories of thresholds that you can configure include:
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n Hardware

n High Availability

n Networking

n Resources

n Log Server Connectivity

Some categories apply only to some machines or deployments.

In each category there are many individual thresholds that you can set. For example, the hardware
category includes alerts for the state of the RAID disk, the state of the temperature sensor, the state of the
fan speed sensor, and others. For each individual threshold, you can configure:

n If it is enabled or disabled

n How frequently alerts are sent

n The severity of the alert

n The threshold point (if necessary)

n Where the alerts are sent to

You can also configure some settings globally, such as how often alerts are send and where they are sent
to.

Types of Alerts

n Active alerts are sent when a threshold point is passed or the status of a monitored component is
problematic.

n Clear alerts are sent when the problem is resolved and the component has returned to its normal
value. Clear alerts look like active alerts but the severity is set to 0.

Configuring SNMP Monitoring

Configure the SNMPmonitoring thresholds in the command line of the Security Management Server.
When you install the policy on the gateways the SNMPmonitoring thresholds are applied globally to all
gateways.

Configuring in Multi-Domain Security Management

In a Multi-Domain Security Management environment, you can configure thresholds on the Multi-Domain
Server and on each individual Domain Management Server. Thresholds that you configure on the Multi-
Domain Server are for the Multi-Domain Server only. Thresholds that you configure for a Domain
Management Server are for that Domain Management Server and its gateways. If a threshold applies to
the Multi-Domain Server and the Domain Management Server gateways, set it on the Multi-Domain Server
and Domain Management Server. But in this situation you can only get alerts from the Multi-Domain Server
if the threshold passed.

For example, because the Multi-Domain Server and Domain Management Server are on the same
machine, if the CPU threshold is passed, it applies to both of them. But only the Multi-Domain Server
generates alerts.

You can see theMulti-Domain Security Management level for each threshold with the threshold_
config utility.
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n If the Multi-Domain Security Management level for a threshold isMulti-Domain Server: Alerts are
generated for the Multi-Domain Server when the threshold point is passed.

n If the Multi-Domain Security Management level for a threshold isMulti-Domain Server and Domain
Management Server: Alerts are generated for the Multi-Domain Server and Domain Management
Servers separately when the threshold point is passed.

Configuring a Local Gateway Policy

You can configure SNMP thresholds locally on a gateway with the same procedure that you do on a
Security Management Server. But each time you install a policy on the gateway, the local settings are
erased and it reverts to the global SNMP threshold settings.

You can use the threshold_config utility to save the configuration file and load it again later.

On Gaia, the configuration file that you can back up is: $FWDIR/conf/thresholds.conf

Configuration Procedures

There is one primary command to configure the thresholds in the command line, threshold_config.
You must be in the Expert mode to run it. After you run threshold_config,follow the on-screen
instructions to make selections and configure the global settings and each threshold.

When you run threshold_config, you get these options:

n Show policy name - Shows you the name configured for the threshold policy.

n Set policy name - Lets you set a name for the threshold policy.

n Save policy - Lets you save the policy.

n Save policy to file - Lets you export the policy to a file.

n Load policy from file - Lets you import a threshold policy from a file.

n Configure global alert settings - Lets you configure global settings for how frequently alerts are
sent and howmany alerts are sent.

n Configure alert destinations - Lets you configure a location or locations where the SNMP alerts are
sent.

n View thresholds overview - Shows a list of all thresholds that you can set including: the category of
the threshold, if it is active or disabled, the threshold point (if relevant), and a short description of
what it monitors.

n Configure thresholds - Opens the list of threshold categories to let you select thresholds to
configure.

Configure Global Alert Settings

If you selectConfigure global alert settings, you can configure global settings for how frequently alerts
are sent and howmany alerts are sent. You can configure these settings for each threshold. If a threshold
does not have its own alert settings, it uses the global settings by default.

You can configure these options:

n Enter Alert Repetitions - Howmany alerts are sent when an active alert is triggered. If you enter 0,
alerts are sent until the problem is fixed.

n Enter Alert Repetitions Delay - How long the system waits between it sends active alerts.
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n Enter Clear Alert Repetitions - Howmany clear alerts are sent after a threshold returns to a regular
value.

n Enter Clear Alert Repetitions Delay - How long the system waits between it sends clear alerts.

Configure Alert Destinations

If you select Configure Alert Destinations, you can add and remove destinations for where the alerts are
sent. You can see a list of the configured destinations. A destination is usually an NMS (Network
Management System) or a Check Point Log Server.

After you enter the details for a destination, the CLI asks if the destination applies to all thresholds.

n If you enter yes, alerts for all thresholds are sent to that destination, unless you remove the
destination from an individual threshold.

n If you enter no, no alerts are sent to that destination by default. But for each individual threshold, you
can configure the destinations and you can add destinations that were not applied to all thresholds.

For each threshold, you can choose to which of the alert destinations its alerts are sent. If you do not define
alert destination settings for a threshold, it sends alerts to all of the destinations that you applied to all
thresholds.

For each alert destination enter:

n Name - An identifying name.

n IP - The IP address of the destination.

n Port - Through which port it is accessed

n Ver - The version on SNMP that it uses

n Other data - Some versions of SNMP require more data. Enter the data that is supplied for that
SNMP version.

Configure Thresholds

If you select Configure thresholds, you see a list of the categories of thresholds, including:

n Hardware

n High Availability

n Networking

n Resources

n Log Server Connectivity

Some categories apply only to some machines or deployments. For example, Hardware applies only to
Check Point appliances and High Availability applies only to clusters or High Availability deployments.

Select a category to see the thresholds in it. Each threshold can have these options:

n Enable/Disable Threshold - If the threshold is enabled, the system sends alerts when there is a
problem. If it is disabled it does not generate alerts.

n Set Severity - You can give each threshold a severity setting. The options are: Low, Medium, High,
and Critical. The severity level shows in the alerts and in SmartViewMonitor. It lets you know quickly
how important the alert is.

n Set Repetitions - Set how frequently and howmany alerts will be sent when the threshold is passed.
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If you do not configure this, it uses the global alert settings.

n Set Threshold Point - Enter the value that will cause active alerts when it is passed. Enter the
number only, without a unit of measurement.

n Configure Alert Destinations - See all of the configured alert destinations. By default, active
alerts and clear alerts are sent to the destinations. You can change this for each destination.
When you select the destination you see these options

l Remove from destinations - If you select this, alerts for this threshold are not sent to the
selected destination.

l Add a destination - If you configured a destination in the global alert destinations but did
not apply it to all thresholds, you can add it to the threshold.

l Disable clear alerts - Cleared alerts for this threshold are not sent to the selected
destination. Active alerts are sent.

Completing the Configuration

1. On the Security Management Server, install the policy on all Security Gateways.

2. For a local Security Gateway threshold policy or a Multi-Domain Security ManagementMulti-
Domain Server environment, use the cpwd_admin utility to restart the CPD process

a. Run: cpwd_admin stop -name CPD -path "$CPDIR/bin/cpd_admin" -
command "cpd_admin stop"

b. Run: cpwd_admin start -name CPD -path "$CPDIR/bin/cpd" -command
"cpd"

Monitoring SNMP Thresholds

You can see an overview of the SNMP thresholds that you configure in SmartViewMonitor.

To see an overview of the SNMP thresholds:

1. Open SmartViewMonitor and select a Security Gateway.

2. In the summary of the Security Gateway data that open in the bottom pane, click System
Information.

3. In the new pane that opens, click Thresholds.

In the pane that opens, you can see these details:

n General Info - A summary of the total SNMP Threshold policy.

l Policy name - The name that you set for the policy in the CLI.

l State - If the policy is enabled or disabled.

l Thresholds - Howmany thresholds are enabled.

l Active events - Howmany thresholds are currently sending alerts.
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l Generated Events - Howmany not active thresholds became active since the
policy was installed.

n Active Events - Details for the thresholds that are currently sending alerts.

l Name - The name of the alert (given in the CLI).

l Category - The category of the alert (given in the CLI), for example, Hardware or
Resources.

l MIB object - The name of the object as recorded in the MIB file.

l MIB object value - The value of the object when the threshold became active, as
recorded in the MIB file.

l State - The status of the object: active or clearing (passed the threshold but returns
to usual value).

l Severity - The severity of that threshold, as you configured for it in the CLI.

l Activation time - When was the alert first sent.

n Alert Destinations - A list of the destinations that alerts are sent to.

l Name - The name of the location.

l Type - The type of location. For example, a Log Server or NMS.

l State - If logs are sent from the gateway or Security Management Server to the
destination machine.

l Alert Count - Howmany alerts were sent to the destination from when the policy
started.

n Errors - Shows thresholds that cannot be monitored. For example, the Security Gateway
cannot monitor RAID sensors on a machine that does not have RAID sensors. Therefore
it shows an error for the RAID Sensor Threshold.

l Threshold Name - The name of the threshold with an error.

l Error - A description of the error.

l Time of Error - When the error first occurred.

Customizing Results
You can create Custom Views, to change the fields that show in the results.

Editing a Custom View

The changes you make to a view are not automatically saved. You can use this procedure to save a
predefined view as a new Custom view.

To save a new view with changes:

1. Right-click the results of the view and select Properties.

Note - For some of the views, this option is View Properties orQuery Properties.
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2. Add or remove fields and other options for the view.

3. ClickOK.

4. For some of the views, select the gateway.

5. In the Results toolbar, click the Save View to Tree button.

6. In the window that opens, enter a name for the new view.

7. Click Save.

Creating a Custom Gateway Status View

To create a custom Gateway status view:

1. In the Tree, right-clickCustom and selectNew Gateways View.

TheGateway Properties window opens.

2. In Select available fields from, select the source of the data.

3. In Available fields, double-click the data to add to SmartViewMonitor.

4. Open the Filter Gateways tab to remove gateways from the results of this view.

5. ClickOK.

6. Right-click the newCustom view and selectRename.

7. Enter a name for the view.

Creating a Custom Traffic View

To creating a custom traffic view:

1. In the Tree, right-clickCustom and selectNew Traffic View.

TheQuery Properties window opens.

2. SelectHistory or Real Time.

3. If you select Real Time, select what you want to see

n Interfaces

n Services

n IPs / Network Objects

n QoS Rules

n Security Rules

n Connections

n Tunnels

n Virtual Links

n Packet Size Distribution
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4. Select the Target gateway.

n If you often need results for on gateway, select it in Specific Gateway.

n If you have a small number of gateways, you can create a custom view for each one.

n If not, select Prompt for Gateway before run.

5. Open the next tabs.

The tabs that show depend on theQuery Type you selected.

n If you selectHistory, the next tab is Traffic History, where you select the Time Frame and
type of report.

n If you selectReal Time, the next tabs let you set services or objects to monitor, gateways or
specified IP addresses to monitor, update interval, result type, and chart settings.

6. Click Save.

7. Right-click the newCustom view and selectRename.

8. Enter a name for the view.

Creating a Custom Counters View

To create a custom counters view:

1. In the Tree, right-clickCustom and selectNew Counters View.

TheQuery Properties window opens.

2. SelectHistory or Real Time.

3. Select the Target gateway.

n If results for one gateway are frequently necessary, select it in Specific Gateway.

n If you have a small number of gateways, you can create a custom view for each one.

n If not, select Prompt for Gateway before run.

4. Open the Counters tab.

5. Select a category and the counters to add.

You can add counters from different categories to one view.

6. In the Query Type:

n If the Query Type isHistory: Select the Time Frame and click Save.

n If the Query Type is Real Time:

a. Open the Settings tab.

b. Set the update interval and chart type.

c. Click Save.

7. Right-click the newCustom view and selectRename.

8. Enter a name for the view.
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Creating a Custom Tunnel View

To create a custom tunnel view:

1. In the SmartViewMonitor client, select File >New >Tunnels View.

TheQuery Properties window shows.

2. Select Prompt on to generate a report about a specified Tunnel, Community or Gateway.

Prompt on: When you run the view, you will be asked for the specified Tunnel, Community or
Gateway on which to base your view.

Important - Do not select Prompt on if your view is not about one of these three.

3. Select Show one record per tunnel or Show two records per tunnel.

Show two records per tunnel shows a more accurate status because the report provides the status
for the tunnels in both directions.

4. In the Show column, select the filter to be related to this view

5. In the Filter column, click the corresponding Any(*) link.

6. Select the related objects to edit the selected filters.

7. Click the Advanced button.

8. Set a limit in the Records limitationwindow for the number of lines that show in the report.

9. Enter a record limitation.

10. ClickOK.

ATunnels view shows in the Custom branch of the Tree View.

11. Enter the name of the new Tunnel view.

12. Click Enter.

Creating a Custom Users View

To create a custom users view:

1. In SmartViewMonitor, select File >New >Users View.

TheQuery Properties window shows.

2. Select Prompt on to generate a user report about a specified user or Gateway.

Prompt on: When you decide to run the view, you will be asked for the specified User DN or
Gateway on which to base your view.

Important - Do not select Prompt on if your view is not about one of these two.

3. In the Show column, select the filter to be related with this view.

4. In the Filter column, click the corresponding Any(*) link.

5. Select the related objects to edit the selected filters.

6. Click the Advanced button to set a limit (in the Records limitationwindow) to the number of lines
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that show in the report.

7. Enter a record limitation.

8. ClickOK.

AUsers view shows in the Custom branch of the Tree View.

9. Enter a name for the newUsers view.

10. Click Enter.

Custom View Example

For example purposes, we create a real-time Traffic view for Services.

To create a real-time traffic view:

1. Double-click the view to change and select the gateway for which you create the view.

2. Select the View Properties button on the view toolbar.

TheQuery Properties window shows.

3. SelectReal-Time.

Real-Time provides information about currently monitored traffic or system counters.

4. SelectHistory for information that was logged before.

5. Select the topic about which you want to create a Real-Time traffic view in the drop-down list
provided. For example, for purposes select Services.

Note - The remaining tabs in theQuery Properties window change according to the type of view
you create and the selection you made in the Real-Time drop-down list.

6. Select the Target of thisCustom Traffic view.

Target is the gateway for which you monitor traffic.

7. Click theMonitor by Services tab.

8. Select Specific Services and the Services for which you want to create a custom Traffic view.

9. Click the Filter tab.

10. Make the necessary selections.

11. Click the Settings tab.

12. Make the necessary selections.

13. ClickOK when you are done with your selections.

The Select Gateway / Interfacewindow shows.

14. Select the gateway or interface for which you want to create or run this new view.

15. Click the Save to Tree button on the toolbar.

16. Enter a name for the new view.
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17. ClickOK.

The new view is saved in the Custom branch.

Exporting a Custom View

You can back up a custom view before you install an upgrade. You can share a custom view with other
SmartViewMonitor GUI clients and other users.

To export a custom view:

1. Right-click the view and select Export Properties.

2. In the window that opens, enter a pathname for the export file.

3. Click Save.

A file with an svm_setting extension is created.

Setting Your Default View
You can set which view to see when SmartViewMonitor starts.

In the Tree, right-click the view and selectRun at Startup.

Refreshing Views
Results are automatically refreshed every 60 seconds.

To refresh the view earlier, right-click the view name in the Tree and selectRun.

To refresh data about an object in the current view, right-click the object in the results and selectRefresh.

Monitoring Gateway Status
This section describes howmonitor your gateway status.

Gateway Status
Status updates show for Security Gateways and Software Blades. TheOverall status of a gateway is the
most important status of its Software Blades. For example, if all the Software Blades statuses areOK
except for the SmartEvent blade, which has a Problem status, theOverall status is Problem.

Status Icon Description

OK The gateway and all its Software Blades work properly.

Attention At least one Software Blade has a minor issue, but the gateway works.

Problem At least one Software Blade reported a malfunction, or an enabled Software Blade is
not installed.

Waiting SmartViewMonitor waits for the Security Management Server to send data from
Security Gateways.
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Status Icon Description

Disconnected
Cannot reach the Security Gateway.

Untrusted Cannot make Secure Internal Communication between the Security Management
Server and the gateway.

Displaying Gateway Data
Gateway Status data shows for each Check Point or OPSEC gateway.

To see data about a gateway:

1. OpenGateways Status and click All Gateways.

2. Right-click the gateway name and selectGateway Details.

The gateway status window opens and shows the IP address, version, and OS information.

3. Click System Information to view the system data.

System Data
n OS Information - The name, the version name/number, the build number, the service pack, and any

additional information about the Operating System in use.

n CPU - The specific CPU parameters (for example, Idle, User, Kernel, and Total) for each CPU.
Note - In theGateways Results view the Average CPU indicates the average total CPU usage of
all existing CPOS.

n Memory - The total amount of virtual memory, what percentage of this total is used. The total
amount of real memory, what percentage of this total is used, and the amount of real memory
available for use.

n Disk - Shows all the disk partitions and their specific details (for example, capacity, used, and free).
Note - In theGateways Results view the percentage/total of free space in the hard disk on which
the Firewall is installed. For example, if there are two hard drives C and D and the Firewall is on C,
the Disk Free percentage represents the free space in C and not D.

To view the status of Check Point applications on the local server or another appliance, the cpstat
command.

Firewall
n Policy information - The name of the Security Policy installed on the gateway, and the date and

time that this policy was installed.

n Packets - The number of packets accepted, dropped and logged by the gateway.

n UFP Cache performance - The hit ratio percentage and the total number of hits handled by the
cache, the number of connections inspected by the UFPServer.

n Hash Kernel Memory (the memory status) and System Kernel Memory (the OSmemory) - The
total amount of memory allocated and used. The total amount of memory blocks used. The number
of memory allocations, and those allocation operations which failed. The number of times that the
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memory allocation freed up, or failed to free up. The NAT Cache, including the total amount of hits
and misses.

Virtual Private Networks
The Virtual Private Networks (VPN) is divided into these main statuses:

n Current represents the current number of active output.

n High Watermark represents the maximum number of current output

n Accumulative data represents the total number of the output.

This includes:

n Active Tunnels - All types of active VPN peers to which there is currently an open IPsec tunnel. This
is useful to track the activity level of the VPN gateway. High Watermark includes the maximum
number of VPN peers for which there was an open IPsec tunnel since the gateway was restarted.

n Remote Access - All types of Remote Access VPN users with which there is currently an open IPsec
tunnel. This is useful to track the activity level and load patterns of VPN gateways that serve as a
remote access server. High Watermark includes the maximum number of Remote Access VPN
users with which there was an open IPsec tunnel since the gateway was restarted.

n Tunnels Establishment Negotiation - The current rate of successful Phase I IKENegotiations
(measured in Negotiations per second). This is useful to track the activity level and load patterns of a
VPN gateway that serve as a remote access server. High Watermark includes the highest rate of
successful Phase I IKENegotiations since the Policy was installed (measured in Negotiations per
second). Accumulative data includes the total number of successful Phase I IKE negotiations since
the Policy was installed.

n Failed - The current failure rate of Phase I IKENegotiations can be used to troubleshoot (for
instance, denial of service) or for a heavy load of VPN remote access connections. High Watermark
includes the highest rate of failed Phase I IKE negotiations since the Policy was installed.
Accumulative is the total number of failed Phase I IKE negotiations since the Policy was installed.

n Concurrent - The current number of concurrent IKE negotiations. This is useful to track the behavior
of VPN connection initiation, especially in large deployments of remote access VPN scenarios. High
Watermark includes the maximum number of concurrent IKE negotiations since the Policy was
installed.

n Encrypted and Decrypted throughput - The current rate of encrypted or decrypted traffic
(measured in Mbps). Encrypted or decrypted throughput is useful (in conjunction with encrypted or
decrypted packet rate) to track VPN usage and VPN performance of the gateway. High Watermark
includes the maximum rate of encrypted or decrypted traffic (measured in Mbps) since the gateway
was restarted. Accumulative includes the total encrypted or decrypted traffic since the gateway was
restarted (measured in Mbps).

n Encrypted and Decrypted packets - The current rate of encrypted or decrypted packets
(measured in packets per second). Encrypted or decrypted packet rate is useful (in conjunction with
encrypted/decrypted throughput) to track VPN usage and VPN performance of the gateway. High
Watermark includes the maximum rate of encrypted or decrypted packets since the gateway was
restarted, and Accumulative, the total number of encrypted packets since the gateway was
restarted.

n Encryption and Decryption errors - The current rate at which errors are encountered by the
gateway (measured in errors per second). This is useful to troubleshoot VPN connectivity issues.
High Watermark includes the maximum rate at which errors are encountered by the gateway
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(measured in errors per second) since the gateway was restarted, and the total number of errors
encountered by the gateway since the gateway was restarted.

n Hardware - The name of the VPN Accelerator Vendor, and the status of the Accelerator. General
errors such as the current rate at which VPN Accelerator general errors are encountered by the
gateway (measured in errors per second). The High Watermark includes the maximum rate at which
VPN Accelerator general errors are encountered by the gateway (measured in errors per second)
since the gateway was restarted. The total number of VPN Accelerator general errors encountered
by the gateway since it was restarted.

n IP Compression - Compressed/Decompressed packets statistics and errors.

QoS
n Policy information - The name of the QoSPolicy and the date and time that it was installed.

n Number of interfaces - The number of interfaces on the Check Point QoS gateway. Information
about the interfaces applies to both inbound and outbound traffic. This includes the maximum and
average amount of bytes that pass per second, and the total number of conversations, where
conversations are active connections and connections that are anticipated as a result of prior
inspection. Examples are data connections in FTP, and the "second half" of UDP connections.

n Packet and Byte information - The number of packets and bytes in Check Point QoS queues.

ClusterXL
n gateway working mode - The gateway working mode as a cluster member, active or not, and its

place in the priority sequence. Working modes are: ClusterXL, Load Sharing, Sync only. Running
modes: active, standby, ready and down.

n Interfaces - Interfaces recognized by the gateway. The interface data includes the IP Address and
status of the specified interface, if the connection that passes through the interface is verified,
trusted or shared.

n Problem Notes - Descriptions of the problem notification device such as its status, priority and when
the status was last verified.

OPSEC
n The version name or number, and build number of the Check Point OPSEC SDK and OPSEC

product. The time it takes (in seconds) since the OPSEC gateway is up and running.

n The OPSEC vendor can add fields to their OPSEC Application gateway details.

Check Point Security Management
n The synchronization status indicates the status of the peer Security Management Servers in relation

to that of the selected Security Management Server. View this status in theManagement High
Availability Servers window, if you are connected to the Active or Standby Security Management
Server. The possible synchronization statuses are:

l Never been synchronized - Immediately after the Secondary Security Management Server
was installed, it did not undergo with the first manual synchronization. This synchronization
brings it up to date with the Primary Management.
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l Synchronized -The peer is synchronized correctly and has the same database information
and installed Security Policy.

l Collision - The active Security Management Server and its peer have different installed
policies and databases. The administrator must do manual synchronization and decide which
of the Security Management Servers to overwrite.

n Clients - The number of connected clients on the Security Management Server, the name of the
SmartConsole, the administrator that manages the SmartConsole, the name of the SmartConsole
host, the name of the locked database, and the type of SmartConsole application.

SmartEvent Correlation Unit and the SmartEvent Server
SmartViewMonitor reads statuses from the SmartEvent Correlation Unit and SmartEvent Server.

SmartEvent Correlation Unit status examples:

n Is the SmartEvent Correlation Unit active or inactive

n Is the SmartEvent Correlation Unit connected to the SmartEvent Server

n Is the SmartEvent Correlation Unit connected to the Log Server

n SmartEvent Correlation Unit and Log Server connection status

n Offline job status

n Lack of disk space status

SmartEvent Server status examples:

n Last handle event time

n Is the SmartEvent Server active or inactive

n A list of SmartEvent Correlation Unit the SmartEvent Server is connected to

n Howmany events arrived in a specified time period

Connect the SmartEvent Correlation Unit to the Log Server to read logs. Connect it to the SmartEvent
Server to send events. If problems occur in the SmartEvent Correlation Unit connection to other
components (for example, SIC problems) the problems are reported in the SmartEvent Correlation Unit
status.

For the same reasons, the SmartEvent Server contains statuses that provide information about
connections to all SmartEvent Correlation Unit.

Anti-Virus and URL Filtering
SmartViewMonitor can now provide statuses and counters for gateways with Anti-Virus and URL Filtering.

The statuses are divided into these categories:

n Current Status

n Update Status (for example, when was the signature update last checked)

Anti-Virus statuses are associated with signature checks and URL Filtering statuses are associated with
URLs and categories.

In addition, SmartViewMonitor can now run Anti-Virus and URL Filtering counters.

For example:
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n Top five attacks in the last hour

n Top 10 attacks since last reset

n Top 10 http attacks in the last hour

n HTTP attacks general info

Multi-Domain Security Management
SmartViewMonitor can be used to monitor Multi-Domain Servers. This information can be viewed in the
Gateway Status view. In this view you can see Multi-Domain Security Management counter information
(for example, CPU or Overall Status).

cpstat

Description

Displays the status and statistics information of Check Point applications.

Syntax

cpstat [-d] [-h <Host>] [-p <Port>] [-s <SICname>] [-f <Flavor>] [-o
<Polling Interval> [-c <Count>] [-e <Period>]] <Application Flag>

Note - You can write the parameters in the syntax in any order.

Parameters

Parameter Description

-d Optional.

Runs the command in debug mode.

Use only if you troubleshoot the command itself.

The output shows the SNMP queries and SNMP responses for the applicable SNMP
OIDs.

-h
<Host>

Optional.

When you run this command on a Management Server, this parameter specifies the
managed Security Gateway.

<Host> is an IPv4 address, a resolvable hostname, or a DAIP object name.

The default is localhost.

-p
<Port>

Optional.

Port number of the Application Monitoring (AMON) server.

The default port is 18192.
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Parameter Description

-s
<
SICname>

Optional.

Secure Internal Communication (SIC) name of the Application Monitoring (AMON)
server.

-f
<Flavor>

Optional.

Specifies the type of the information to collect.

If you do not specify a flavor explicitly, the command uses the first flavor in the
<Application Flag>. To see all flavors, run the cpstat command without any
parameters.

-o
<Polling
Interval>

Optional.

Specifies the polling interval (in seconds) - how frequently the command collects and
shows the information.

n 0 - The command shows the results only once and the stops (this is the default
value).

n 5 - The command shows the results every 5 seconds in the loop.

n 30 - The command shows the results every 30 seconds in the loop.

n N - The command shows the results every N seconds in the loop.

Use this parameter together with the "-c <Count>" parameter and the "-e <Period>"
parameter.

Example: cpstat os -f perf -o 2

-c
<Count>

Optional.

Specifies howmany times the command runs and shows the results before it stops.

You must use this parameter together with the "-o <Polling Interval>" parameter.

n 0 - The command shows the results repeatedly every <Polling Interval> (this is the
default value).

n 10 - The command shows the results 10 times every <Polling Interval> and then
stops.

n 20 - The command shows the results 20 times every <Polling Interval> and then
stops.

n N - The command shows the results N times every <Polling Interval> and then
stops.

Example: cpstat os -f perf -o 2 -c 2
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Parameter Description

-e
<Period>

Optional.

Specifies the time (in seconds), over which the command calculates the statistics.

You must use this parameter together with the "-o <Polling Interval>" parameter.

You can use this parameter together with the "-c <Count>" parameter.

Example: cpstat os -f perf -o 2 -c 2 -e 60
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Parameter Description

<
Application
Flag>

Mandatory.

One of these:

n os - The OS information

n persistency - The historical status values

n thresholds - The thresholds configured with the threshold_config
command

n ci - The Anti-Virus blade information

n https_inspection - The HTTPS Inspection information

n cvpn - The Mobile Access blade information

n fw - The Firewall blade information

n vsx - The VSX information

n vpn - The IPsec VPN blade information

n blades - Overall status of the software blades

n identityServer - The Identity Awareness blade information

n appi - The Application Control blade information

n urlf - The URL Filtering blade information

n dlp - The Data Loss Prevention blade information

n ctnt - The Content Awareness blade information

n antimalware - The Threat Prevention information

n threat-emulation - The Threat Emulation blade information

n scrub - The Threat Extraction blade information

n gx - The LTE / Firewall-1 GX information

n fg - The QoS (formerly FloodGate-1) information

n ha - The ClusterXL (High Availability) information

n polsrv - The Policy Server information for Remote Access VPN clients

n ca - The Certificate Authority information

n mg - The Security Management Server information (connected GUI clients,
received logs statistics from connected gateways, indexed logs statistics)

n cpsemd - The SmartEvent blade information

n cpsead - The SmartEvent Correlation Unit information

n ls - The Log Server information

n PA - The Provisioning Agent information
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These flavors are available for the application flags
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--------------------------------------------------------------

|Flag |Flavours |

--------------------------------------------------------------

|os |default, ifconfig, routing, routing6, |

| |memory, old_memory, cpu, disk, perf, |

| |multi_cpu, multi_disk, raidInfo, sensors, |

| |power_supply, hw_info, all, average_cpu, |

| |average_memory, statistics, updates, |

| |licensing, connectivity, vsx |

--------------------------------------------------------------

|persistency |product, TableConfig, SourceConfig |

--------------------------------------------------------------

|thresholds |default, active_thresholds, destinations, |

| |error |

--------------------------------------------------------------

|ci |default |

--------------------------------------------------------------

|https_inspection |default, hsm_status, all |

--------------------------------------------------------------

|cvpn |cvpnd, sysinfo, products, overall |

--------------------------------------------------------------

|fw |default, interfaces, policy, perf, hmem, |

| |kmem, inspect, cookies, chains, |

| |fragments, totals, totals64, ufp, http, |

| |ftp, telnet, rlogin, smtp, pop3, sync, |

| |log_connection, all |

--------------------------------------------------------------

|vsx |default, stat, traffic, conns, cpu, all, |

| |memory, cpu_usage_per_core |

--------------------------------------------------------------

|vpn |default, product, IKE, ipsec, traffic, |

| |compression, accelerator, nic, |

| |statistics, watermarks, all |

--------------------------------------------------------------
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|blades |fw, ips, av, urlf, vpn, cvpn, aspm, dlp, |

| |appi, anti_bot, default, |

| |content_awareness, threat-emulation, |

| |default |

--------------------------------------------------------------

|identityServer |default, authentication, logins, ldap, |

| |components, adquery |

--------------------------------------------------------------

|appi |default, subscription_status, |

| |update_status, RAD_status, top_last_hour, |

| |top_last_day, top_last_week, |

| |top_last_month |

--------------------------------------------------------------

|urlf |default, subscription_status, |

| |update_status, RAD_status, top_last_hour, |

| |top_last_day, top_last_week, |

| |top_last_month |

--------------------------------------------------------------

|dlp |default, dlp, exchange_agents, fingerprint|

--------------------------------------------------------------

|ctnt |default |

--------------------------------------------------------------

|antimalware |default, scanned_hosts, scanned_mails, |

| |subscription_status, update_status, |

| |ab_prm_contracts, av_prm_contracts, |

| |ab_prm_contracts, av_prm_contracts |

--------------------------------------------------------------

|threat-emulation |default, general_statuses, update_status, |

| |scanned_files, malware_detected, |

| |scanned_on_cloud, malware_on_cloud, |

| |average_process_time, emulated_file_size, |

| |queue_size, peak_size, |

| |file_type_stat_file_scanned, |

| |file_type_stat_malware_detected, |
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| |file_type_stat_cloud_scanned, |

| |file_type_stat_cloud_malware_scanned, |

| |file_type_stat_filter_by_analysis, |

| |file_type_stat_cache_hit_rate, |

| |file_type_stat_error_count, |

| |file_type_stat_no_resource_count, |

| |contract, downloads_information_current, |

| |downloading_file_information, |

| |queue_table, history_te_incidents, |

| |history_te_comp_hosts |

--------------------------------------------------------------

|scrub |default, subscription_status, |

| |threat_extraction_statistics |

--------------------------------------------------------------

|gx |default, contxt_create_info, |

| |contxt_delete_info, contxt_update_info, |

| |contxt_path_mng_info, GXSA_GPDU_info, |

| |contxt_initiate_info, gtpv2_create_info, |

| |gtpv2_delete_info, gtpv2_update_info, |

| |gtpv2_path_mng_info, gtpv2_cmd_info, all |

--------------------------------------------------------------

|fg |all |

--------------------------------------------------------------

|ha |default, all |

--------------------------------------------------------------

|polsrv |default, all |

--------------------------------------------------------------

|ca |default, all, cert, crl, user |

--------------------------------------------------------------

|mg |default |

--------------------------------------------------------------

|cpsemd |default |

--------------------------------------------------------------

|cpsead |default |
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--------------------------------------------------------------

|ls |default |

--------------------------------------------------------------

|PA |default |

--------------------------------------------------------------

Example 1

[Expert@MyGW:0]# cpstat -f interfaces fw

Network interfaces
------------------------------------------------------------------------
--------------------------------------------
|Name|IP |Netmask |Flags|Peer name|Remote
IP|Topology|Proxy name|Slaves|Ports|IPv6 Address|IPv6 Len|
------------------------------------------------------------------------
--------------------------------------------
|eth0|192.168.30.40|255.255.255.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth1| 172.30.60.80|255.255.255.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth2| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth3| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth4| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth5| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth6| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
|eth7| 0.0.0.0| 0.0.0.0| 0| | 0.0.0.0| 4|

| | | ::| 0|
------------------------------------------------------------------------
--------------------------------------------

[Expert@MyGW:0]#
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Example 2

[Expert@MyGW:0]# cpstat -f default fw

Policy name: MyGW_Policy
Install time: Wed May 23 18:14:32 2018

Interface table
---------------------------------------
|Name|Dir|Total |Accept|Deny |Log|
---------------------------------------
|eth0|in | 2393126| 32589| 2360537| 52|
|eth0|out| 33016| 33016| 0| 0|
|eth1|in | 2360350| 0| 2360350| 0|
|eth1|out| 0| 0| 0| 0|
|eth2|in | 2360350| 0| 2360350| 0|
|eth2|out| 0| 0| 0| 0|
|eth3|in | 2348704| 0| 2348704| 1|
|eth3|out| 0| 0| 0| 0|
|eth4|in | 2360350| 0| 2360350| 0|
|eth4|out| 0| 0| 0| 0|
---------------------------------------
| | |11855896| 65605|11790291| 53|
---------------------------------------

... ... [truncated for brevity] ... ...

[Expert@MyGW:0]#
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Example 3

[Expert@MyGW:0]# cpstat os -f perf -o 2 -c 2 -e 60

Total Virtual Memory (Bytes): 12417720320
Active Virtual Memory (Bytes): 3741331456
Total Real Memory (Bytes): 8231063552
Active Real Memory (Bytes): 3741331456
Free Real Memory (Bytes): 4489732096
Memory Swaps/Sec: -
Memory To Disk Transfers/Sec: -
CPU User Time (%): 0
CPU System Time (%): 0
CPU Idle Time (%): 100
CPU Usage (%): 0
CPU Queue Length: -
CPU Interrupts/Sec: 135
CPUs Number: 8
Disk Servicing Read\Write Requests Time: -
Disk Requests Queue: -
Disk Free Space (%): 61
Disk Total Free Space (Bytes): 12659716096
Disk Available Free Space (Bytes): 11606188032
Disk Total Space (Bytes): 20477751296

Total Virtual Memory (Bytes): 12417720320
Active Virtual Memory (Bytes): 3741556736
Total Real Memory (Bytes): 8231063552
Active Real Memory (Bytes): 3741556736
Free Real Memory (Bytes): 4489506816
Memory Swaps/Sec: -
Memory To Disk Transfers/Sec: -
CPU User Time (%): 3
CPU System Time (%): 0
CPU Idle Time (%): 97
CPU Usage (%): 3
CPU Queue Length: -
CPU Interrupts/Sec: 140
CPUs Number: 8
Disk Servicing Read\Write Requests Time: -
Disk Requests Queue: -
Disk Free Space (%): 61
Disk Total Free Space (Bytes): 12659716096
Disk Available Free Space (Bytes): 11606188032
Disk Total Space (Bytes): 20477751296

[Expert@MyGW:0]#
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Starting and Stopping Cluster Members

To stop and start one member of a cluster from SmartViewMonitor:

1. Open aGateway Status view.

2. Right-click the cluster member and selectCluster Member >Start Member or Stop Member.

Monitoring Tunnels
This section describes how to monitor tunnels.

Tunnels Solution
VPN Tunnels are secure links between Security Gateways. These Tunnels ensure secure connections
between gateways of an organization and remote access clients.

When Tunnels are created and put to use, you can keep track of their normal function, so that possible
malfunctions and connectivity problems can be accessed and solved as soon as possible.

To ensure this security level, SmartViewMonitor constantly monitor and analyze the status of an
organization's Tunnels to recognize malfunctions and connectivity problems. With the use ofTunnel views,
you can generate fully detailed reports that include information about the Tunnels that fulfill the specific
Tunnel views conditions. With this information you can monitor Tunnel status, the Community with which a
Tunnel is associated, the gateways to which the Tunnel is connected, and so on. These are the Tunnel
types:

n ARegular tunnel refers to the ability to send encrypted data between two peers. The Regular tunnel
is considered up if both peers have Phase 1 and Phase 2 keys.

n Permanent tunnels are constantly kept active. As a result, it is easier to recognize malfunctions and
connectivity problems. With Permanent tunnels administrators can monitor the two sides of a VPN
tunnel and identify problems without delay.

Permanent tunnels are constantly monitored. Therefore, each VPN tunnel in the community can be
set as a Permanent tunnel. A log, alert or user defined action can be issued when the VPN tunnel is
down.

Permanent tunnels can only be established between Check Point gateways. The configuration of
Permanent tunnels takes place on the community level and:

l Can be specified for an entire community. This option sets every VPN tunnel in the community
as permanent.

l Can be specified for a specific gateway. Use this option to configure specific gateways to have
Permanent tunnels.

l Can be specified for a single VPN tunnel. This feature allows you to configure specific tunnels
between specific gateways as permanent.

This table shows the possible Tunnel states and their significance to a Permanent or Regular Tunnel.

State Permanent Tunnel Regular Tunnel

Up The tunnel works and the data can
flow with no problems.

IDE SA (Phase 1) and IPSEC SA (Phase 2) exist
with a peer gateway.
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State Permanent Tunnel Regular Tunnel

Destroyed The tunnel is destroyed. The tunnel is destroyed.

Up Phase1 Irrelevant Tunnel initialization is in process and Phase 1 is
complete (that is, IKE SA exists with cookies), but
there is no Phase 2.

Down There is a tunnel failure. You
cannot send and receive data to or
from a remote peer.

Irrelevant.

Up Init The tunnel is initialized. Irrelevant.

Gateway
not
Responding

The gateway is not responding. The gateway is not responding.

Tunnel View Updates
If a Tunnel is deleted from SmartConsole, the Tunnel Results View shows the deleted Tunnel for an hour
after it was deleted.

If a community is edited, the Results View shows removed tunnels for an hour after they were removed
from the community.

Running Tunnel Views
When a Tunnel view runs the results show in the SmartViewMonitor client. ATunnel view can run:

n From an existing view

n When you create a new view

n When you change an existing view

ATunnels view can be created and run for:

n Down Permanent Tunnels

n Permanent Tunnels

n Tunnels on Community

n Tunnels on Gateway

Run a Down Tunnel View

Down Tunnel view results list all the Tunnels that are currently not active.

To run a down tunnel view:

1. In the SmartViewMonitor, click the Tunnels branch in the Tree View.

2. In the Tunnels branch (Custom or Predefined), double-click the Down Permanent Tunnel view.
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A list of all the Down Tunnels associated with the selected view properties shows.

Run a Permanent Tunnel View

Permanent Tunnel view results list all of the existing Permanent Tunnels and their current status.

APermanent Tunnel is a Tunnel that is constantly kept active.

To run a permanent tunnel view:

1. In the SmartViewMonitor client, click the Tunnels branch in the Tree View.

2. In the Tunnels branch, double-click the Custom Permanent Tunnel view that you want to run.

A list of the Permanent Tunnels related to the selected view properties shows.

Run a Tunnels on Community View

Tunnels on Community view results list all the Tunnels related to a selected Community.

To run a tunnels on community view:

1. In the SmartViewMonitor client, click the Tunnels branch in the Tree View.

2. In the Tunnels branch (Custom or Predefined), double-click the Tunnels on Community view.

A list of all Communities shows.

3. Select the Community whose Tunnels you want to monitor.

4. ClickOK.

A list of all the Tunnels related to the selected Community shows.

Run Tunnels on Gateway View

Tunnels on Gateways view results list all of the Tunnels related to a selected Gateway.

To run tunnels on Gateway view:

1. In the SmartViewMonitor client, click the Tunnels branch in the Tree View.

2. In the Tunnels branch (Custom or Predefined), double-click the Tunnels on Gateway view.

A list of the gateways shows.

3. Select the gateway whose Tunnels and their status you want to see.

4. ClickOK.

A list of theTunnels related to the selected gateway shows.
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Monitoring Traffic or System Counters
This sections describes how to monitor traffic or system counters.

Traffic or System Counters Solution
SmartViewMonitor provides tools that enable you to monitor traffic related to specified network activities,
and server, as well as the status of activities, hardware and software use of different Check Point products
in real-time. With this knowledge you can:

n Block specified traffic.

n Control traffic flow on a gateway.

n See howmany tunnels are currently open, or the rate of new connections that pass through the VPN
gateway.

SmartViewMonitor delivers a comprehensive solution to monitor and analyze network traffic and network
usage. You can generate fully detailed or summarized graphs and charts for all connections intercepted
and logged when you monitor traffic, and for numerous rates and figures when you count usage
throughout the network.

Traffic

Traffic Monitoring provides in-depth details on network traffic and activity. As a network administrator you
can generate traffic information to:

n Analyze network traffic pattern

Network traffic patterns help administrators determine which services demand the most network
resources.

n Audit and estimate costs of network us

Monitoring traffic can provide information on how the use of network resources is divided among
corporate users and departments. Reports that summarize customer use of services, bandwidth
and time can provide a basis to estimate costs for each user or department.

n Identify the departments and users that generate the most traffic and the times of peak activity.

n Detect and monitor suspicious activity. Network administrators can produce graphs and charts that
document blocked traffic, alerts, rejected connections, or failed authentication attempts to identify
possible intrusion attempts.

ATraffic view can be created to monitor the Traffic types listed in the following table.

Traffic Type Explanation

Services Shows the current status view about Services used through the selected gateway.

IPs/Network
Objects

Shows the current status view about active IPs/Network Objects through the
selected gateway.

Security Rules Shows the current status view about the most frequently used Firewall rules.

The Name column in the legend states the rule number as previously configured in
SmartConsole.
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Traffic Type Explanation

Interfaces Shows the current status view about the Interfaces associated with the selected
gateway.

Connections Shows the current status view about current connections initiated through the
selected gateway.

Tunnels Shows the current status view about the Tunnels associated with the selected
gateway and their usage.

Virtual Link Shows the current traffic status view between two gateways (for example,
Bandwidth, Bandwidth Loss, and Round Trip Time).

Packet Size
Distribution

Shows the current status view about packets according to the size of the packets.

QoS Shows the current traffic level for each QoS rule.

Traffic Legend Output

The values that you see in the legend depend on the Traffic view that you run.

All units in the view results show in configurable Intervals.

System Counters

Monitoring System Counters provides in-depth details about Check PointSoftware Blade usage and
activities. As a network administrator, you can generate system status information about:

n Resource usage for the variety of components associated with the gateway. For example, the
average use of real physical memory, the average percent of CPU time used by user applications,
free disk space, and so on.

n Gateway performance statistics for a variety of Firewall components. For example, the average
number of concurrent CVP sessions handled by the HTTP security server, the number of concurrent
IKE negotiations, the number of new sessions handled by the SMTP security server, and so on.

n Detect and monitor suspicious activity. Network administrators can produce graphs and charts that
document the number of alerts, rejected connections, or failed authentication attempts to identify
possible intrusion attempts.

Select and Run a Traffic or System Counters View
When aTraffic or System Counters view runs, the results show in the SmartViewMonitor client. ATraffic
or System Counter view can run:

n From an existing view

n When you create a new view

n When you change an existing view
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To run a Traffic or System Counters view:

1. In the SmartViewMonitor client, select the Traffic or System Counter branch in the Tree View.

2. Double-click the Traffic or System Counter view that you want to run.

A list of available gateways shows.

3. Select the gateway for which you want to run the selected Traffic or System Counter view.

4. ClickOK.

The results of the selected view show in the SmartViewMonitor client.

Recording a Traffic or Counter View
You can save a record of the Traffic or System Counter view results.

To record a traffic or counter view:

1. Run the Traffic or System Counters view.

2. Select the Traffic menu.

3. SelectRecording >Record.

ASave As window shows.

4. Name the record.

5. Save it in the related directory.

6. Click Save.

The word Recording shows below theTraffic or Counter toolbar. The appearance of this word
signifies that the view currently running is recorded and saved.

7. To stop recording, open the Traffic menu and selectRecording >Stop.

A record of the view results is saved in the directory you selected in step 3 above.

Play the Results of a Recorded Traffic or Counter View

After you record a view, you can play it back. You can select Play or Fast Play, to see results change
faster.

To play the results:

1. In the SmartViewMonitor client, selectTraffic >Recording >Play.

The Select Recorded Filewindow shows.

2. Access the directory in which the recorded file is kept and select the related record.

3. ClickOpen.

The results of the selected recorded view start to run. The word Playing shows below the toolbar.
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Pause or Stop the Results of a Recorded View that is Playing

n To pause the record select Traffic >Recording >Pause.

n ClickRecording >Play to resume to play the Traffic or Counter view results recorded before.

n To stop the record select Traffic >Recording >Stop.

Monitoring Users
This section describes how to monitor users.

Users Solution
The User Monitor is an administrative feature. This feature lets you to keep track of Endpoint Security VPN
users currently logged on to the specific Security Management Servers. The User Monitor provides you
with a comprehensive set of filters which makes the view definition process user-friendly and highly
efficient. It lets you to easily navigate through the obtained results.

With data on current open sessions, overlapping sessions, route traffic, connection time, and more, the
User Monitor gives detailed information about connectivity experience of remote users. This SmartView
Monitor feature lets you view real-time statistics about open remote access sessions.

If specific data are irrelevant for a given User, the column showsN/A for the User.

Run a Users View
When you run a Users view, the results show in the SmartViewMonitor:

n From an existing view

n When you create a new view

n When you change an existing view

AUsers view can be created and run for:

n One user

n All users

n A specific gateway

n Mobile Access user

Run a User View for a Specified User

To run a user view for a specified user:

1. In SmartViewMonitor > Tree View, clickUsers.

2. ClickGet User by Name.

The User DN Filter window opens.

3. Enter the specified User DN in the area provided.
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4. ClickOK.

The view results show in the Results View.

Run a User View for all Users or Mobile Access Users

To run a user view for all users or Mobile Access users:

1. In SmartViewMonitor > Tree View, clickUsers.

2. Click All Users orMobile Access Users.

The view results show in the Results View.

Run a User View for a Specified Gateway

To run a user view for a specified Gateway:

1. In SmartViewMonitor > Tree View, clickUsers.

2. ClickUsers by Gateway.

The Select Gateway window shows.

3. Select the gateway for which you want to run the view.

4. ClickOK.

The view results show in the Results View.

Cooperative Enforcement Solution
Cooperative Enforcement works with Check Point Point Endpoint Security Management Servers. This
feature utilizes the Endpoint Security Management Server compliance function to make sure connections
that come from different hosts across the internal network.

Endpoint Security Management Server is a centrally managed, multi-layered endpoint security solution
that employs policy based security enforcement for internal and remote PCs. The Endpoint Security
Management Server mitigates the risk of hackers, worms, spyware, and other security threats.

Features such as policy templates and application privilege controls enable administrators to easily
develop, manage, and enforce Cooperative Enforcement.

With Cooperative Enforcement, a host that initiates a connection through a gateway is tested for
compliance. This increases the integrity of the network because it prevents hosts with malicious software
components to access the network.

Cooperative Enforcement acts as a middle-man between hosts managed by an Endpoint Security
Management Server and the Endpoint Security Management Server itself. It relies on the Endpoint
Security Management Server compliance feature. It defines if a host is secure and can block connections
that do not meet the defined prerequisites of software components.
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Unauthorized

Authorized

1. The Endpoint Security client (A) in the internal network (B) opens a connection to the internet (C)
through a Security Gateway (D).

2. Cooperative Enforcement starts to work on the first server's reply to the client.

3. The Security Gateway sees the client's compliance in its tables and queries the Endpoint Security
server (E).

4. When a reply is received, a connection from a compliant host to the internet is allowed.

If the client is non-compliant and Cooperative Enforcement is not in Monitor-only mode, the
connection is closed.

NAT Environments
Cooperative Enforcement is not supported by all the NAT configurations.

For Cooperative Enforcement to work in a NAT environment, the gateway and the Endpoint Security
Server must recognize the same IP address of a client. If NAT causes the IP address received by gateway
to be different than the IP address received by the Endpoint Security Server, Cooperative Enforcement will
not work.

Configuring Cooperative Enforcement

To configure Cooperative Enforcement:

From the gatewayCooperative Enforcement page, click Authorize clients using Endpoint Security
Server to enable Cooperative Enforcement.

n Monitor Only The firewall requests authorization from the Endpoint Security server, but
connections are not dropped. Hosts can connect while the gateway grants authorization. The
Firewall generates logs for unauthorized hosts. You can add unauthorized hosts to the host's
exception list or make those hosts compliant in other ways.

If Monitor Only is not selected, Cooperative Enforcement works in Enforcement mode. The
Endpoint Security Firewall blocks non-compliant host connections. For HTTP connections, the client
is notified that its host is non-compliant. The user can change the computer to make compliant. For
example, the user can upgrade the version of the Endpoint Security client.

n Track unauthorized client status. Set a log, or alert option for the hosts that would be dropped if not
in Monitor Only mode.



Monitoring Traffic or System Counters

Logging andMonitoring R80.40 Administration Guide      |      153

n In the Endpoint Security Server Selection section, select which Endpoint Security server will be
used:

l To use this machine, selectUse Endpoint Security Server installed on this machine.

l To use another machine, select a server from Select Endpoint Security Server. ClickNew
to create a new server.

n In the Client Authorization. section, define exceptions for client authorization.

l Check authorization of all clients - Get authorization from all clients.

l Bypass authorization of the following clients - Allow clients in the selected groups to always
connect, without authorization inspection. All other clients are inspected.

l Check authorization only of the following clients - Inspect authorization of clients from the
selected groups. All other clients bypass authorization.

Non-Compliant Hosts by Gateway View
The Non-Compliant Hosts by Gateway view lets you to see Host IP addresses by Endpoint Security
Management Server compliance:

n Authorized - Enables access to the internet. If a gateway has Authorized status, it does not show in
the Non-Compliant Hosts view.

n Unauthorized - The Endpoint Security client is not compliant and the host is not authorized.

l Monitor Only mode - The Endpoint Security client has access to the internet, authorized or
not.

l Blocked mode - Blocks access to the internet.

n No Endpoint Security client - The gateway is not related to an Endpoint Security client.
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Third-Party Log Formats
You can import these third-party log formats to a Check Point Log Server:

n Syslog messages.

n Windows Events.

n SNMPTraps.

The Log Server converts the third-party log messages to a Check Point log. The log is then available for
further analysis by SmartEvent.

Importing Syslog Messages
Many third-party devices use the syslog format for logging. The Log Server reformats the raw data to the
Check Point log format to process third-party syslogmessages.

The Log Server uses a syslog parser to convert syslog messages to the Check Point log format.

To import syslog messages, define your own syslog parser and install it on the Log Server.

SmartEvent can take the reformatted logs and convert them into security events.

Generating a Syslog Parser and Importing syslog Messages
To import syslog messages from products and vendors that are not supported out-of-the-box, see
sk55020. This shows you how to:

1. Import some sample syslog messages to the Log Parsing Editor.

2. Define the mapping between syslog fields and the Check Point log fields.

3. Install the syslog parser on the Log Server.

After you imported the syslog messages to the Log Server, you can see them in SmartConsole, in the Logs
& Monitor > Logs tab.

Note - Make sure that Access Control rules allow ELA traffic between the Syslog computer and the Log
Server.

Configuring SmartEvent to Read Imported Syslog Messages
After you imported the syslog messages to the Log Server, you can forward them to SmartEvent Server
(and other OPSEC LEA clients), as other Check Point logs. SmartEvent converts the syslog messages into
security events.

To configure the SmartEvent Server to read logs from this Log Server:

1. Configure SmartEvent to read logs from the Log Server.

2. In SmartEvent or in the SmartConsole event views, make a query to filter by the Product Name field.
This field uniquely identifies the events that are created from the syslog messages.

http://supportcontent.checkpoint.com/solutions?id=sk55020
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Importing Windows Events
Check Point Windows Event Service is a Windows service application. It reads events from the Windows
server and other configured Windows computers, converts them to Check Point logs, and places the data
in the Check PointLog Server. The Log Server processes this data. The process can only be installed on a
Windows computer, but it does not have to be the computer that runs Log Server. Therefore, Windows
events can be processed even if the Log Server is installed on a different platform.

How Windows Event Service Works

To convert Windows events into Check Point logs:

1. Download the Windows Event Service agent WinEventToCPLog from the Check Point Support
Center.

2. Install the service agent on a Windows server.

An administrator user name and password are necessary. The administrator name is one of these:

n A domain administrator responsible for the endpoint computer

n A local administrator on the endpoint computer

3. Create SIC between the Windows server and the management.

4. Configure the Windows server to collect Windows events from required computers.

Administrator Support for WinEventToCPLog
WinEventToCPLog uses Microsoft APIs to read events from Windows operating system event files. To
see these files, use the Windows Event Viewer.

WinEventToCPLog can read event files on the local machine, and can read log files from remote
machines with the right privileges. This is useful when you make a central WinEventToCPLog server that
forwards multiple Window hosts events to a Check Point Log Server.

To set the privileges, invoke the "WinEventToCPLog -s" to specify an administrator login and
password.

These are the ways to access the files on a remote machine:

n To define a local administrator on the remote machine that their name matches the name registered
with WinEventToCPLog.

n To define the administrator registered with WinEventToCPLog as an administrator in the domain.
This administrator can access all of the machines in the domain.

Sending Windows Events to the Log Server
This section describes how to send Windows events to the Log Server. For advanced Windows event
configuration, see sk98861.

https://supportcenter.checkpoint.com/
https://supportcenter.checkpoint.com/
http://supportcontent.checkpoint.com/solutions?id=sk98861
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Creating an OPSEC Object for Windows Event Service
In SmartConsole, create an OPSEC object for Windows Event Service.

To create an OPSEC object for windows event service:

1. From the Object Explore, clickNew > Server > OPSEC Application > Application.

TheOPSEC Applications Properties window shows.

2. Enter the name of the application that sends log files to the Log Server.

3. ClickNew to create a Host.

4. Enter an object name and the IP address of the machine that runsWinEventToCPLog.

5. ClickOK.

6. BelowClient Entities, select ELA.

7. SelectCommunication.

8. Enter an Activation Key, enter it again in the confirmation line, and keep a record of it for later use.

9. Click Initialize.

The system must report the trust status as Initialized but trust not established.

10. ClickClose.

11. ClickOK.

12. Publish the SmartConsole session.

Note - Make sure that Access Control rules allow ELA traffic between the Windows computer and the Log
Server.

Configuring the Windows service
On the Windows host, configure the Windows service to send logs to the Log Server.

To configure the Windows service:

1. Install theWinEventToCPLog package from the Check Point Support Center.

2. When the installation completes, restart the computer.

3. Open a command prompt window and go to this location:

n OnWindows 32-bit:

C:\Program Files\CheckPoint\WinEventToCPLog\R65\bin\

n OnWindows 64-bit:

C:\Program Files (x86)\CheckPoint\WinEventToCPLog\R65\bin\

4. Pull the certificate.

Instructions

a. Run:

http://supportcenter.checkpoint.com/file_download?id=7200
https://supportcenter.checkpoint.com/
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windowEventToCPLog -pull_cert

b. Enter the IP address of the management server.

c. Enter the name of the corresponding OPSEC Application object that you created in
SmartConsole for the Windows events.

d. Enter the Activation Key of the OPSEC object.

5. Restart the Check Point Windows Event Service.

Establishing Trust
Establish trust between the Security Management Server and the windows host.

To establish trust:

1. Edit the OPSEC Application that you created in SmartConsole for the Windows events.

2. SelectCommunication.

3. Make sure that the trust status is Trust Established.

4. Publish the SmartConsole session.

Configuring the Windows Audit Policy
On each machine that sendsWindows Events, configure the Windows Audit Policy.

To configure the windows audit:

1. From the Startmenu, click Settings > Control Panel.

2. Click Administrative Tools > Local Security Policy >Local Policies >Audit Policy.

3. Make sure that the Security Setting for the Policy Audit Logon Events is set to Failure. If not,
double-click it and select Failure.

4. Open a command prompt window and go to this path:

n OnWindows 32 bit:

C:\Program Files\CheckPoint\WinEventToCPLog\R65\bin\

n OnWindows 64 bit:

C:\Program Files (x86)\CheckPoint\WinEventToCPLog\R65\bin\

5. Run these commands:

windowEventToCPLog -l <ipaddr>, where <ipaddr> is the IP address of the Log Server that
receives the Windows Events.

windowEventToCPLog -a <ipaddr>, where <ipaddr> is the IP address of each machine that sends
Windows Events.

windowEventToCPLog -s, where you are prompted for an administrator name and the
administrator password that to be registered with the windowEventToCPLog service.
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The administrator that runs the windowEventToCPLog service must have permissions to access
and read logs from the IP addressed defined in this procedure. This is the IP address of the
computer that sendsWindows events.

6. When you configure windowEventToCPLog to read Windows events from a remote machine, log in
as the administrator. This makes sure that the administrator can access remote computer events.

7. Use the Microsoft Event Viewer to read the events from the remote machine.

Working with SNMP
SNMP (Simple Network Management Protocol) is an internet standard protocol. SNMP is used to send and
receive management data, protocol data units (PDUs), to network devices. SNMP-compliant devices,
called agents, keep data about themselves in Management Information Bases (MIBs) and resend this data
to the SNMP requesters.

For more information, see R80.40Gaia Administration Guide > Chapter SystemManagement
> Section SNMP.

https://sc1.checkpoint.com/documents/R80.40/WebAdminGuides/EN/CP_R80.40_Gaia_AdminGuide/Default.htm
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Log Exporter
This section describes how to work with Log Server.

Overview
Check Point Log Exporter is an easy and secure method to export Check Point logs over syslog in R80.20
and higher management. For information on deployment in R77.30 and R80.10 servers, see sk122323.

The Check Point App for Splunk uses the Log Exporter to seamlessly send logs from your Check Point Log
Server to your Splunk server. This enables you to collect and analyze millions of logs from all Check Point
technologies and platforms. For more information, see the App for SplunkUser Guide.

Log Exporter supports:

n SIEM applications: Splunk/Arcsight/RSA/LogRhythm/QRadar/McAfee/rsyslog/ng-syslog and any
other SIEM application that can run a syslog agent.

n Protocols: Syslog over TCP or UDP.

n Formats: Syslog, CEF, LEEF, Generic.

n Read-Mode: Raw, Semi-Unified.

n Security: Mutual authentication TLS.

n Types: Security logs, Audit logs.

n Export Links: You can export links to the relevant log card in SmartView and the log attachment
(such as Forensics\Threat Emulation report).

n Filtering:

n Filter out (do not export) firewall connection logs.

n Select what to export based on field values.

n For more information, including basic and advanced instructions for filtering, see sk122323.

How it Works
Log Exporter is a multi-threaded daemon service which runs on a log server. Each log that is written on the
log server is read by the Log Exporter daemon. It is then transformed into the applicable format and
mapping and sent to the end target.

On Multi-Domain Server / Multi-Domain Log Server, if Log Exporter is deployed on several domains, each
domain server has its own Log Exporter daemon service. If you export the logs to several targets, each
target has its own Log Exporter daemon.

n Extract - Reads incoming logs from itself, the Log Server / SmartEvent Server of the Security
Gateways.

n Transform - Changes the logs according to the configuration.

n Export - Sends the logs to the configured target server.

http://supportcontent.checkpoint.com/solutions?id=sk122323
https://sc1.checkpoint.com/documents/App_for_Splunk/html_frameset.htm
http://supportcontent.checkpoint.com/solutions?id=sk122323
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Basic Deployment
Common method for creating \ modifying log exporters \ targets.

To configure a new target for the logs:

1. On the Log Server, run:

cp_log_export add name <name> [domain-server <domain-server>]
target-server <target-server> target-port <target-port> protocol <
(udp|tcp)> format {syslog) | cef} [optional arguments]

2. On Multi-Domain Server / Multi-Domain Log Server: The domain-server argument is mandatory.
You can usemdsas the value for the domain-server to export Multi-Domain Log Server level audit
logs

3. This creates a new target directory with the unique name specified in the -n parameter under
$EXPORTERDIR/targets/<deployment_name>.

4. Set the target configuration parameters with the connection details:

n IP Address

n Port

n Protocol

Note - This deployment exports the logs in clear text.

Unless apply-now is used within the command, the new Log Exporter does not start automatically and
requires a manual start command.

For information on how to send the logs over an encrypted connection, see "TLS Configuration" on
page 164.

Advanced Deployment - Additional Commands
Advanced parameters for creating and modifying Log Exporter targets.

Usage

cp_log_export <command-name> [command-arguments]

To understand a specific command usage:

cp_log_export <command-name> help
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Commands

Name Description

add Deploy a new Check Point Log Exporter.

delete Remove an exporter.

reexport Reset the current position and reexport all logs per the configuration.

restart Restart an exporter process.

set Update an existing exporter's configuration.

show Print an exporter's current configuration.

start Start an exporter process.

status Show an exporter's overview status.

stop Stop an exporter process.

Command Arguments

Name Description
Required
for "add"
command

Required
for "set"
command

Required
for
"delete"
command

Required
for
"show",
"status",
"start",
"stop",
"restart"
command

Required
for
"reexport"
command

apply-now Applying any
change that
was done
immediately.

Optional Optional Mandatory N/A Mandatory

ca-cert Full path to the
CA certificate
file *.pem.

Applicable only
when the value
of the
"encrypted"
argument is
"true".

Optional Optional N/A N/A N/A
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Name Description
Required
for "add"
command

Required
for "set"
command

Required
for
"delete"
command

Required
for
"show",
"status",
"start",
"stop",
"restart"
command

Required
for
"reexport"
command

client-cert Full path to the
client
certificate
*.p12.

Applicable only
when the value
of the
"encrypted"
argument is
"true".

Optional Optional N/A N/A N/A

client-
secret

The challenge
phrase used to
create the
client
certificate
*.p12.

Applicable only
when the value
of the
"encrypted"
argument is
"true".

Optional Optional N/A N/A N/A

domain-
server

The name or
IP address of
the applicable
Domain
Management
Server.

Mandatory Mandatory Mandatory Optional.

By
default,
applies to
all.

Mandatory

enabled Allow the Log
Exporter to
start when you
run the
"cpstart" or
"mdsstart"
command.

Optional Optional N/A N/A N/A

encrypted Use TSL (SSL)
encryption to
export the
logs.

Optional Optional N/A N/A N/A
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Name Description
Required
for "add"
command

Required
for "set"
command

Required
for
"delete"
command

Required
for
"show",
"status",
"start",
"stop",
"restart"
command

Required
for
"reexport"
command

export-
attachment-
link

Add a field to
the exported
log that
represents a
link to
SmartView
that sows the
log card and
automatically
opens the
attachment.

Optional Optional N/A N/A N/A

export-link Add a field to
the exported
log that
represents a
link to
SmartView
that shows the
log card.

Optional Optional N/A N/A N/A

export-
link-ip

Make the links
to SmartView
use a custom
IP address (for
example, for a
Log Server
behind NAT).

Optional Optional N/A N/A N/A

format The format, in
which the logs
are exported.

Optional Optional N/A N/A N/A

name Unique name
of the exporter
configuration.

Mandatory Mandatory Mandatory Optional.

By
default,
applies to
all.

Mandatory

protocol Transport
protocol to
use.

Mandatory Optional N/A N/A N/A
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Name Description
Required
for "add"
command

Required
for "set"
command

Required
for
"delete"
command

Required
for
"show",
"status",
"start",
"stop",
"restart"
command

Required
for
"reexport"
command

target-port The port on
the target
server, to
which you
export the
logs.

Mandatory Optional N/A N/A N/A

target-
server

The IP
address of the
target server,
to which you
export the
logs.

Mandatory Optional N/A N/A N/A

TLS Configuration
How to get a secured connection between the Log Exporter and the syslog server.

The only allowed authentication method via TLS is mutual authentication. For mutual authentication, Log
Exporter needs these certificates:

n A pemCertificate Authority (CA) certificate

n A .p12 format client certificate

If you do not already have the required certificates, this procedure is an example of how to create the
required certificates. There are also alternative procedures.

All commands need to run on the CA server.

Note - The CA server needs to be routable from the Log Exporter device.

To create a self signed CA:

Run this if you do not already have a trusted CA pem:

1. Generate the root CA key and do not pass to anyone:

openssl genrsa -out RootCA.key 2048

2. Generate the root CA pem:

openssl req -x509 -new -nodes -key RootCA.key -days 2048 -out
RootCA.pem

3. Enter the Distinguished Name (DN) information for the certificate.
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n Common Name(CN) is the exact Fully Qualified Domain Name (FQDN) of the host that you
use the certificate with.

n All other fields are optional. If you purchase an SSL certificate from a certificate authority,
these additional fields may be required.

An example of the prompt to provide information:

---

Country Name (2 letter code) [AU]:US

State or Province Name (full name) [Some-State]:New York

Locality Name (eg, city) []:MyCity

Organization Name (eg, company) [Internet Widgits Pty Ltd]:MyCompany

Organizational Unit Name (eg, section) []:MyDepartment

Common Name (e.g. server FQDN or YOUR name) []:www.company.com

Email Address []:

To create a client (log_exporter) .p12 certificate file:

1. Generate the client key and do not pass to anyone:

openssl genrsa -out log_exporter.key 2048

2. Generate the client certificate sign request:

openssl req -new -key log_exporter.key -out log_exporter.csr

3. Use the CA files to sign the certificate:

openssl x509 -req -in log_exporter.csr -CA RootCA.pem -CAkey
RootCA.key -CAcreateserial -out log_exporter.crt -days 2048 -sha256

4. Convert to p12 format:

openssl pkcs12 -inkey log_exporter.key -in log_exporter.crt -export
-out log_exporter.p12

Note - The challenge phrase used in this conversion is required in the log_exporter TLS configuration.

After you create the required certificates, update the security parameters on the Check Point exporting
server:

To update the security parameters:

1. If running on Multi-Domain Server / Multi-Domain Log Server, switch to the required domain. Run:

mdsenv<domain server name or ip>

2. Go to the deployment directory:

cd $EXPORTERDIR/targets/<deployment name>

3. Create a directory for the certificates:

mkdir certs

4. Copy RootCA.pem and log_exporter.p12 to the certs directory
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5. Give the RootCA.pem and log_exporter.p12 execution privilege

chmod +r RootCA.pem

chmod +r log_exporter.p12

6. Update the targetConfiguration.xmlfile with the full path to the certificates and the
challenge phrase used to create the .p12 certificate

To create a server (target) certificate:

1. Generate the server key and do not pass to anyone:

openssl genrsa -out syslogServer.key 2048

2. Generate the server certificate sign request:

openssl req -new -key syslogServer.key -out syslogServer.csr

3. Use the CA files to sign the certificate:

openssl x509 -req -in syslogServer.csr -CA RootCA.pem -CAkey
RootCA.key -CAcreateserial -out syslogServer.crt -days 2048 -sha256

Advanced Configuration Post Deployment
Configuring Log Exporter without using the deployment script.

After deploying a new instance of Log Exporter, all related files to that deployment can be found under
$EXPORTERDIR/targets/<deployment name>.

On a Multi-Domain Server / Multi-Domain Log Server, the EXPORTERDIR environment variable is per
domain. The value is changed automatically when you switch between domain server contexts with the
mdsenv command.

Target Configuration XML

The target configuration file, located under each deployment folder:
$EXPORTERDIR/targets//targetConfiguration.xml

Note - You must restart the Log Exporter process for the new setting to take effect.

These are some of the configuration options:

Parameter Description Possible/Default
Values

<version></version> Current Log Exporter version - used for upgrades

<is_enabled></is_
enabled>

Determines if the process is monitored by the
watch dog

true/false

Destination Parameters
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Parameter Description Possible/Default Values

type Reserved for future use

<ip></ip> The IP address of the target that receives the logs Any IPv4 address

<port></port> The port on the target Any valid port number

<protocol></protocol> The protocol used in the connection UDP/TCP

Security Parameters

These are discussed in more detail in "TLS Configuration" on page 164.

Parameter Description Possible/Default
Values

<security></security> Determines if the connection is sent in clear
text or encrypted

clear [default] /
tls

<pem_ca_file></pem_ca_file> The location of the root CA pem file

<p12_certificate_file></p12_
certificate_file>

The location of the client key pair in p12 format

<client_certificate_challenge_
phrase></client_certificate_
challenge_phrase>

The challenge phrase used to create the p12
certificate. It is hashed when the Log Exporter
is started or restarted.

Source Parameters

Parameter Description Possible/Default Values

<folder></folder> The path where the log files are
located

Default location is $FWDIR/log/

<log_files></log_
files>

Determines which log files are
exported

on-line| read logs from [number - default=1]
days back (recommended) | specific file name

<log_
types></log_
types>

Determines which log file types
(by extension) are exported

All [default] / log / audit

Resolver Parameters

Parameter Description Possible/Defa
ult Values

<mappingConfiguration></mappingConfigurati
on>

The XML file that contains the log
field mapping scheme. Uses the
default settings if left empty.

Default values
are based on
the format
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Parameter Description Possible/Defa
ult Values

<exportAllFields>true</exportAllFields> When this field is set to true, all
log fields are sent regardless of
whether or not they appear in the
mapping scheme. The exception is
for fields that are specifically black
listed in the relevant log format
mapping file (with exported flag
false): <reported>
false</exported>

When set to false, only those
fields which appear in the relevant
log format mapping file are sent
(with exported flag true:
<exported>true</exporte
d>)

true/false

Format Parameters

Parameter Description Possible/Default
Values

<formatHeaderFile></formatHeaderFile> The XML file that contains the log
header format scheme. Uses the
default settings if left empty.

Default values
are based on the
format

SmartViewLinks Parameters

Parameter Description Possible/Default
Values

export_log_
link

Add a field to the exported log that represents a link to SmartView
that shows the log card.

True/False
(default)

export_
attachment_
link

Add a field to the exported log that represents a link to SmartView
that shows the log card and automatically opens the attachment.

True/False
(default)

export_link_
ip

Make the avove 2 links use a customized IP (e.g. for NATed Log
Server).

IPv4/empty
(default)

Filters Parameters

The Log Exporter solution supports both a basic and advanced filtering ability. For more information about
the advanced value filtering ability, see sk122323. The basic ability below allows you to not export firewall
connections logs. All other logs are exported.

http://supportcontent.checkpoint.com/solutions?id=sk122323
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Parameter Description Possible/Default
Values

<filter filter_out_by_
connection="false">

Determines if the Access logs should be filtered out.

When set to true,VPN-1 & Firewall-1 logs are filtered
out (HTTPS Inspections logs are still exported).

Note - These are the only blade filters currently
supported.

true/false

Format Configuration XML

Body

Parameter Description Syslog CEF LEEF Generic

<start_message_
body></start_
message_body>

The character that
precedes the log data
payload

[

<end_message_
body></end_
message_body>

The character that follows
the log data payload

]

<message_
separator></message_
separator>

The delimeter that
separates logs

&#10;
(&#10;=='\n')

&#10;
('\n')

&#10;
('\n')

('\n')

<fields_
separatator></fields_
separatator>

The delimeter that
separates log fields

'; ' (semi
colon,
space)

' '
(space)

&#09;
(<TAB>)

' '
(space)

<field_value_
separatator></field_
value_separatator>

The assignment operator : = = =

<value_encapsulation_
start>&quot;</value_
encapsulation_start>

The value encapsulation
operator (start)

" " "

<value_encapsulation_
start>&quot;</value_
encapsulation_start>

The value encapsulation
operator (end)

" " "

<escape_chars>

<char>

<orig></orig>

<escaped></escaped>

</char>

</escape_chars>

To escape unwanted
characters

The escape functionality
replaces the string that is
encapsulated by the orig
tags with the string
encapsulated by the
escaped tags

\ --> \\

" --> \"

&#10; --> ' '

] --> \]

\ --> \\

= --> \=

&#10; -
-> ' '

| --> \|

= --> \=

&#10; --
> ' '

\ --> \\

" --> '

&#10; --
> ' '
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Header

Parameter Description
Default
values for
sysl

Default
values for
CEF

<header_
format></header_
format>

The delimeter between the header values and the
number of values. Every {} is replaced with one value.

' ' (space) |

Field Mapping Configuration XML

Parameter Description Possible/Default
Values

<table> Some fields appear in the tables based on the log
format. This information can be found in the elglog -
one entry for every new field. A field can appear in
multiple tables. Each distinct instance is considered a
new field.

<exported></exported> Optional - You can use the exported true/false tag in
the mapping configuration file to filter out specific
fields.

Alternatively, if the 'exportAllFields' tag in the
'targetConfiguration.xml' file is set to false, only
those fields which are listed in the mapping file are
exported.

true/false

<origName></origName> The name of the field that is mapped to <dstName>

<dstName></dstName> The newmapping scheme name for the applicable
field.

<required></required> Optional - When set to true, only logs that contain
this field are exported.

true/false

SIEM Specific Instruction
How to configure SIEM applications to optimally receive logs.

ArcSight

ArcSight recommends that you name the certificate syslog-ng.

To name the certificate:

Convert the key to p12 format:

openssl pkcs12 -inkey syslogServer.key -in syslogServer.crt -export -out
syslog-ng.p12 -name "syslogng-alias" -password pass:changeit
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To make sure the environment variable ARCSIGHT_HOME is the connector install directory:

1. Run the certificates manager on the Linux KDE console: $ARCSIGHT_
HOME/current/bin/arcsight agent keytoolgui

2. From the Filemenu, open the keystore: $ARCSIGHT_
HOME/current/jre/lib/security/cacerts (password "changeit").

3. From the menu, select Import Trusted Certificate.

4. From the file dialog, select Ca.pem and save it.

5. Save and close the certificate manager.

To edit the agent.properties file to enable mutual authentication:

Use vi $ARCSIGHT_HOME//current/user/agent/agent.properties:

1. Change this value to true:

syslogng.mutual.auth.enabled=false -> true

2. Add these lines to the end:

syslogng.tls.keystore.file=user/agent/syslog-ng.p12

syslogng.tls.keystore.alias=syslogng-alias

3. Run: /etc/init.d/arc_connector_name restart

Splunk

1. Generate the server pem file:

cat syslogServer.crt syslogServer.key RootCA.pem > splunk.pem

2. Update the inputs.conf file on the Splunk server:

vi /opt/splunk/etc/apps/search/local/inputs.conf

[SSL]

serverCert = /etc/ssl/my-certs/splunk.pem

sslPassword =<challenge password>

requireClientCert = true

[tcp-ssl://<port>]

index =<index>

3. Update the server.conffile on the Splunk server

vi /opt/splunk/etc/system/local/server.conf

[sslConfig]

sslRootCAPath = /etc/ssl/my-certs/RootCA.pem

4. Restart Splun
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/opt/splunk/bin/splunk restart

QRadar

1. In the Authentication Mode field, select TLS And Client Authentication.

When you use Client Authentication, you must provide the absolute path to the client certificate.

2. Upload the Check Point certificate and private key to QRadar and provide the absolute path to those
under the Provide Certificate option.

Transition from LEA to Log Exporter

To move from the existing LEA connector to the new Log Exporter:

1. Delete the OPSEC application object from the GUI, if it is the only use for the OPSEC application. If
not, remove the LEA client entity.
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2. If this is the only OPSEC LEA client, configure $FWDIR/conf/fwopsec.conf to not allow LEA:

Comment out these lines:

From To

# #

lea_server auth_port 18184 # lea_server auth_port 18184
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From To

lea_server port 0 # lea_server port 0

# #

3. Install the Log Exporter according to the installation guide above.

Transition from CPLogToSyslog to Log Exporter

To move from the existing CPLogToSyslog to the new Log Exporter:

1. Use CPUSE to uninstall the CPLogToSyslog package. See section 4-C in sk92449.

2. Install the Log Exporter according to the installation guide above.

Appendix

Special log fields

loguid - Some Check Point logs are updated over time. Updated logs have the same loguid value. Check
Point SmartLog client correlates those updates into a single unified log. When the update logs are sent to
3rd party servers, they arrive as distinct logs. Administrators can use the loguid field to correlate updated
logs and get the full event chain.

Note - Log Exporter's new semi-unified mode correlates all previous logs into one, so the latest log always
shows the complete data.

An example of updated logs includes the total amount of bytes sent and received over time or the severity
field which is updated over time as more information becomes available.

hll_key (High Level Log key) - This concept was introduced in R80.10. Multiple connection logs can
comprise one session with one shared hll_key. For example, when you browse to a webpage, you may
have multiple connection logs which are related to the same session. Connection logs which are part of the
same session share the same hll_key value.

Syslog-NG Listener configuration

We recommend you use the syslog-protocol flag when you configure a source on a Syslog NG server.

For example: source s_network { network(transport("tcp") port(514) flags
(syslog-protocol) ); };

Splunk Listener configuration

We recommend that you add these time settings to your sourcetype:

n TIME_FORMAT = %s

n TIME_PREFIX = time=

n MAX_TIMESTAMP_LOOKAHEAD = 15

http://supportcontent.checkpoint.com/solutions?id=sk92449
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ArcSight Listener configuration

The Log Exporter solution does not work with the OPSEC LEA connector. Instead, you must install the
ArcSight Syslog-NG connector.

ArcSight Common Event Format (CEF) Mapping

CEF is an extensible, text-based format that supports multiple device types by offering the most relevant
information. Message syntaxes are reduced to work with ESM normalization. Specifically, CEF defines a
syntax for log records comprised of a standard header and a variable extension, formatted as key-value
pairs. The CEF format can be used with on-premises devices by implementing the ArcSight Syslog
SmartConnector. CEF can also be used by cloud-based service providers by implementing the
SmartConnector for ArcSight Common Event Format REST.

CEF Header format

Versio
n

Devic
e
Vend
or

Device
Produ
ct

Device
Versio
n

Device Event
Class ID Name Severity

Defau
lt

CEF:0 Check
Point

Log
Updat
e

Check
Point

Log Log 0

Value
s

- - Produ
ct
Name
(Blad
e)

- n Attack
Name

n Protectio
n Type

n Verdict

n Matched
Category

n DLP
Data
Type

n Applicati
on
Category

n Applicati
on
Propertie
s

n Protectio
n Name

n Applicati
on Name

n Message
Info

n Service
ID

n Service

n Applicati
on Risk

n Risk

n Severity

QRadar Log Event Extended Format (LEEF) Mapping

The LEEF is a customized event format for IBM Security QRadar.

LEEF Header Format
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LEEF Version Vendor Product Version EventID

Default LEEF:2.0 Check Point Log Update 1.0 Check Point Log

Values - - Product Name (Blade) - n Protection
Name

n Application
Name

n Action

Note - The time format is not compliant with the official LEEF format.

As there is currently no epoch time format, Log Exporter with LEEF format is only partially supported.
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Appendix: Manual Syslog Parsing
Many third-party devices use the syslog format to log. The Log Server reformats the raw data to the Check
Point log format to process third-party syslogmessages. SmartEvent can take the reformatted logs and
convert them into security events.

You can use the Log Parsing Editor to make a parsing file (see Importing SyslogMessages). As an
alternative you can manually create a parsing file. This section shows you how to do that.

Warning - Manual modifications to out-of-the-box parsing files cannot be preserved
automatically during an upgrade. Mark your modifications with comments so you can
remember what changed.

Planning and Considerations
1. Learn the accurate structure of the logs the device generates with these guides.

a. The vendor logging guide, or other documentation that specifies the logs the device can
generate and their structure. Documentation is important to make sure that you found all
possible logs. Usually it is sufficient to write the parsing file.

b. Log samples, as many as possible. Use logs generated from the actual devices to be used
with SmartEvent. Samples are important to examine the parsing file and to tune it
accordingly.

2. Learn and know "The Free Text Parsing Language" on page 179 and the necessary parsing files
and their location on the Log Server (see"The Parsing Procedure" below).

3. Compare existing parsing files of an equivalent product.

4. Select the fields to extract from the log. The fields to extract are different from one device to another.
But devices of the same category usually have equivalent log fields. For example:

Device Type Typical Log Fields

Firewall, router and other devices
that send connection based logs

source IP address, destination IP address, source port,
destination port, protocol, accept/reject indication

IDS / IPS, application Firewall and
other devices that send attack logs

attack name/ID

The Parsing Procedure
The procedure occurs on the Log Server and starts with the syslog daemon. The syslog daemon that runs
on the Log Server receives the syslogs and calls for their parsing. The parsing involves many parsing files,
which contain the different parsing definitions and specifications, and can be found in the
$FWDIR/conf/syslog/ directory. In these files there are the device-specific parsing files, which define the
actual parsing and extraction of fields, according to each device specific syslog format.
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The parsing starts with the syslog_free_text_parser.C file. This file defines the differentDictionary terms
and parses the syslog. The file extracts fields, which are common to all syslog messages (such as PRI,
date and time), and the machine and application that generated the syslog.

The syslog_free_text_parser.C file uses the allDevices.C file (which refers to two files:
UserDefined/UserDefinedSyslogDevices.C and CPdefined/CPdefinedSyslogDevices.C).

n The first file (UserDefined/UserDefinedSyslogDevices.C)contains the names of the devices
parsing files that the user defines.

n The second file (CPdefined/CPdefinedSyslogDevices.C)contains devices parsing files that Check
Point defines.

The allDevices.C file goes over the device parsing files, and tries to match the incoming syslog with the
syslog format parsed in that file.

After the parsing-file succeeds in the preliminary parsing of the syslog (that is, it matches the syslog format
and is therefore the syslog origin), the remaining of the syslog is parsed in that file. If a match is not found,
the file will continue to go over the Check Point device parsing files until it finds a match.

Manual Syslog Parsing

To parse a syslog file:

1. Create a new parsing file called <device product name>.C.

2. Put this file in the directory $FWDIR/conf/syslog/UserDefined on the Log Server.

3. On the Log Server, edit the file $FWDIR/conf/syslog/UserDefined/UserDefinedSyslogDevices.C
to add a line that includes the new parsing file. For example:

: (
            :command (
                  :cmd_name (include)
                  :file_name ("snortPolicy.C")
            )
      )

4. Optional: If required

a. Create a new dictionary file called <device product name>_dict.ini. See Dictionary.

b. Put it in the directory $FWDIR/conf/syslog/UserDefined on the Log Server.

A dictionary translates values with the same meaning from logs from different devices into
a common value. This common value is used in the Event Definitions.

c. Edit the file $FWDIR/conf/syslog/UserDefined/UserDefinedSyslogDictionaries.C on
the Log Server.

d. Add a line to include the dictionary file. For example:

:filename ("snort_dict.ini")

5. To examine the parsing, send syslog samples to a Check Point Log Server.
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To send syslog samples:

1. To configure the Log Server to accept syslogs, connect to the Security Management Server with
SmartConsole.

2. In Logs and Masters >Additional Logging Configuration, enable the property Accept Syslog
messages.

3. Edit the Log Server network object.

4. Run the commands cpstop & cpstart, or fw kill fwd & fwd -n.

The fwd procedure on the Log Server restarts.

5. Send syslogs from the device itself, or from a syslog generator.

For example: Kiwi Syslog Message Generator, available at
http://www.kiwisyslog.com/software_downloads.htm#sysloggen.

Troubleshooting:

If SmartConsole does not show the logs as expected, there can be problems with the parsing files:

n If there is a syntax error in the parsing files, an error message shows. To read a specified error
message, set the TDERROR_ALL_FTPARSER value to 5 before you run the procedure fwd -n.

n If the syslogs show in SmartConsole with 'Productsyslog', the log was not parsed properly, but as a
general syslog.

n If the Product field contains another product (not the one you have just added) this means there is a
problem with the other product parsing file. Report this to the Check Point SmartEvent team.

n If the product reports correctly in the log, look for all the fields you extracted. Some of them are in the
Information section. Some fields can be seen only when you selectMore Columns.

The Free Text Parsing Language
The free text parsing language enables to parse an input string, extract information, and define log fields.
These log fields which show as part of the Check Point log in the Log Server. They are used in the definition
of events. Each parsing file contains a tree of commands. Each command examines or parses part of the
input string (sometimes it adds fields to the log as a result), and decides if to continue to parse the string
(according to the success/failure of its execution).

The Commands
Each command consists of these parts:

n cmd_name - the name of the command.

n command arguments - arguments that define the behavior of the command.

n on_success (optional) - the next command executed if the current command execution succeeds.

n on_fail (optional) - the next command executed if the current command execution fails.
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Sample

:command (
      :cmd_name (try)
      :try_arguments
           .
           .

      :on_success (
             :command()
      )
      :on_fail (
             :command()
      )
)

Try
The try command matches a regular expression against the input string.

Try Command Parameters

Argument Description

parse_
from

start_position - run the regular expression from the start of the input string.

last_position - run the regular expression from the last position of the previous
successful command.

regexp The regular expression to match.

add_
field

One or more fields to add to the result (only if the regular expression is successful).

Try Command Sample

:command (
     :cmd_name (try)
     :parse_from (start_position)
     :regexp ("([0-9]+\.[0-9]+\.[0-9]+\.[0-9]+)")
     :add_field (
             :type (index)
             :field_name (Src)
             :field_type (ipaddr)
             :field_index (1)
     )
)

In the above example, we try to match the regular expression ([0-9]+\.[0-9]+\.[0-9]+\.[0-
9]+) that looks at the entire log (parse_from (start_position)) - parse from the start of the log).
If the regular expression is matched, we add a source field.
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Group_try
The command group_try executes one or more commands in one of these modes:

n try_all tries all commands in the group, and ignores the return code of the commands.

n try_all_successively tries all the commands in the group, and ignores the return code of the
commands.

Each command tries to execute from the last position of the earlier successful command.

n try_until_success tries all the commands until one succeeds.

n try_until_fail tries all the commands until one fails.

The command group_try is commonly used when it parses a "free-text" piece of a log, which contains a
number of fields we want to extract. For example:

%PIX-6-605004: Login denied from 194.29.40.24/4813 to
outside:192.168.35.15/ssh for user 'root'

When you look at see this section of the log, you can use this structure:

Group_try Command Sample 1

:command (
      :cmd_name (group_try)
      :mode (try_all_successively)
      :(
            # A "try" command for the source.
            :command ()
      )
      :(
            # A "try" command for the destination.
            :command ()
      )
      :(

            # A "try" command for the user.
            :command ()
      )
                 .
                 .
                 .
)

In this example, the first try command in the group_try block (for the source) is executed.

If the source, destination and user are not in a specified sequence in the syslog, use the try_allmode
instead of try_all_successively.

Group_try Command Sample 2

In this example, the regular expressions in the different commands try to match more specified logs. At
most, one command in the group_try block will be successful. When it is found, it is not necessary to
examine the others:
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:command (
    :cmd_name (group_try)
    :mode (try_until_success)
    :(
         :command (
         .
         .
         .
           :regexp ("(\(|)(login|su)(\)|).* session (opened|closed)
for
user ([a-z,A-Z,0-9]*)")
         )
    )
    :(
         :command (
             .
             .
             .
           :regexp ("(\(|)su(\)|).* authentication failure; logname=
([a-zA-Z0-9]*).*
user=([a-zA-Z0-9]*)")
         )
    )
         .
         .
         .
)

Note - When you add a new device, the first trycommand in the parsing file must use the try until
success parameter:

:cmd_name (group_try)
:mode (try_until_success)
: (
?.
)

Switch
This command enables to compare the result of a specified field against a list of predefined constant
values.

SwitchCommand Parameters

Parameter Description

Parameter Description

field_name The field name whose value is checked.

case One or more case attributes followed by the value with which to compare.
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Parameter Description

default Execute only if no relevant case is available. The default value is optional.

SwitchCommand Sample

:command (

     :cmd_name (switch)

     :field_name (msgID)

     :(
           :case (302005)
           :command ()
     )
     :(
           :case (302001)
           :case (302002)
           :command ()
     )
     :default (
           :command()
     )
)

Unconditional _try
This command is an "empty" command that allows you to add fields to the result without any conditions.

Unconditional _try Command Sample 1

:command (
      :cmd_name (unconditional_try)
      :add_field (
            :type (const)
            :field_name (product)
            :field_type (string)
            :field_value ("Antivirus")
      )
)

A common usage of unconditional_try is with the switch command. In example 2, each message ID
is attached with its corresponding message field which denotes its meaning.
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Unconditional _try Command Sample 2

:command (
      :cmd_name (switch)
      :field_name (msgID)
(
:case (106017)
:command (
:cmd_name (unconditional_try)
:add_field (
:type (const)
:field_name (message)
:field_type (string_id)
:field_value ("LAND Attack")
)
)
)
:(
:case (106020)
:command (
:cmd_name (unconditional_try)
:add_field (
:type (const)
:field_name (message)
:field_type (string_id)
:field_value ("Teardrop Attack")
)
)
)
.
.
.
)

Include
This command enables the inclusion of a new parsing file.

file_name The full path plus the file name of the file to be included.

IncludeCommand Sample

:command (
     :cmd_name (include)
     :file_name ("c:\freeTextParser\device\antivirusPolicy.C")
)

add_field
Each add_fieldhas some parameters:
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n Type - The type of the add_fieldcommand. This parameter has these possible values:

l Index - Part of the regular expression will be extracted as the field. The field_indexvalue
denotes which part will be extracted (see field_indexbullet).

l Const - Add a constant field whose value does not depend on information extracted from the
regular expression. See field_valuebullet.

Field_name - the name of the new field. There are some fields, which have corresponding columns in
SmartConsoleLogs & Monitor > Logs. This table shows the names to give these fields to show in their
Logs & Monitor > Logs column (and not in the Information field, where other added fields appear):

Field Name to be Given Column in Logs & Monitor > Logs

Src Source

Dst Destination

proto Protocol

s_port Source Port

product Product

service Service (when resolved includes the port

and protocol.)

Action Action

ifname Interface

User User

When you name the above fields accordingly, they are placed in their correct column in Logs & Monitor >
Logs. This enables them to participate in all filtering done on these columns. These fields automatically
take part in existing event definitions with these field names.

Field_type - the type of the field in the log. This table shows the possible field types.

Field Type Comment

int

uint

string

ipaddr For IP addresses used with the Src and Dst fields.

pri Includes the facility and severity of a syslog.

timestmp Includes the date and time of the syslog. Supports the format 'Oct 10 2019 15:05:00'.
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Field Type Comment

time Supports the format '15:05:00'.

string_
id

For a more efficient usage of strings. Used when there is a finite number of possible
values for this field.

action Supports these actions: drop, reject, accept, encrypt, decrypt, vpnroute, keyinst,
authorize, deauthorize, authcrypt, and default.

ifdir 0 - inbound

1 - outbound

ifname For an interface name (used with the "ifname" field).

protocol The field name should be "proto".

port For "service", "s_port" or "port" fields.

The field type of the field names in this table must be as mentioned:

Field Name Field Type

Src ipaddr

Dst ipaddr

proto protocol

s_port port

service port

Action action

ifname ifname

n field_indexor field_value- The parameter used depends on the value of the "type" field. If it
is index, field_index shows. If it is const, field_value shows.

field_indexdenotes which part of the regular expression is extracted, according to the grouping
of the patterns. To make this grouping, write a certain expression in brackets. In this expression, the
number in field_index denotes the bracket number whose pattern is taken into account.
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Add_fieldCommand Sample

:command (
     :cmd_name (try)
     :parse_from (last_position)
     :regexp ("Failed password for ([a-zA-Z0-9]+) from
([0-9]+\.[0-9]+\.[0-9]+\.[0-9]+) port ([0-9]+)")
     :add_field (
        :type (index)
        :field_name (User)
        :field_type (string)
        :field_index (1)
     )
     :add_field (
        :type (index)
        :field_name (Src)
        :field_type (ipaddr)
        :field_index (2)
     )
     :add_field (
        :type (index)
        :field_name (port)
        :field_type (port)
        :field_index (3)
     )
)

The pattern for the User, [a-zA-Z0-9]+, is located in the first pair of brackets. Therefore, the field_
index is one. The pattern for the Source address, [0-9]+\.[0-9]+\.[0-9]+\.[0-9]+, is located
in the second pair of brackets. Therefore, the index is two. The pattern for the port is in the third pair of
brackets.

In each parsed regular expression the maximum number of brackets must be up to nine. To extract more
than nine elements from the regular expression, break the expression into two pieces. The first regular
expression contains the first nine brackets. The remaining of the regular expression is in the on_success
command.
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:command (
:cmd_name (try)
:parse_from (start_position)
:regexp ("access-list (.*) (permitted|denied|est-allowed)

([a-zA-Z0-9_\([a-zA-Z0-9_\\.[0-9]+\.[0-9]+\.[0-9]+)\(([0-9]*)\) -> ")
:add_field (
:type (index)
:field_name (listID)
:field_type (string)
:field_index (1)
)
:add_field (
:type (index)
:field_name (action)
:field_type (action)
:field_index (2)
)
:add_field (
:type (index)
:field_name (proto)
:field_type (protocol)
:field_index (3)
)
:add_field (
:type (index)
:field_name (ifname)
:field_type (ifname)
:field_index (4)
)
:add_field (
:type (index)
:field_name (Src)
:field_type (ipaddr)
:field_index (5)
)
:on_success (
:command (
:cmd_name (try)
:parse_from (last_position)
:regexp

("([a-zA-Z0-9_\\.[0-9]+\.[0-9]+\.[0-9]+)\(([0-9]*)\) hit-cnt ([0-9]+) ")
:add_field (
:type (index)
:field_name (destination_interface)
:field_type (string)
:field_index (1)
)
)
)

)

field_value is the constant value to be added.
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:command (
      :cmd_name (try)
      :parse_from (last_position)
      :regexp ("%PIX-([0-9])-([0-9]*)"))
      :add_field (
             :type (const)
             :field_name (product)
             :field_type (string_id)
             :field_value ("CISCO PIX")
      )
)

Dict_name is the name of the dictionary to use to convert the value. If the value is not found in the
dictionary, the value is the result.

Dictionary
The free text parser enables us to use dictionaries to convert values from the log. These conversions are
used to translate values from logs from different devices, with the same meaning, into a common value,
which is used in the event definitions.

Each dictionary file is defined as an .inifile. In the inifile the section name is the dictionary name and
the values are the dictionary values (each dictionary can include one or more sections).

[dictionary_name]

Name1 = val1

Name2 = val2

cisco_action]          [3com_action]

permitted = accept      Permit = accept

denied = reject         Deny = reject

Dictionary Sample

The reference to a dictionary in the parsing file is shown in this table:
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Dictionary Command Sample 2

:command (
      :cmd_name (try)
      :parse_from (start_position)
      :regexp ("list (.*) (permitted|denied) (icmp)
([0-9]+\.[0-9]+\.[0-9]+\.[0-9]+) -> ([0-9]+\.[0-9]+\.[0-9]+\.[0-9]+).*
packet")
       :add_field (
               :type (index)
               :field_name (action)
               :field_type (action)
               :field_index (2)
               :dict_name (cisco_action)

)
)
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